
Real-Time Monitoring Tool  
アドミニストレーション ガイド  
for Cisco Unity Connection
Release 2.x 
Published May 30, 2007

Text Part Number: OL-13895-01-J



このマニュアルに記載されている仕様および製品に関する情報は、予告なしに変更されることがあります。このマニュアルに記載されている表現、情報、

および推奨事項は、すべて正確であると考えていますが、明示的であれ黙示的であれ、一切の保証の責任を負わないものとします。このマニュアルに記

載されている製品の使用は、すべてユーザ側の責任になります。

対象製品のソフトウェア ライセンスおよび限定保証は、製品に添付された『Information Packet』に記載されています。見当たらない場合には、代理店に  
ご連絡ください。

シスコが採用している TCP ヘッダー圧縮機能は、UNIX オペレーティング システムの UCB（University of California, Berkeley）パブリック ドメイン バー          
ジョンとして、UCB が開発したプログラムを最適化したものです。All rights reserved. Copyright © 1981, Regents of the University of California. 

ここに記載されている他のいかなる保証にもよらず、すべてのマニュアルおよび上記各社のソフトウェアは、障害も含めて「現状のまま」として提供さ

れます。シスコおよび上記各社は、商品性や特定の目的への適合性、権利を侵害しないことに関する、または取り扱い、使用、または取り引きによって

発生する、明示されたまたは黙示された一切の保証の責任を負わないものとします。

いかなる場合においても、シスコおよびその代理店は、このマニュアルの使用またはこのマニュアルを使用できないことによって起こる制約、利益の損

失、データの損傷など間接的で偶発的に起こる特殊な損害のあらゆる可能性がシスコまたは代理店に知らされていても、それらに対する責任を一切負い

かねます。

CCVP, the Cisco logo, and the Cisco Square Bridge logo are trademarks of Cisco Systems, Inc.; Changing the Way We Work, Live, Play, and Learn is a service mark                            
of Cisco Systems, Inc.; and Access Registrar, Aironet, BPX, Catalyst, CCDA, CCDP, CCIE, CCIP, CCNA, CCNP, CCSP, Cisco, the Cisco Certified Internetwork                     
Expert logo, Cisco IOS, Cisco Press, Cisco Systems, Cisco Systems Capital, the Cisco Systems logo, Cisco Unity, Enterprise/Solver, EtherChannel, EtherFast,                   
EtherSwitch, Fast Step, Follow Me Browsing, FormShare, GigaDrive, HomeLink, Internet Quotient, IOS, iPhone, IP/TV, iQ Expertise, the iQ logo, iQ Net Readiness                     
Scorecard, iQuick Study, LightStream, Linksys, MeetingPlace, MGX, Networking Academy, Network Registrar, Packet, PIX, ProConnect, ScriptShare, SMARTnet,               
StackWise, The Fastest Way to Increase Your Internet Quotient, and TransPath are registered trademarks of Cisco Systems, Inc. and/or its affiliates in the United States                        
and certain other countries. 

All other trademarks mentioned in this document or Website are the property of their respective owners. The use of the word partner does not imply a partnership                          
relationship between Cisco and any other company. (0705R)

このドキュメントで使用しているインターネット プロトコル（IP）アドレスは、実在のアドレスではありません。ドキュメント中で示される例、コマン 
ドの画面出力、および図は、いずれも視覚的な説明のみを目的としています。実在する IP アドレスが例示されていた場合、それらは意図して使用したも  
のではありません。

Real-Time Monitoring Tool アドミニストレーション ガイド for Cisco Unity Connection 
Copyright © 2007 Cisco Systems, Inc. 
All rights reserved.



iii
Real-Time Monitoring Tool アドミニストレーション ガイド for Cisco Unity Connection        

OL-13895-01-J

C O N T E N T S

このマニュアルについて　　ix

目的　　ix

対象読者　　ix

マニュアルの構成　　ix

関連マニュアル　　x

表記法　　xi

技術情報の入手方法、サポートの利用方法、およびセキュリティ ガイドライン　
　xii

シスコ製品のセキュリティの概要　　xii

C H A P T E R  1 Real-Time Monitoring Tool の概要　　1-1

サービス、servlet、および サービス パラメータ　　1-2

サーバ（RTMT Collector、Alert Manager、および RTMT Reporter）で設定できな
いコンポーネント　　1-4

サーバ ログの概要　　1-5

関連項目　　1-5

C H A P T E R  2 Real-Time Monitoring Tool のインストールと設定　　2-1

RTMT のインストール　　2-2

RTMT のアップグレード　　2-3

複数の RTMT のインストール　　2-4

RTMT のアンインストール　　2-5

RTMT の起動　　2-6

RTMT のナビゲーション　　2-7

構成プロファイルの使用　　2-8

デフォルト構成プロファイルの使用方法　　2-8

構成プロファイルの追加　　2-8

プロファイルの復元　　2-9

構成プロファイルの削除　　2-9

カテゴリの使用　　2-10

カテゴリの追加　　2-10

カテゴリ名の変更　　2-10

カテゴリの削除　　2-11

関連項目　　2-11



Contents

iv
Real-Time Monitoring Tool アドミニストレーション ガイド for Cisco Unity Connection

OL-13895-01-J

C H A P T E R  3 定義済みオブジェクトの監視　　3-1

システム概要の表示　　3-1

サーバ ステータスの監視　　3-2

定義済みのシステム オブジェクトの表示と監視　　3-3

関連項目　　3-4

C H A P T E R  4 パフォーマンス モニタリングの概要　　4-1

パフォーマンス モニタリングのための RTMT の使用方法　　4-2

カテゴリ タブ　　4-3

サンプル レート　　4-3

監視するカウンタの追加　　4-3

カウンタのアラート通知　　4-3

カウンタのズーム　　4-3

カウンタのプロパティ　　4-4

トラブルシューティング用 perfmon データ ロギング　　4-5

関連項目　　4-8

C H A P T E R  5 パフォーマンス カウンタの設定と表示　　5-1

パフォーマンス カウンタの表示　　5-2

RTMT Performance Monitoring ペインからのカウンタの削除　　5-3

カウンタ インスタンスの追加　　5-4

カウンタのアラート通知の設定　　5-5

カウンタのズーム　　5-8

カウンタの説明の表示　　5-9

データ サンプルの設定　　5-10

カウンタ データの表示　　5-11

perfmon カウンタ データのローカル ロギング　　5-12

カウンタ ログの開始　　5-12

カウンタ ログの停止　　5-12

perfmon ログ ファイルの表示　　5-13

Performance Log Viewer でのログ ファイルの表示　　5-13

ズームインとズームアウト　　5-14

Microsoft パフォーマンス ツールでの perfmon ログ ファイルの表示　　5-15

トラブルシューティング用 perfmon データ ロギング　　5-16

トラブルシューティング用 Perfmon データ ロギングの設定　　5-16

トラブルシューティング用 Perfmon データ ロギングのコンフィギュレーショ
ン設定　　5-17

関連項目　　5-18



v
Real-Time Monitoring Tool アドミニストレーション ガイド for Cisco Unity Connection        

OL-13895-01-J

Contents

C H A P T E R  6 アラート　　6-1

アラートの概要　　6-2

アラートの表示　　6-3

アラートのフィールド　　6-4

アラート アクションの設定　　6-5

トレース ダウンロードの有効化　　6-5

アラート ログの概要　　6-6

Log Partition Monitoring　　6-7

関連項目　　6-8

C H A P T E R  7 アラートの使用　　7-1

アラートの使用　　7-2

アラート プロパティの設定　　7-4

アラートの一時停止　　7-6

アラート通知用電子メールの設定　　7-7

アラート アクションの設定　　7-7

関連項目　　7-8

C H A P T E R  8 プラグインの使用方法　　8-1

関連項目　　8-2

C H A P T E R  9 RTMT での Trace and Log Central の設定　　9-1

証明書のインポート　　9-2

RTMT の Trace and Log Central オプションの表示　　9-3

トレース ファイルの収集　　9-4

Query Wizard の使用方法　　9-7

トレース収集のスケジュール　　9-11

トレース収集ステータスの表示とスケジュールされた収集の削除　　9-14

クラッシュ ダンプの収集　　9-15

Local Browse の使用方法　　9-18

Remote Browse の使用方法　　9-19

Real-Time Trace の使用方法　　9-22

View Real-Time Data　　9-22

Monitor User Event　　9-23

RTMT のトレース設定の更新　　9-25

関連項目　　9-26

C H A P T E R  10 RTMT での SysLog Viewer の使用方法　　10-1

関連項目　　10-2



Contents

vi
Real-Time Monitoring Tool アドミニストレーション ガイド for Cisco Unity Connection

OL-13895-01-J

C H A P T E R  11 Port Monitor　　11-1

Port Monitor の概要　　11-1

Port Monitor の使用方法　　11-2

関連項目　　11-2

A P P E N D I X  A システムのパフォーマンス オブジェクトとパフォーマンス カウンタ　　A-1

Cisco Tomcat Connector　　A-2

Cisco Tomcat JVM　　A-3

Cisco Tomcat Web Application　　A-4

Database Change Notification Client　　A-4

Database Change Notification Server　　A-5

Database Change Notification Subscription　　A-5

Database Local DSN　　A-5

DB User Host Information Counters　　A-5

Enterprise Replication DBSpace Monitors　　A-5

Enterprise Replication Perfmon Counters　　A-6

IP　　A-6

Memory　　A-7

Network Interface　　A-8

Number of Replicates Created and State of Replication　　A-9

Partition 　　A-9

Process　　A-10

Processor　　A-11

System 　　A-11

TCP 　　A-12

Thread　　A-12

参考情報　　A-12

A P P E N D I X  B Cisco Unity Connection のパフォーマンス オブジェクトとパフォーマンス カウンタ
　　B-1

CUC Data Store: Databases　　B-2

CUC Message Store　　B-2

CUC Personal Call Transfer Rules　　B-2

CUC Phone System　　B-3

CUC Phone System: Ports　　B-4

CUC Sessions: IMAP Server　　B-4

CUC Sessions: TRaP　　B-5

CUC Sessions: TTS　　B-5

CUC Sessions: Voice　　B-6



vii
Real-Time Monitoring Tool アドミニストレーション ガイド for Cisco Unity Connection        

OL-13895-01-J

Contents

CUC Sessions: VUI　　B-7

CUC Sessions: Web　　B-7

参考情報　　B-8

I N D E X 索引



Contents

viii
Real-Time Monitoring Tool アドミニストレーション ガイド for Cisco Unity Connection

OL-13895-01-J



ix
Real-Time Monitoring Tool アドミニストレーション ガイド for Cisco Unity Connection        

OL-13895-01-J

このマニュアルについて

ここでは、このマニュアルの目的、対象読者、構成、および表記法、そして関連資料の入手方法に

ついて説明します。

ここで紹介する内容は次のとおりです。

 • 目的（P.ix）

 • 対象読者（P.ix）

 • マニュアルの構成（P.ix）

 • 関連マニュアル（P.x）

 • 表記法（P.xi）

 • 技術情報の入手方法、サポートの利用方法、およびセキュリティ ガイドライン（P.xii）

 • シスコ製品のセキュリティの概要（P.xii）

目的
『Real-Time Monitoring Tool アドミニストレーション ガイド for Cisco Unity Connection』は、Real-Time        

Monitoring Tool（RTMT）についての情報を提供しています。

本書は、『Cisco Unity Connection システム アドミニストレーション ガイド』および『Cisco Unity      
Connection サービスアビリティ アドミニストレーション ガイド』と併用してください。すべてのマ   
ニュアルに、Cisco Unity Connection の管理方法と、Cisco Unity Connection の管理を使用して完了す      
る手順に関する説明が記載されています。

対象読者
『Real-Time Monitoring Tool アドミニストレーション ガイド for Cisco Unity Connection』は、Cisco Unity         

Connectionの保守とサポートを担当するネットワーク管理者を対象としています。ネットワーク エ 
ンジニア、システム管理者、または電気通信技術者の方は、リモート サービサビリティ機能につい 
て学習し、管理する目的で使用してください。テレフォニーおよび IP ネットワーキング テクノロ   
ジーに関する知識が必要です。
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マニュアルの構成
次の表に、このマニュアルの構成を示します。

関連マニュアル
他の Cisco Unity Connection のマニュアルについては、 
http://www.cisco.com/en/US/products/ps6509/products_documentation_roadmaps_list.htmlにある
『Documentation Guide for Cisco Unity Connection』を参照してください。

章番号 説明

第 1 章「Real-Time Monitoring Tool の概
要」

Real-Time Monitoring Tool（RTMT）について簡単に説明  
します。

第 2 章「Real-Time Monitoring Tool のイ
ンストールと設定」

RTMT をインストール、アップグレード、およびアンイ 
ンストールする手順を示します。また、RTMT 内での移 
動方法とプロファイルの設定方法についても説明しま

す。

第 3 章「定義済みオブジェクトの監視」 RTMT によって監視される定義済みオブジェクトの概 
要を示します。

第 4 章「パフォーマンス モニタリングの   
概要」

パフォーマンス カウンタの概要を示します。

第 5 章「パフォーマンス カウンタの設定   
と表示」

パフォーマンス カウンタおよびカウンタの説明の表示 
方法など、パフォーマンス モニタの使用手順を示しま 
す。

第 6 章「アラート」 あらかじめ設定されているアラートの説明など、アラー

トの概要を示します。アラートおよびアラート アクショ 
ンの設定に使用するフィールドについて説明します。 

第 7 章「アラートの使用」 アラートの使用手順を示します。

第 8 章「プラグインの使用方法」 Real-Time Monitoring Tool でのプラグインのインストー   
ルおよび使用方法について説明します。

第 9 章「RTMT での Trace and Log 
Central の設定」

オンデマンドのトレース収集とクラッシュ ダンプ ファ  
イルの設定方法、および該当ビューアでのトレース ファ 
イルの表示方法について説明します。

第 10 章「RTMT での SysLog Viewer の      
使用方法」

SysLog Viewer の使用方法について説明します。

第 11 章「Port Monitor」 Cisco Unity Connection の Port Monitor について説明しま      
す。

付録 A「システムのパフォーマンス オブ  
ジェクトとパフォーマンス カウンタ」

システムのパフォーマンス オブジェクトと、関連付け 
られているカウンタのリストを示します。

付録 B「Cisco Unity Connection のパ    
フォーマンス オブジェクトとパフォー 
マンス カウンタ」

Cisco Unity Connection のパフォーマンス オブジェクト    
と、関連付けられているカウンタのリストを示します。

http://www.cisco.com/en/US/products/ps6509/products_documentation_roadmaps_list.html


このマニュアルについて

表記法

xi
Real-Time Monitoring Tool アドミニストレーション ガイド for Cisco Unity Connection        

OL-13895-01-J

表記法
このマニュアルは、次の表記法を使用しています。

（注）は、次のように表しています。

（注） 「注釈」です。役立つ情報や、このマニュアル以外の参照資料などを紹介しています。

ワンポイント アドバイスは、次のように表しています。

ワンポイント アドバイス 時間を節約する方法です。ここに紹介している方法で作業を行うと、時間を短縮できます。

ヒントは、次のように表しています。

ヒント 便利なヒントです。

表記法 説明

太字 コマンドおよびキーワードは、太字で示しています。

イタリック体 ユーザが値を指定する引数は、イタリック体で示しています。

[   ] 角カッコの中の要素は、省略可能です。

{ x | y | z } 必ずどれか 1 つを選択しなければならない必須キーワードは、波カッコ  
で囲み、縦棒で区切って示しています。

[ x | y | z ] どれか 1 つを選択できる省略可能なキーワードは、角カッコで囲み、縦  
棒で区切って示しています。

ストリング 引用符を付けない一組の文字。ストリングの前後には引用符を使用しま

せん。引用符を使用すると、その引用符も含めてストリングとみなされ

ます。

screen フォント システムが表示する端末セッションおよび情報は、screen フォントで示 
しています。

太字の screen フォント ユーザが入力しなければならない情報は、太字の screen フォントで示  
しています。

イタリック体の screen 
フォント

ユーザが値を指定する引数は、イタリック体の screen フォントで示し  
ています。

例の中で重要なテキストを強調しています。

^ ^ 記号は、Ctrl キーを表します。たとえば、画面に表示される ^D という    
キーの組み合せは、Ctrl キーを押しながら D キーを押すことを意味しま   
す。

<   > パスワードのように出力されない文字は、山カッコで囲んで示していま

す。
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注意は、次のように表しています。

注意 「要注意」の意味です。機器の損傷またはデータ損失を予防するための注意事項が記述されていま

す。

警告は、次のように表しています。

警告 「危険」の意味です。人身事故を予防するための注意事項が記述されています。装置の取り扱い作

業を行うときは、電気回路の危険性に注意し、一般的な事故防止策をとるよう努めてください。

技術情報の入手方法、サポートの利用方法、およびセキュリティ ガイド 
ライン

技術情報の入手、サポートの利用、技術情報に関するフィードバックの提供、セキュリティ ガイド 
ライン、推奨するエイリアスおよび一般的なシスコのマニュアルに関する情報は、月刊の

『What’s New in Cisco Product Documentation』を参照してください。ここには、新規および改訂版の     
シスコの技術マニュアルもすべて記載されています。次の URL からアクセスできます。

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

シスコ製品のセキュリティの概要
本製品には暗号化機能が備わっており、輸入、輸出、配布および使用に適用される米国および他の

国での法律を順守するものとします。シスコの暗号化製品を譲渡された第三者は、その暗号化技術

の輸入、輸出、配布、および使用を許可されたわけではありません。輸入業者、輸出業者、販売業

者、およびユーザは、米国および他の国での法律を順守する責任があります。本製品を使用するに

あたっては、関係法令の順守に同意する必要があります。米国および他の国の法律を順守できない

場合は、本製品を至急送り返してください。 

シスコの暗号化製品に適用される米国の法律の概要については、次の URL で参照できます。 
http://www.cisco.com/wwl/export/crypto/tool/stqrg.html 
何かご不明な点があれば、export@cisco.com まで電子メールを送信してください。

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
http://www.cisco.com/wwl/export/crypto/tool/stqrg.html
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1
Real-Time Monitoring Tool の概要

Real-Time Monitoring Tool（RTMT）は、クライアント側で実行されるアプリケーションで、HTTPS  
と TCP を使用して、Cisco Unity Connection のシステム パフォーマンス、デバイス ステータス、デ       
バイスの検出状況、および CTI アプリケーションを監視します。RTMT は、HTTPS でデバイスに    
直接接続して問題を解決できます。RTMT は、Cisco Unity Connection のボイスメッセージ ポートも     
監視します。

（注） RTMT がデスクトップのアプリケーションとして実行されていない場合でも、アラームやパフォー 
マンス監視のアップデートなどのタスクは、サーバで引き続きバックグラウンドで実行されます。

RTMT では、次のタスクを実行できます。

 • システムの状態を監視するためにあらかじめ定義された一連の管理オブジェクトを監視する 

 • 値がユーザ設定のしきい値を上回ったり下回ったりした場合に、オブジェクトに対するさまざ

まなアラートを電子メール形式で生成する

 • RTMT に用意された各種デフォルト ビューアでトレースを収集および表示する

 • SysLog Viewer で syslog メッセージを表示する

 • パフォーマンス モニタリング カウンタを使用する

この章は、次の項で構成されています。

 • サービス、servlet、および サービス パラメータ（P.1-2）

 • サーバ（RTMT Collector、Alert Manager、および RTMT Reporter）で設定できないコンポーネン    
ト（P.1-4）
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サービス、servlet、および サービス パラメータ
RTMT クライアントをサポートするには、サーバで多数のサービスをアクティブにし、実行する必 
要があります。RTMT は、次のサービスまたは servlet を使用します。

 • Cisco AMC サービス：このサービスは、インストール後に自動的に起動し、RTMT がサーバか   
らリアルタイム情報を取得できるようにします。

次のリストは、RTMT に関連する Cisco AMC サービス パラメータの一部です。 パラメータの最      
新リストについては、Cisco Unity Connection の管理の［システム設定（System Settings）］ >     
［サービス パラメータ（Service Parameters）］を選択します。次に、サーバと Cisco AMC サー     
ビスを選択します。

－ Primary Collector

－ Failover Collector

－ Data Collection Enabled

－ Data Collection Polling Rate

－ Server Synchronization Period

－ RMI Registry Port Number

－ RMI Object Port Number

－ AlertMgr Enabled

－ Logger Enabled

これらのサービス パラメータについては、Cisco Unity Connection の管理の［ヘルプ（Help）］ >     
［ページ上でのヘルプ（Help with This Page）］ を参照してください。

 • Cisco Communications Manager servlet（Cisco Unified Serviceability の [Control Center - Network         
Services] ウィンドウ）：Real-Time Monitoring Tool（RTMT）をサポートします。このサービス   
は、インストール後に自動的に開始されます。

 • Cisco RIS Data Collector（Cisco Unified Serviceabilityの [Control Center - Network Services] ウィン           
ドウ）：Real-time Information Server（RIS）が、パフォーマンス カウンタの統計情報や生成され   
た重要なアラートなどのリアルタイム情報を保持します。Cisco RIS Data Collector サービスは、    
Real-Time Monitoring Tool（RTMT）、SOAP アプリケーション、および AlertMgrCollector（AMC）    
などのアプリケーションが、サーバに保存されている情報を取得するためのインターフェイス

を提供します。

 • Cisco Tomcat Stats Servlet（Cisco Unified Serviceabilityの [Control Center - Network Services] ウィ           
ンドウ）：Cisco Tomcat Stats Servlet により、RTMT またはコマンドライン インターフェイスを      
使用して Tomcat perfmon カウンタを監視できます。CPU 時間などのリソース使用量が過剰に    
なっていると思われる場合以外は、このサービスを停止しないでください。

 • Cisco Trace Collection Servlet（Cisco Unified Serviceabilityの [Control Center - Network Services] ウィ           
ンドウ）：Cisco Trace Collection Servlet は、Cisco Trace Collection Service とともにトレースの収        
集をサポートしており、RTMT クライアントを使用してトレースを表示できるようにします。 
サーバでこのサービスを停止すると、そのサーバでのトレースの収集や表示はできなくなりま

す。

 • Cisco Trace Collection Service（Cisco Unified Serviceabilityの [Control Center - Network Services] ウィ           
ンドウ）：Cisco Trace Collection Service は、Cisco Trace Collection Servlet とともにトレースの収        
集をサポートしており、RTMT クライアントを使用してトレースを表示できるようにします。 
サーバでこのサービスを停止すると、そのサーバでのトレースの収集や表示はできなくなりま

す。

 • Cisco Log Partition Monitoring Tool（Cisco Unified Serviceabilityの [Control Center - Network Services]           
ウィンドウ）：インストール後に自動的に開始されるこのサービスは、サーバのログ パーティ 
ションのディスク使用状況を監視します。 

 • Cisco SOAP-Real-Time Service APIs（Cisco Unified Serviceability の [Control Center - Network         
Services] ウィンドウ）：Cisco SOAP-Real-Time Service APIs は、インストール後に自動的に開始     
される API で、CTI アプリケーションの情報をリアルタイムで収集できるようにします。
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 • Cisco SOAP-Performance Monitoring APIs（Cisco Unified Serviceabilityの [Control Center - Network         
Services] ウィンドウ）：インストール後に自動的に開始されるこのサービスは、SOAP API を通   
じてさまざまなアプリケーションのパフォーマンス モニタリング カウンタを使用できるよう  
にします。

 • Cisco RTMT Reporter servlet（Cisco Unified Serviceabilityの [Control Center - Network Services] ウィ           
ンドウ）：このサービスはインストール後に自動的に開始され、RTMT のレポートを公開でき 
るようにします。

 • Cisco Serviceability Reporter（Cisco Unified Serviceabilityの [Control Center - Feature Services] ウィ          
ンドウ）：Cisco Serviceability Reporter サービスは、RTMT のレポートを公開できるようにします。

追加情報

P.1-5 の「関連項目」を参照してください。
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サーバ（RTMT Collector、Alert Manager、および RTMT Reporter）で    
設定できないコンポーネント

アプリケーションと一緒に自動的にインストールされるコンポーネントである RTMT Collector が、   
定義済みのモニタリング オブジェクト情報を記録するのに対し、同じく自動的にインストールされ 
る Alert Manager は、アラート履歴をログ ファイルに記録します。定義済みの各オブジェクトは、デ    
バイス、サービス、サーバ、コール アクティビティ、および PPR という複数のカテゴリのいずれ   
かに属します。各カテゴリには個別のログ ファイルがあり、アラートの詳細が個別のファイルに記 
録されます。

重要な perfmon オブジェクトの値もパフォーマンス ログ ファイルに記録されます。

ローカルで書き込まれたログ ファイルは、cm/log/amc でプライマリ コレクタ サーバに表示されま    
す。

アラート ログ ファイル以外のログ ファイルは、RTMT で Performance Log Viewer を使用するか、ネ        
イティブの Microsoft Performance ビューアを使用して表示できます。RTMT での Performance Log      
Viewer の使用方法の詳細については、P.5-13 の「perfmon ログ ファイルの表示」を参照してくださ    
い。アラートログ ファイルは、テキスト エディタを使用して表示できます。

ログ ファイルをローカル マシンにダウンロードするには、RTMT の Trace and Log Central にある        
[Collect Files] オプションを使用できます。[Collect Files] オプションを使用してログ ファイルをダウ     
ンロードする方法の詳細については、P.9-4 の「トレース ファイルの収集」を参照してください。

また、コマンドライン インターフェイス（CLI）から file list コマンドを使用してファイルの一覧を    
表示したり、file get コマンドを使用して SFTP でファイルをダウンロードしたりすることもできま    
す。CLI コマンドの使用方法については、『Cisco Unified Communications Operating System アドミニ      
ストレーション ガイド』を参照してください。

ログ ファイルは csv 形式になっています。新しいログ ファイルは、ローカル システムで毎日 00:00      
に作成されます。これらのログの最初の列は、時間帯に関する情報と、グリニッジ標準時間（GMT）
を起点とする分数です。RTMT Reporter は、これらのログ ファイルをデータ ソースとして使用し    
て、毎日の要約レポートを生成します。デフォルトのモニタリング オブジェクトに基づくこのレ 
ポートは、次の情報について、24 時間ごとに生成されます。

 • Server Status：CPU 負荷率、メモリ使用率、サーバごとのディスク スペース率。

 • Alert Status：サーバごとのアラート数。 

 • Performance Protection Report：システム全体の状態をトラッキングできるデフォルトのモニタリ  
ング オブジェクトに関する傾向分析情報。レポートには、サーバごとに過去 7 日間の情報が記   
録されています。

ヒント RTMT レポートは、英語でのみ表示されます。

サービス パラメータ RTMT Reporter Designated server、RTMT Report Generation Time、および RTMT         
Report Deletion Age は、RTMT レポートの生成に適用されます。これらのサービス パラメータにつ     
いての情報を参照するには、［サービス パラメータ（Service Parameters）］ページの［サービス  
（Service）］ドロップダウン リスト ボックスで [Cisco Serviceability Reporter] サービスをクリック      
し、［ヘルプ（Help）］ > ［ページ上でのヘルプ（Help with This Page）］をクリックします。

Serviceability レポートの詳細については、『Cisco Unified Serviceability アドミニストレーション ガイ     
ド』の Serviceability Reports 関連の章を参照してください。
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追加情報

P.1-5 の「関連項目」を参照してください。

サーバ ログの概要
サーバ データは、5 分ごとに 1 レコードとしてファイルに記録されます。データは、次の計算式に    
基づいて、5 分ごとに次のカウンタで記録されます。

 • cpuUsage：過去 5 分間に収集されたすべての値の平均

 • MemoryInUse：過去 5 分間に収集されたすべての値の平均

 • DiskSpaceInUse：アクティブ パーティションで過去 5 分間に収集されたすべての値の平均

Cisco AMC サービスは、サーバ データを csv 形式で記録します。ログのヘッダーは、時間帯に関す     
る情報と、対象サーバの前回のカウンタを持つ列で構成されます。

次のサーバ ログのファイル名形式は、ServerLog_MM_DD_YYYY_hh_mm.csv です。各ログ ファイ   
ルの最初の行はヘッダーです。

ローカル コンピュータで表示するためにサーバ ログをダウンロードするには、P.9-1 の「RTMT で    
の Trace and Log Central の設定」を参照してください。

追加情報

P.1-5 の「関連項目」を参照してください。

関連項目
 • サービス、servlet、および サービス パラメータ（P.1-2）

 • サーバ（RTMT Collector、Alert Manager、および RTMT Reporter）で設定できないコンポーネン    
ト（P.1-4）

 • サーバ ログの概要（P.1-5）
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2
Real-Time Monitoring Tool のインス
トールと設定

RTMT は、800 x 600 以上の解像度で動作し、Windows 98、Windows XP、Windows 2000、または       
KDE や Gnome クライアントを搭載した Linux を実行しているコンピュータにインストールできま     
す。

この章は、次の項で構成されています。

 • RTMT のインストール（P.2-2）

 • RTMT のアップグレード（P.2-3）

 • 複数の RTMT のインストール（P.2-4）

 • RTMT のアンインストール（P.2-5）

 • RTMT の起動（P.2-6）

 • RTMT のナビゲーション（P.2-7）

 • 構成プロファイルの使用（P.2-8）

 • カテゴリの使用（P.2-10）
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RTMT のインストール
このツールをインストールするには、次の手順を実行します。

手順

ステップ 1 Cisco Unity Connection の管理から、［システム設定（System Settings）］>［プラグイン（Plugins）］    
を選択します。

ステップ 2 ［検索（Find）］ボタンをクリックします。

ステップ 3 Microsoft Windows オペレーティング システムを実行しているクライアントに RTMT ツールをイン     
ストールするには、Cisco Unified CM Real-Time Monitoring Tool - Windows の [Download] リンクをク          
リックします。 

Linux オペレーティング システムを実行しているクライアントに RTMT ツールをインストールす    
るには、Cisco Unified CM Real-Time Monitoring Tool - Linux の [Download] リンクをクリックします。

ステップ 4 クライアントの任意の場所に実行ファイルをダウンロードします。

ステップ 5 Windows 版をインストールするには、デスクトップに表示されている RTMT アイコンをダブルク   
リックするか、実行ファイルをダウンロードしたディレクトリを指定して、RTMT インストール 
ファイルを実行します。

抽出処理が開始されます。

ステップ 6 Linux 版をインストールするには、chmod +x CcmServRtmtPlugin.bin コマンド（大文字と小文字を    
区別）を実行するなどして、そのファイルに実行権限が存在することを確認してください。

ステップ 7 RTMT の初期画面が表示されたら、［次へ］をクリックします。

ステップ 8 使用許諾契約に同意するには、［使用条件の条項に同意します。］をクリックし、次に［次へ］をク

リックします。

ステップ 9 RTMT をインストールする場所を選択します。デフォルトの場所を使用しない場合には、［ブラウ 
ズ］をクリックして、別の場所に移動します。［次へ］をクリックします。

ステップ 10 インストールを開始するには、［次へ］をクリックします。

セットアップのステータス ウィンドウが表示されます。［キャンセル］をクリックしないでくださ 
い。

ステップ 11 インストールを完了するには、［終了］をクリックします。

追加情報

P.2-11 の「関連項目」を参照してください。
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RTMT のアップグレード
このツール（RTMT）を使用すると、ユーザ設定と、ダウンロードしたモジュール jar ファイルがク  
ライアント マシンに保存されます。ユーザが作成したプロファイルはデータベースに保存されるた 
め、ツールをアップグレードした後に、RTMT でこれらの項目にアクセスできます。

新しいバージョンの RTMT にアップグレードする前に、RTMT の旧バージョンをアンインストール   
することをお勧めします。P.2-5 の「RTMT のアンインストール」を参照してください。 

新しいバージョンの RTMT にアップグレードするには、次の手順を実行します。

手順

ステップ 1 Cisco Unity Connection の管理から、［システム設定（System Settings）］>［プラグイン（Plugins）］    
を選択します。

ステップ 2 ［検索（Find）］ボタンをクリックします。

ステップ 3 Microsoft Windows オペレーティング システムを実行しているクライアントに RTMT ツールをイン     
ストールすることを予定している場合には、Cisco Unified CM Real-Time Monitoring Tool - Windows       
の [Download] リンクをクリックします。

Linux オペレーティング システムを実行しているクライアントに RTMT ツールをインストールす    
ることを予定している場合には、Cisco Unified CM Real-Time Monitoring Tool - Linux の [Download]        
リンクをクリックします。

ステップ 4 任意の場所に実行ファイルをダウンロードします。

ステップ 5 デスクトップに表示されている RTMT アイコンをダブルクリックするか、実行ファイルをダウン  
ロードしたディレクトリを指定して、RTMT インストール ファイルを実行します。

抽出処理が開始されます。

ステップ 6 RTMT の初期画面で、［次へ］をクリックします。

ステップ 7 アップグレードの場合にはインストール場所を変更できないため、［次へ］をクリックします。

セットアップのステータス ウィンドウが表示されます。［キャンセル］をクリックしないでくださ 
い。

ステップ 8 メンテナンスの完了ウィンドウで、［終了］をクリックします。

追加情報

P.2-11 の「関連項目」を参照してください。
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複数の RTMT のインストール
RTMT がコンピュータに 1 つだけインストールされている場合には、一度にサーバを 1 台またはク     
ラスタを 1 台のみ監視できます。たとえば、次のエンティティのいずれかを監視できます。

 • サーバ上の Cisco Unified Communications Manager 製品。

 • クラスタの状態を監視するクラスタ上のノード。

別のサーバまたはノード上の製品を監視するには、まずそのサーバまたはノードからログオフし、

もう一方のサーバにログオンする必要があります。

コンピュータに複数の RTMT がインストールされている場合には、異なるサーバにインストールさ  
れている複数の Cisco Unified Communications Manager 製品を同時に監視できます。たとえば、コン     
ピュータに 3 つの RTMT がインストールされている場合には、Cisco Unity Connection サーバ、Cisco       
Unified Communications Manager サーバ、および Cisco Unified Communications Manager Business Edition         
サーバを同時に監視できます。

（注） 次の制限事項に注意してください。

 • Cisco Unified Communications Manager の管理 6.X、Cisco Unified Communications Manager の管理         
5.X（旧 Cisco Unified CallManager）、および Cisco Unity Connection の管理 2.0 のプラグイン ウィ          
ンドウからダウンロードした RTMT のバージョンは互換性があり、相互にサポートされていま  
す。ただし、Cisco Unified Communications Manager または Cisco Unity Connection のそれ以前の        
リリースはサポートしていません。

 • Cisco Unified Communications Manager の旧バージョンについては、場合によっては、異なるバー    
ジョンの RTMT がコンピュータにインストールされている必要があります（Cisco Unified   
Communications Manager のリリースごとに 1 バージョン）。インストールする RTMT バージョ      
ンが、監視対象の Cisco Unified Communications Manager と互換性を持っていることを確認して     
ください。

複数の RTMT を 1 台のコンピュータにインストールする場合には、RTMT を異なるフォルダにイン     
ストールする必要があります。RTMT を 4 コピー以上コンピュータにインストールしないことをお   
勧めします。

別の RTMT をインストールしたら、次のタスクを実行します。

1. 最新の RTMT インストールのみを参照するようにショートカット アイコンが上書きされます。   
以前のインストールを格納しているフォルダの jrtmt.exe へのショートカットを作成して、別の  
アイコンを作成します。

2. アイコンの名前を適宜変更します。

インストール時、選択したフォルダに別のバージョンが検出された場合には、メッセージが表示さ

れます。インストールを続行するには、このバージョンを別のフォルダにインストールします。

（注） IP アドレスや RTMT フレーム サイズなどのユーザ設定は、最後に終了した RTMT クライアントの      
設定が保存されます。
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RTMT のアンインストール

ヒント RTMT を使用すると、ユーザ設定と、モジュール jar ファイル（キャッシュ）がクライアント マシ    
ンに保存されます。RTMT をアンインストールするときには、キャッシュを削除するか保存するか 
を選択します。

Windows クライアントの場合には、コントロール パネルの［プログラムの追加と削除］から RTMT   
をアンインストールします（［スタート］>［設定］>［コントロール パネル］>［プログラムの追 
加と削除］を選択します）。

KDE や Gnome クライアントを搭載した Hat Linux で RTMT をアンインストールするには、タスク        
バーから、[Start] > [Accessories] > [Uninstall Real-time Monitoring tool] を選択します。

追加情報

P.2-11 の「関連項目」を参照してください。
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RTMT の起動

手順

ステップ 1 プラグインをインストールしたら、次のいずれかのタスクを実行します。

 • Windows デスクトップにある Real-Time Monitoring Tool アイコンをダブルクリックします。

 • ［スタート］>［すべてのプログラム］> [Cisco Unified Serviceability] > [Real-Time Monitoring      
Tool] > [Real-Time Monitoring Tool] を選択します。

[Real-Time Monitoring Tool Login] ウィンドウが表示されます。

ステップ 2 [Host IP Address] フィールドに、サーバの IP アドレスまたはホスト名を入力します。

ステップ 3 [User Name] フィールドに、アプリケーションの管理者ユーザ名を入力します。

ステップ 4 [Password] フィールドに、そのユーザ名に設定した管理者ユーザ パスワードを入力します。

（注） 認証が失敗した場合やサーバに接続できない場合には、サーバと認証の詳細情報を再入力

するように要求されます。[Cancel] ボタンをクリックしてアプリケーションを終了すること 
もできます。認証が成功すると、バックエンド バージョンに一致するモニタリング モ  
ジュールがローカル キャッシュに含まれていない場合でも、RTMT がローカル キャッシュ   
またはリモート サーバからモニタリング モジュールを起動します。

ステップ 5 アプリケーションがサーバの監視に使用するポートを入力します。デフォルト設定は 8443 です。

ステップ 6 [Secure Connection] チェックボックスをオンにします。

ステップ 7 [OK] をクリックします。

ステップ 8 メッセージが表示されたら、[Yes] をクリックして、証明書ストアを追加します。

Real-Time Monitoring Tool が起動します。 

追加情報

P.2-11 の「関連項目」を参照してください。
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RTMT のナビゲーション
RTMT のウィンドウは、次の主要コンポーネントで構成されます。

 • 次のメニュー オプションが表示されるメニューバー。

－ File：既存の RTMT プロファイルの保存、復元、および削除、Java Heap Memory Usage の      
監視、Cisco Unified Serviceability の [Serviceability Report Archive] ウィンドウへの移動、       
RTMT からのログオフまたは終了を実行できます。

－ System：システム概要の監視、サーバ リソースの監視、パフォーマンス カウンタの使用、  
アラートの使用、トレースの収集、および syslog メッセージの表示が実行できます。

－ Unity Connection：Port Monitor Tool を表示できます。

－ Edit：カテゴリの設定（表形式表示）、デバイスとパフォーマンス モニタリング カウンタ  
のポーリング レートの設定、Quick Launch Channel の非表示、および RTMT のトレース設      
定の編集が実行できます。

－ Window：単一またはすべての RTMT ウィンドウを閉じることができます。

－ Application：Web ページで Cisco Unity Connection の管理と Cisco Unity Connection 
Serviceability を参照できます。

－ Help：RTMT マニュアルのオンライン ヘルプへアクセスしたり、RTMT バージョンを表示   
したりできます。

 • Quick Launch Channel：RTMT ウィンドウの左側のペインにあるタブをクリックすることによ   
り、サーバやアプリケーションに関する情報を表示できます。タブにはアイコンのグループが

あり、これらのアイコンをクリックすることにより、各種オブジェクトを監視できます。

 • モニタ ペイン：監視結果が表示されるペイン。

追加情報

P.2-11 の「関連項目」を参照してください。
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構成プロファイルの使用
RTMT を使用してサーバに接続できます。ログインすると、バックエンド バージョンに一致するモ  
ニタリング モジュールがローカル キャッシュに含まれていない場合でも、RTMT がローカル   
キャッシュまたはリモート サーバからモニタリング モジュールを起動します。

RTMT には、Default と呼ばれるデフォルト設定があります。初めて RTMT を使用するときには、    
Default プロファイルが使用され、モニタ ペインにはシステム概要ページが表示されます。

さまざまな機能に合せた別々のパフォーマンス カウンタなど、必要な情報を RTMT のモニタ ペイ    
ンに表示したり、プロファイルに設定したフレームワークを保存したりするように RTMT を構成で  
きます。同じセッションの間、または次回 RTMT にログインするときにそのプロファイルを復元で  
きます。複数のプロファイルを作成することで、各プロファイルが固有の情報を表示するようにな

り、プロファイルを切り替えることによって異なる情報をすばやく表示できます。

この項は、次のトピックについて取り上げます。

 • デフォルト構成プロファイルの使用方法（P.2-8）

 • 構成プロファイルの追加（P.2-8）

 • プロファイルの復元（P.2-9）

 • 構成プロファイルの削除（P.2-9）

デフォルト構成プロファイルの使用方法

最初に RTMT をロードしたときに、Default と呼ばれるデフォルトのプロファイルがシステムに組   
み込まれます。初めて RTMT を使用するときには、Default プロファイルが使用され、モニタ ペイ    
ンにはシステム概要ページが表示されます。

構成プロファイルの追加

RTMT を使用し、別々のパフォーマンス カウンタを監視することによってモニタリング ウィンド   
ウをカスタマイズして、自分自身の構成プロファイルを作成できるため、もう一度各ウィンドウを

開かなくても 1 ステップでこれらのモニタリング ウィンドウを復元できます。同じ RTMT セッショ     
ンの間に別のプロファイルに切り替えたり、次の RTMT セッションでその構成プロファイルを使用  
したりすることができます。

プロファイルの作成手順は次のとおりです。

手順

ステップ 1 [File] > [Profile] を選択します。

[Profile] ダイアログボックスが表示されます。

ステップ 2 [Save] をクリックします。

[Save Current Configuration] ダイアログボックスが表示されます。

ステップ 3 [Configuration Name] フィールドに、この特定の構成プロファイルに付ける名前を入力します。

ステップ 4 [Configuration Description] フィールドに、この特定の構成プロファイルに関する説明を入力します。
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（注） 構成プロファイル名と説明は、自由に入力できます。

新しい構成プロファイルが作成されます。

プロファイルの復元

設定したプロファイルを復元するには、次の手順を実行します。

手順

ステップ 1 [File] > [Profile] を選択します。

[Profile] ダイアログボックスが表示されます。

ステップ 2 復元するプロファイルをクリックします。

ステップ 3 [Restore] をクリックします。

すべてのウィンドウが、復元したプロファイルの既定の設定またはパフォーマンス モニタリング 
カウンタ（あるいはその両方）を表示した状態で開きます。

構成プロファイルの削除

設定したプロファイルを削除するには、次の手順を実行します。

手順

ステップ 1 [File] > [Profile] を選択します。

[Profile] ダイアログボックスが表示されます。

ステップ 2 削除するプロファイルをクリックします。

ステップ 3 [Delete] をクリックします。

ステップ 4 [Close] をクリックします。

追加情報

P.2-11 の「関連項目」を参照してください。
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カテゴリの使用
カテゴリを使用して、パフォーマンス モニタリング カウンタなどのオブジェクトを RTMT で編成    
できます。たとえば、パフォーマンス モニタリングの配下にあるデフォルト カテゴリの場合、RTMT  
を使用して、6 つのパフォーマンス モニタリング カウンタをグラフ形式で監視できます。監視する   
カウンタを増やす場合には、新しいカテゴリを設定して、データを表形式で表示します。

カテゴリの追加

カテゴリを追加するには、次の手順を実行します。

手順

ステップ 1 次のいずれかのタスクを実行します。

 • Quick Launch Channel で

－ [System] をクリックします。
－ ツリー階層で、[Performance] をダブルクリックします。

－ [Performance] アイコンをクリックします。
 • [System] > [Performance] > [Open Performance Monitoring] を選択します。

ステップ 2 [Edit] > [Add New Category] を選択します。

ステップ 3 カテゴリの名前を入力し、[OK] をクリックします。

ウィンドウの下部にカテゴリ タブが表示されます。

追加情報

P.2-11 の「関連項目」を参照してください。

カテゴリ名の変更

カテゴリの名前を変更するには、次の手順を実行します。

手順

ステップ 1 次のいずれかのタスクを実行します。

 • 名前を変更するカテゴリ タブを右クリックし、[Rename Category] を選択します。

 • 名前を変更するカテゴリ タブをクリックし、[Edit] > [Rename Category] を選択します。

ステップ 2 新しい名前を入力し、[OK] をクリックします。

ウィンドウの下部に、名前が変更されたカテゴリが表示されます。
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追加情報

P.2-11 の「関連項目」を参照してください。

カテゴリの削除

カテゴリを削除するには、次のいずれかのタスクを実行します。

 • 削除するカテゴリ タブを右クリックし、[Remove Category] を選択します。

 • 削除するカテゴリ タブをクリックし、[Edit] > [Remove Category] を選択します。

追加情報

P.2-11 の「関連項目」を参照してください。

関連項目
 • RTMT のインストール（P.2-2）

 • RTMT のアップグレード（P.2-3）

 • RTMT のアンインストール（P.2-5）

 • RTMT の起動（P.2-6）

 • RTMT のナビゲーション（P.2-7）

 • 構成プロファイルの使用（P.2-8）

 • カテゴリの使用（P.2-10）
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3
定義済みオブジェクトの監視

RTMT は、システム状態の監視を支援するデフォルトのモニタリング オブジェクトを提供していま  
す。デフォルトのオブジェクトには、システムとサポートされているその他のサービスを対象とす

るパフォーマンス カウンタや重要なイベント ステータスがあります。

この章は、次の項で構成されています。

 • システム概要の表示（P.3-1）

 • サーバ ステータスの監視（P.3-2）

 • 定義済みのシステム オブジェクトの表示と監視（P.3-3）

システム概要の表示
RTMT の System Summary により、1 つのモニタリング ペインで重要な一般情報を監視できます。      
System Summary には、次の定義済みオブジェクトに関する情報を表示できます。

 • 仮想メモリの使用状況

 • CPU の使用状況

 • 共通パーティションの使用状況

 • アラート履歴ログ

追加情報

P.3-4 の「関連項目」を参照してください。
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サーバ ステータスの監視
[Servers] カテゴリでは、CPU とメモリの使用状況、プロセス、ディスク スペースの使用状況、およ   
びサーバ上の各種アプリケーションの重要なサービスが監視されます。

[CPU and Memory] モニタには、各サーバの CPU の使用状況と仮想メモリの使用状況が表示されま     
す。サーバの CPU ごとに、各プロセッサが各種モードと処理（User、Nice、System、Idle、IRQ、  
SoftIRQ、IOWait）でのプロセスの実行に費やす時間の割合などの情報が表示されます。CPU 使用 
率とは、アイドル時間を除く、すべてのモードと処理の実行に費やされる合計時間の割合のことで

す。メモリの場合、この情報には、Total、Used、Free、Shared、Buffers、Cached、Total Swap、Used 
Swap、Free Swap メモリがキロバイト単位で表示され、さらに使用中の仮想メモリの割合も表示さ  
れます。

[Processes] モニタには、システム上で実行中のプロセスに関する情報が表示されます。RTMT は、  
プロセス ID（PID）、CPU 使用率、Status、Shared Memory（KB）、Nice（レベル）、VmRSS（KB）、   
VmSize（KB）、VmData（KB）、Thread Count、Page Fault Count、および Data Stack Size（KB）といっ      
た情報をプロセスごとに表示します。

[Disk Usage] モニタリング カテゴリには、共通およびスワップ パーティションのディスク使用率が    
図で表示されます。また、各ホストの各パーティション（Active、Boot、Common、Inactive、Swap、
SharedMemory）のディスク使用率も表示されます。

[Critical Services] モニタリング カテゴリには、重要なサービスの名前、ステータス（サービスの起   
動またはアクティベーション状況）、およびサービスが起動され、システムで実行されている経過

時間が表示されます。 

追加情報

P.3-4 の「関連項目」を参照してください。
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定義済みのシステム オブジェクトの表示と監視
Quick Launch Channel で [System] を選択すると、RTMT のモニタリング ペインに、定義済みのシス       
テム オブジェクトに関する情報が表示されます。

表 3-1 は、RTMT が監視する定義済みのオブジェクトに関する情報です。

ヒント 定義済みのオブジェクトのモニタでズームインするには、目的の図の領域上でマウスの左ボタンを

クリックしてドラッグします。領域を選択したら、マウス ボタンを放します。RTMT が、監視表示  
を更新します。モニタをズームアウトして最初のデフォルトの表示にリセットするには、「R」キー
を押します。

追加情報

P.3-4 の「関連項目」を参照してください。

表 3-1 システムのカテゴリ

カテゴリ 説明

System Summary 仮想メモリの使用状況、CPU の使用状況、共通パーティションの使用状況、およびアラート履 
歴ログに関する情報が表示されます。

定義済みのシステム オブジェクトに関する情報を表示するには、[System] > [System Summary]    
を参照してください。

Server  • CPU and Memory：サーバの CPU 使用状況と仮想メモリの使用状況に関する情報が表示され    
ます。

CPU と仮想メモリの使用状況に関する情報を表示するには、[System] > [Server] > [CPU and      
Memory] を選択します。特定のサーバの CPU およびメモリ使用状況を監視するには、[Host]   
ドロップダウン リスト ボックスからサーバを選択します。

 • Process：サーバで実行中のプロセスに関する情報を表示します。

システムで実行中のプロセスに関する情報を表示するには、[System] > [Server] > [Process]    
を選択します。特定のサーバのプロセス使用状況を監視するには、[Host] ドロップダウン リ  
スト ボックスからサーバを選択します。

 • Disk Usage：サーバでのディスク使用状況に関する情報を表示します。

システムのディスク使用状況に関する情報を表示するには、[System] > [Server] > [Disk    
Usage] を選択します。特定のサーバのディスク使用状況を監視するには、[Host] ドロップダ  
ウン リスト ボックスからサーバを選択します。

 • Critical Services：サーバで実行中のサービスのステータスに関する情報を表示します。

重要なサービスに関する情報を表示するには、[System] > [Server] > [Critical Services] を選      
択します。重要なサービスを表示するには、[System] タブをクリックします。

－ Cisco Unity Connection の重要なサービスを表示するには、[Cisco Unity Connection] タブ      
をクリックします。

－ 特定のサーバの重要なサービスを監視するには、[Host] ドロップダウン リスト ボックス   
からサーバを選択し、目的の重要なサービスのタブをクリックします。
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関連項目
 • システム概要の表示（P.3-1）

 • サーバ ステータスの監視（P.3-2）

 • 定義済みのシステム オブジェクトの表示と監視（P.3-3）
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4
パフォーマンス モニタリングの概要

Cisco Unified Communications Manager は、パフォーマンス カウンタ（PerfMon カウンタと呼ばれる）      
を直接更新します。カウンタには、システムとその機能に関する簡潔で有用な情報が含まれていま

す。

RTMT を使用してオブジェクトのカウンタを選択することにより、システムのコンポーネントのパ 
フォーマンスと、そのシステムで稼働しているアプリケーションのコンポーネントを監視できま

す。各オブジェクトのカウンタは、フォルダが展開されたときに表示されます。

perfmon カウンタのログをローカル コンピュータに記録し、RTMT で Performance Log Viewer を使       
用して、収集した perfmon CSV ログ ファイルや、Realtime Information Server Data Collection（RISDC）        
perfmon のログを表示できます。

この章は、次の項で構成されています。

 • パフォーマンス モニタリングのための RTMT の使用方法（P.4-2）

 • トラブルシューティング用 perfmon データ ロギング（P.4-5）
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パフォーマンス モニタリングのための RTMT の使用方法
RTMT は、Cisco Unity Connection の管理およびサービスアビリティ ソフトウェアと連動していま     
す。RTMT は、すべての Connection コンポーネントのパフォーマンス情報を表示します。トラブル   
シューティングを要するパフォーマンスには、アラートで通知します。また、定期的にパフォーマ

ンス カウンタをポーリングして、そのカウンタのデータを表示します。perfmon カウンタを図また  
は表形式で表示する例については、P.5-9 の「カウンタの説明の表示」を参照してください。

perfmon モニタリングにより、次のタスクを実行できます。

 • 定義済みのオブジェクトを継続的に監視し、電子メール メッセージの形式で通知を受信する。

 • カウンタのしきい値設定をアラート通知と関連付ける。電子メールまたはポップアップ メッ 
セージで管理者に通知する。

 • 監視されているカウンタ、しきい値設定、アラート通知など、カスタマイズしたトラブルシュー

ティング タスクの設定を保存し、復元する。

 • パフォーマンスを比較する目的で、最大 6 つの perfmon カウンタを 1 つの図で表示する。

RTMT は、パフォーマンス カウンタを図または表形式で表示します。図形式は、小さな情報ウィン  
ドウのように見えます。作成したカテゴリ タブごとに、最大 6 つの図が RTMT の Performance      
Monitoring ペインに表示されます。特定のカウンタを表示するには、Perfmon Monitoring ペインでカ   
ウンタをダブルクリックします。図形式の表示がデフォルトです。したがって、パフォーマンス カ 
ウンタを表形式で表示するには、カテゴリを作成するときにそのように設定します。

メニューバーの [Performance] メニューの [Remove Chart/TableEntry] メニュー項目を使用して、カウ     
ンタ図（表エントリ）を削除できます。

ヒント 既定の各モニタリング ウィンドウのポーリング レートは一定で、デフォルト値は 30 秒です。AMC    
（Alert Manager and Collector）サービス パラメータの収集レートが変化すると、既定のウィンドウ内    
のポーリング レートも更新されます。また、バックエンド サーバの時間ではなく、RTMT クライ   
アント アプリケーションのローカル タイムが、各図のタイム スタンプの基準となります。 
 

サービス パラメータの詳細については、『Cisco Unity Connection システム アドミニストレーション     
ガイド』を参照してください。

RTMT Perfmon Monitoring ペインの設定オプションについては、次の項を参照してください。

 • カテゴリ タブ（P.4-3）

 • サンプル レート（P.4-3）

 • パフォーマンス モニタリングのための RTMT の使用方法（P.4-2）

 • カウンタのズーム（P.5-8）
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カテゴリ タブ
カテゴリは、監視されているパフォーマンス カウンタのグループで構成されます。RTMT モニタリ  
ング ペインのタブに、カテゴリ名が表示されています。このタブで監視されているすべてのパ 
フォーマンス カウンタがカテゴリに属します。タブ内のパフォーマンス カウンタは同じレートで  
ポーリングされ、各カテゴリが独自のポーリング レートを持つように設定されています。

RTMT モニタリング ペインでカスタム カテゴリを作成して、特定のパフォーマンスまたはシステ   
ムの問題を解決するのに役立つ情報を表示できます。特定のオブジェクトのパフォーマンスに関す

る問題が発生した場合は、カスタム カテゴリを作成して、そのオブジェクト内のカウンタのパ 
フォーマンスを監視します。また、これらのカスタム カテゴリのカウンタとゲートウェイを対象と 
するアラート通知を作成することもできます。カスタム カテゴリを作成するには、新しいカテゴリ 
タブを追加します。タブが作成されたら、そのタブ内でパフォーマンス カウンタとアラートを指定 
し、プロファイルを使用してカスタム カテゴリを保存します。

サンプル レート
アプリケーションは、カウンタをポーリングしてステータス情報を収集します。RTMT モニタリン 
グ ペインで、作成したカテゴリ タブごとにパフォーマンス カウンタのポーリング間隔を設定しま   
す。

（注） ポーリング レートの頻度が高いと、サーバのパフォーマンスに影響します。図表示でパフォーマ 
ンス カウンタを監視する場合の最短ポーリング レートは 5 秒、表表示でパフォーマンス カウンタ     
を監視する場合の最短ポーリング レートは 1 秒です。デフォルト値は両方とも 10 秒です。

監視するカウンタの追加

システム パフォーマンスの問題を解決するには、perfmon オブジェクトと関連付けられているカウ  
ンタを、カウンタ用の図を表示する RTMT Performance Monitoring ペインに追加します。カウンタ    
を追加する前に、P.4-3 の「カテゴリ タブ」を参照してください。

カテゴリ タブには、最大 6 つの perfmon カウンタ図を含めることができます。

カウンタのアラート通知

アプリケーションは、アラート通知機能を使用してシステムの問題を通知します。システム カウン 
タのアラート通知を有効にするには、次の設定を実行します。

 • RTMT の Perfmon Monitoring ペインで、システム perfmon カウンタを選択します。

 • アラート通知の電子メールまたはメッセージ ポップアップ ウィンドウを設定します。

 • アラートのしきい値を決めます。

 • アラート通知の頻度を決めます（1 回のみ、または毎時間など）。

 • アラートが有効になるタイミングのスケジュールを決めます（毎日、または 1 日の特定の時刻  
など）。

カウンタのズーム

パフォーマンス モニタを詳しく見るには、カウンタ図を強調表示し、[System] > [Performance] >    
[Zoom Chart] を選択して、RTMT Perfmon Monitoring ペインでモニタ カウンタをズームします。
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カウンタのプロパティ

カウンタのプロパティを使用して、カウンタの説明を表示し、データ サンプリング パラメータを  
設定できます。

[Counter Property] ウィンドウには、カウンタのデータ サンプルを設定するオプションが表示されま   
す。RTMT Performance Monitoring ペインに表示されるパフォーマンス カウンタには、データのサ    
ンプルの時間の経過を表す緑色のドットが表示されます。収集するデータ サンプルの数と、図に表 
示するデータ ポイントの数を設定できます。データ サンプルが設定されたら、[View All Data] また     
は [View Current Data] メニュー オプションを使用して、perfmon カウンタが収集したすべてのデー      
タを表示することにより、情報を表示します。

追加情報

P.4-8 の「関連項目」を参照してください。
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トラブルシューティング用 perfmon データ ロギング
トラブルシューティング用 perfmon データ ロギング機能は、Cisco TAC によるシステムの問題の特     
定を支援します。トラブルシューティング用 perfmon データ ロギングを有効にしたら、Cisco Unity    
Connection と、そのサーバのオペレーティング システム パフォーマンス統計情報の収集を開始しま   
す。収集される統計情報には、システム診断に使用できる包括的な情報が含まれています。

システムには、トラブルシューティング用 perfmon データ ロギングによってシステムの状態に関す   
る包括的な情報を提供する perfmon カウンタから統計情報が収集されるように自動的に設定されて  
います。トラブルシューティング用 Perfmon データ ロギングが有効であっても、システムの CPU    
使用率の上昇は 5 パーセント未満で、使用メモリの量もわずかに増加するだけであり、毎日ログ  
ファイルに記述される情報は約 50 MB です。 

トラブルシューティング用 perfmon データ ロギング機能を使用して、次の管理タスクを実行できま   
す。

 • トラブルシューティング用 perfmon データ ロギングのためのトレース フィルタを有効または    
無効にする。

 • 各サーバで、定義済みのシステムおよび Cisco Unity Connection パフォーマンス オブジェクトと     
カウンタを監視する。

 • パフォーマンス データを、CSV ファイル形式でサーバの var/log/active/cm/log/ris/csv ディレクト    
リのアクティブ ログ パーティションに記録する。 
ログ ファイルは、PerfMon_172.19.240.80_06_15_2005_11_25.csv のように、 
PerfMon_<ノード >_<月 >_<日 >_<年 >_<時 >_<分 >.csv という命名規則に従います。ポーリ 
ング レートを指定します。このレートは、パフォーマンス データが収集および記録されるレー  
トです。ポーリング レートは、最短 5 秒まで設定できます。デフォルトのポーリング レート    
は 15 秒です。 

 • Microsoft Windows パフォーマンス ツールまたは Real-Time Monitoring Tool の Performance Log         
Viewer を使用して、グラフ形式でログ ファイルを表示する。

 • ディスクに保存されるログ ファイルの最大数を指定する。ログ ファイルがこの制限を超える  
と、最も古いログ ファイルが自動的に削除されます。デフォルトは 50 ファイルです。

 • ファイルの最大サイズに基づいて、ログ ファイルのロールオーバー基準を MB 単位で指定す   
る。デフォルト値は 2 MB です。

 • Real-Time Monitoring Tool またはコマンドライン インターフェイスの Trace and Log Central 機能         
を使用して、Cisco RIS Data Collector PerfMonLog ログ ファイルを収集する。 

トラブルシューティング用 Perfmon データ ロギングの設定方法の詳細については、P.5-16 の「トラ    
ブルシューティング用 Perfmon データ ロギングの設定」を参照してください。

トラブルシューティング用 perfmon データロギング機能は、次の perfmon オブジェクト内にある次    
のカウンタから情報を収集します。

次のカウンタに関する説明については、付録 B「Cisco Unity Connection のパフォーマンス オブジェ    
クトとパフォーマンス カウンタ」を参照してください。

 • CUC Data Store: Databases

－ Disk Free/chunk [kb]

 • CUC Message Store

－ Messages Delivered Total

－ Messages Received Total

－ VPIM Messages Delivered Total

－ VPIM Messages Received Total

－ VPIM Messages Total
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 • CUC Personal Call Transfer Rules

－ Applicable Rule Found

－ Destinations Tried

－ PCTR Calls

－ Rules Evaluated

－ Subscriber Reached

－ Transfer Failed

－ Voicemail Reached

 • CUC Phone System

－ Call Count Current

－ Call Count Total

－ Call Duration Average [s]

－ Call Duration Total [s]

－ Incoming Calls CFB Current

－ Incoming Calls CFB Total

－ Incoming Calls CFNA Current

－ Incoming Calls CFNA Total

－ Incoming Calls Current

－ Incoming Calls Direct Current

－ Incoming Calls Direct Total

－ Incoming Calls Duration Average [s]

－ Incoming Calls Duration Total [s]

－ Incoming Calls No Info Total

－ Incoming Calls Total

－ MWI Request Duration Average [ms]

－ MWI Request Duration Total [ms]

－ MWI Requests Failed Total

－ MWI Requests Total

－ Notification Duration Average [s]

－ Notification Duration Total [s]

－ Notifications Failed

－ Notifications Total

－ Outgoing Calls Duration Average [s]

－ Outgoing Calls Duration Total [s]

－ Pager Notifications Duration Average [s]

－ Pager Notifications Duration Total [s]

－ Pager Notifications Failed

－ Pager Notifications Total

－ Port Idle Duration [s]

－ Port Idle Duration Average [s]

－ Ports Idle Current

－ Ports In Use Current

－ Ports Locked
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 • CUC Phone System: Ports

－ Port Calls

－ Port Usage Duration Average [s]

－ Port Usage Duration Total [s]

 • CUC Sessions: IMAP Server

－ Commands/second Average

－ Connection Length Average [s]

－ Errors Total

－ EXAMINE Requests Total

－ Failed Login Requests Total

－ FETCH Requests Total

－ Login Requests Total

－ Logout Requests Total

－ Messages Read Total

－ Messages Read/hour

－ Messages/fetch Average

－ NOOP Requests Total

－ Response Time Average [ms]

－ Socket Connections Current

－ Socket Connections Total

－ STARTTLS Requests Total

－ STATUS Requests Total

－ TLS Connections Current

－ TLS Errors Total

－ Unsolicited Notify Response Time Average [ms]

－ Unsolicited Notify Responses Total

 • CUC Sessions: TRaP

－ Session Duration Average [s]

－ Session Duration Total [s]

－ Sessions Current

－ Sessions Total

 • CUC Sessions: TTS

－ Session Duration Average [s]

－ Session Duration Total [s]

－ Sessions Current

－ Sessions Total

 • CUC Sessions: Voice

－ Delay - Directory Search [ms]

－ Delay - Opening Greeting [ms]

－ Delay - Subscriber Delete Message [ms]

－ Delay - Subscriber Logon [ms]

－ Delay - Subscriber Message Count [ms]

－ Delay - Subscriber Messages Header [ms]
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－ Failsafes Total

－ Messages Deleted

－ Messages Forwarded

－ Messages Read

－ Messages Replied

－ Messages Sent

－ MRCP Define Grammar Delay [ms]

－ MRCP Define Grammar Delay Average [ms]

－ MRCP Define Grammar Delay Max [ms]

－ MRCP Delay [ms]

－ MRCP Delay Average [ms]

－ MRCP Delay Max [ms]

－ Subscriber lookup delay [ms]

 • CUC Sessions: VUI

－ Delay - Subscriber Message Access [ms]

－ Matches Total

－ Messages Deleted

－ Messages Forwarded

－ Messages Read

－ Messages Replied

－ Messages Sent

－ No-matches Total

－ Session Duration Average/call [s]

－ Session Duration Total [s]

－ Sessions Current

－ Sessions Total

 • CUC Sessions: Web

－ CPCA Failed Authentications Total

－ CPCA Pages Saved Total

－ CPCA Pages Served Total

－ CPCA Requests In Queue Total

－ CPCA Server Busy Pages Total

－ CPCA Sessions Current

－ CPCA Sessions Total

関連項目
 • パフォーマンス モニタリングのための RTMT の使用方法（P.4-2）

 • トラブルシューティング用 perfmon データ ロギング（P.4-5）

 • パフォーマンス カウンタの設定と表示（P.5-1）

 • システムのパフォーマンス オブジェクトとパフォーマンス カウンタ（P.A-1）

 • Cisco Unity Connection のパフォーマンス オブジェクトとパフォーマンス カウンタ（P.B-1）
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5
パフォーマンス カウンタの設定と表示

この章は、次の項で構成されています。

 • パフォーマンス カウンタの表示（P.5-2）

 • RTMT Performance Monitoring ペインからのカウンタの削除（P.5-3）

 • カウンタ インスタンスの追加（P.5-4）

 • カウンタのアラート通知の設定（P.5-5）

 • カウンタのズーム（P.5-8）

 • カウンタの説明の表示（P.5-9）

 • データ サンプルの設定（P.5-10）

 • カウンタ データの表示（P.5-11）

 • perfmon カウンタ データのローカル ロギング（P.5-12）

 • perfmon ログ ファイルの表示（P.5-13）

 • トラブルシューティング用 perfmon データ ロギング（P.5-16）
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パフォーマンス カウンタの表示
RTMT は、perfmon カウンタを図または表形式で表示します。図形式は、折れ線グラフを使用して  
perfmon カウンタ情報を表示します。作成したカテゴリ タブごとに、RTMT Perfmon Monitoring ペ     
インに最大 6 つのグラフを表示でき、1 つのグラフに最大 3 つのカウンタを表示できます。

ヒント RTMT Perfmon Monitoring ペインでは、1 つのグラフに最大 3 つのカウンタを表示できます。グラフ      
に別のカウンタを追加するには、カウンタをクリックし、RTMT Perfmon Monitoring ペインにドラッ   
グします。この作業を繰り返して、カウンタを最大 3 つまで追加できます。

デフォルトでは、RTMT は図形式で perfmon カウンタを表示します。また、perfmon カウンタを表    
形式で表示することもできます。perfmon カウンタを表形式で表示するには、新しいカテゴリを作 
成するときに [Present Data in Table View] チェックボックスをオンにする必要があります。

perfmon カウンタは、機能ベースのカウンタを表示するように整理し、カテゴリに保存できます。 
RTMT プロファイルを保存した後は、目的のカウンタにすばやくアクセスできます。カテゴリを作 
成した後に、図形式から表形式、またはその逆に表示形式を変更することはできません。

手順

ステップ 1 次のいずれかのタスクを実行します。

 • Quick Launch Channel で

－ [System] をクリックします。
－ ツリー階層で、[Performance] をダブルクリックします。
－ [Performance] アイコンをクリックします。

 • [System] > [Performance] > [Open Performance Monitoring] を選択します。

ステップ 2 監視するカウンタを追加するサーバの名前をクリックします。

ツリー階層が展開され、すべての perfmon オブジェクトが表示されます。

ステップ 3 カウンタを表形式で監視するには、ステップ 4 に進みます。カウンタを図形式で監視するには、ス  
テップ 9 に進みます。

ステップ 4 [Edit] > [New Category] を選択します。

ステップ 5 [Enter Name] フィールドに、タブの名前を入力します。

ステップ 6 perfmon カウンタを表形式で表示するには、[Present Data in Table View] チェックボックスをオンに      
します。

ステップ 7 [OK] をクリックします。

入力した名前を持つ新しいタブがペインの下部に表示されます。
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ステップ 8 監視するカウンタを一覧表示するオブジェクト名の横にあるファイル アイコンをクリックします。 
この手順の残りは省略してください。

ヒント カウンタを表形式で表示した後に図形式で表示するには、カテゴリ タブを右クリックし、 
[Remove Category] を選択します。カウンタが図形式で表示されます。

ステップ 9 カウンタを図形式で監視するには、次のタスクを実行します。

 • 監視するカウンタを一覧表示するオブジェクト名の横にあるファイル アイコンをクリックし 
ます。

カウンタのリストが表示されます。

 • カウンタ情報を表示するには、カウンタを右クリックして [Counter Monitoring] をクリックし、   
カウンタをダブルクリックするか、カウンタを RTMT Perfmon Monitoring ペインにドラッグ ア     
ンド ドロップします。

カウンタのグラフが RTMT Perfmon Monitoring ペインに表示されます。

追加情報

P.5-18 の「関連項目」を参照してください。

RTMT Performance Monitoring ペインからのカウンタの削除
カウンタが必要なくなったときには、RTMT Perfmon Monitoring ペインからカウンタを削除できま   
す。ここでは、ペインからカウンタを削除する方法を説明します。

次のいずれかのタスクを実行します。

 • 削除するカウンタを右クリックし、[Remove] を選択します。

 • 削除するカウンタをクリックし、[Performance] > [Remove Chart/Table Entry] を選択します。

RTMT Perfmon Monitoring ペインからカウンタが消去されます。

追加情報

P.5-18 の「関連項目」を参照してください。
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カウンタ インスタンスの追加
カウンタ インスタンスを追加するには、次の手順を実行します。

手順

ステップ 1 P.4-2 の「パフォーマンス モニタリングのための RTMT の使用方法」の説明に従って、パフォーマ    
ンス モニタリング カウンタを表示します。

ステップ 2 次のいずれかのタスクを実行します。

 • パフォーマンス モニタリング ツリー階層で、パフォーマンス モニタリング カウンタをダブル    
クリックします。

 • パフォーマンス モニタリング ツリー階層でパフォーマンス モニタリング カウンタをクリック    
し、[System] > [Performance] > [Counter Instances] を選択します。

 • パフォーマンス モニタリング ツリー階層でパフォーマンス モニタリング カウンタを右クリッ    
クし、[Counter Instances] を選択します。

ステップ 3 [Select Instance] ウィンドウで、インスタンスをクリックし、[Add] をクリックします。

カウンタが表示されます。

追加情報

P.5-18 の「関連項目」を参照してください。
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カウンタのアラート通知の設定
カウンタのアラート通知を設定する手順は次のとおりです。

ヒント カウンタのアラートを削除するには、カウンタを右クリックし、[Remove Alert] を選択します。ア  
ラートを削除すると、オプションがグレー表示になります。

手順

ステップ 1 P.4-2 の「パフォーマンス モニタリングのための RTMT の使用方法」の説明に従って、パフォーマ    
ンス カウンタを表示します。

ステップ 2 カウンタの図または表で、アラート通知を設定するカウンタを右クリックし、[Set Alert/Properties] 
を選択します。

ステップ 3 [Enable Alert] チェックボックスをオンにします。

ステップ 4 [Severity] ドロップダウン リスト ボックスで、通知の基準とするシビラティ レベルを選択します。

ステップ 5 [Description] ペインに、アラートの説明を入力します。

ステップ 6 [Next] をクリックします。

ステップ 7 表 5-1 を使用して、[Threshold]、[Value Calculated As]、[Duration]、[Frequency]、[Schedule] の各ペイ    
ンを設定します。ウィンドウに設定を入力したら、[Next] をクリックして次のペインに進みます。

表 5-1 カウンタのアラート設定パラメータ  

設定 説明

[Threshold] ペイン

Trigger alert when following 
conditions met (Over、Under)

チェックボックスをオンにし、適切な値を入力します。

 • Over：アラート通知がアクティブになる前に達する必要のある
最大しきい値を設定するには、このチェックボックスをオンに

します。[Over] フィールドに値を入力します。

 • Under：アラート通知がアクティブになる前に達する必要のあ
る最小しきい値を設定するには、このチェックボックスをオン

にします。[Under] フィールドに値を入力します。

ヒント これらのチェックボックスは、[Frequency] および 
[Schedule] の設定パラメータと組み合せて使用します。
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ステップ 8 システムがアラートの電子メール メッセージを送信するように設定する場合には、[Enable Email]  
チェックボックスをオンにします。

ステップ 9 すでに設定されているアラート アクションをトリガーする場合には、[Trigger Alert Action] ドロッ    
プダウン リスト ボックスからそのアラート アクションを選択します。

[Value Calculated As] ペイン

Absolute、Delta、Delta 
Percentage

適切なオプション ボタンをクリックします。

 • Absolute：データの現在のステータスを表示するには [Absolute] 
を選択します。 これらのカウンタ値は累積されます。

 • Delta：現在のカウンタ値と直前のカウンタ値の差を表示するに
は、[Delta] を選択します。 

 • Delta Percentage：カウンタのパフォーマンスの変化をパーセン 
トで表示するには、[Delta Percentage] を選択します。 

[Duration] ペイン

Trigger alert only when value 
constantly...、Trigger alert 
immediately

 • Trigger alert only when value constantly...：設定した秒数にわたっ     
て値が常にしきい値を下回ったか上回った場合に限りアラー

ト通知が必要な場合には、このオプション ボタンを選択し、ア 
ラートを送信するまでの秒数を入力します。 

 • Trigger alert immediately：アラート通知をすぐに送信する場合に  
は、このオプション ボタンをクリックします。

[Frequency] ペイン

Trigger alert on every poll、
Trigger up to...

適切なオプション ボタンをクリックします。

 • Trigger alert on every poll：しきい値に達したときにポーリング    
ごとにアラート通知をアクティブにする場合には、このオプ

ション ボタンをクリックします。

たとえば、進行中の通話数が継続的にしきい値を上回ったり下

回ったりしても、アラート通知は再送信されません。しきい値

が正常（進行中の通話数が 50 ～ 100）になると、アラート通知   
は非アクティブになります。ただし、しきい値が再びしきい値

を上回ったり下回ったりすると、アラート通知は再度アクティ

ブになります。

 • Trigger up to...：特定の間隔でアラート通知をアクティブにする  
場合には、このオプション ボタンをクリックし、送信するア 
ラート数、およびアラートの送信期間（分単位）を入力します。 

[Schedule] ペイン

24-hours daily、start/stop 適切なオプション ボタンをクリックします。

 • 24-hours daily：1 日 24 時間アラートをトリガーする場合には、    
このオプション ボタンをクリックします。

 • Start/Stop：特定の時間枠内でアラート通知をアクティブにする
場合には、このオプション ボタンをクリックし、開始時刻と停 
止時刻を入力します。このチェックボックスをオンにした場合

には、毎日のタスクの開始時刻と停止時刻を入力します。たと

えば、毎日午前 9:00 ～午後 5:00、または午後 9:00 ～午前 9:00      
にカウンタが確認されるように設定できます。

表 5-1 カウンタのアラート設定パラメータ （続き）

設定 説明
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ステップ 10 アラートに新しいアラート アクションを設定する場合には、[Configure] をクリックします。

（注） 指定したアラートがトリガーされるたびに、そのアラート アクションが送信されます。

[Alert Action] ダイアログボックスが表示されます。

ステップ 11 新しいアラート アクションを追加するには、[Add] をクリックします。

[Action Configuration] ダイアログボックスが表示されます。

ステップ 12 [Name] フィールドに、アラート アクションの名前を入力します。 

ステップ 13 [Description] フィールドに、アラート アクションの説明を入力します。

ステップ 14 アラート アクションの新しい電子メール受信者を追加するには、[Add] をクリックします。

[Input] ダイアログボックスが表示されます。

ステップ 15 アラート アクション通知を受信する受信者の電子メールまたは電子ページのアドレスを入力しま 
す。

ステップ 16 [OK] をクリックします。

受信者のアドレスが [Recipient] リストに表示されます。[Enable] チェックボックスがオンになりま   
す。

ヒント 受信者のアドレスを無効にするには、[Enable] チェックボックスをオフにします。
[Recipient] リストから受信者のアドレスを削除するには、そのアドレスを強調表示して、
[Delete] をクリックします。

ステップ 17 [OK] をクリックします。

ステップ 18 追加したアラート アクションが [Action List] に表示されます。

ヒント [Action List] からアラート アクションを削除するには、そのアラート アクションを強調    
表示して、[Delete] をクリックします。[Edit] をクリックして、既存のアラート アクショ   
ンを編集することもできます。

ステップ 19 [Close] をクリックします。

ステップ 20 [User-defined email text] ボックスに、電子メール メッセージに表示するテキストを入力します。

ステップ 21 [Activate] をクリックします。
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追加情報

P.5-18 の「関連項目」を参照してください。

カウンタのズーム
パフォーマンス カウンタの詳細を表示するには、RTMT Perfmon Monitoring ペインの perfmon モニ      
タ カウンタをズームできます。

手順

ステップ 1 次のいずれかのタスクを実行します。

 • RTMT Performance Monitoring ペインで、ズームするカウンタをダブルクリックします。カウン   
タのボックスが強調表示され、[Zoom] ウィンドウが自動的に表示されます。

 • RTMT Performance Monitoring ペインで、ズームするカウンタをクリックします。カウンタの   
ボックスが強調表示されます。[System] > [Performance] > [Zoom Chart] を選択します。[Zoom]      
ウィンドウが自動的に表示されます。

カウンタのモニタリングが開始されてからの、カウンタの最小値、最大値、平均値、および最新の

値のフィールドが表示されます。

ステップ 2 [OK] をクリックしてウィンドウを閉じます。

追加情報

P.5-18 の「関連項目」を参照してください。
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カウンタの説明の表示
カウンタの説明を表示するには、次のいずれかの方法を使用します。

手順

ステップ 1 次のいずれかのタスクを実行します。

 • [Performance] ツリー階層で、プロパティ情報を表示するカウンタを右クリックし、[Counter 
Description] を選択します。

 • RTMT Performance Monitoring ペインでカウンタをクリックし、メニューバーから [System] >     
[Performance] > [Counter Description] を選択します。 

ヒント カウンタの説明を表示し、データサンプリング パラメータを設定するには、P.5-10 の  
「データ サンプルの設定」を参照してください。

[Counter Property] ウィンドウにカウンタの説明が表示されます。説明には、ホスト アドレス、カウ   
ンタが属するオブジェクト、カウンタ名、カウンタの機能に関する簡単な概要が記載されています。

ステップ 2 [OK] ボタンをクリックして、[Counter Property] ウィンドウを閉じます。

追加情報

P.5-18 の「関連項目」を参照してください。
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データ サンプルの設定
[Counter Property] ウィンドウには、カウンタのデータ サンプルを設定するオプションが表示されま   
す。RTMT Perfmon Monitoring ペインに表示されるパフォーマンス カウンタには、緑のドットがあ    
り、データのサンプルが一定期間存在していることを示します。収集するデータ サンプルの数と、 
図に表示するデータ ポイントの数を設定できます。データ サンプルを設定した後、[View All Data]    
または [View Current Data] メニュー オプションを使用して情報を表示します。P.5-11 の「カウンタ      
データの表示」を参照してください。

ここでは、カウンタに対して収集するデータ サンプルの数を設定する方法を説明します。

手順

ステップ 1 P.4-2 の「パフォーマンス モニタリングのための RTMT の使用方法」の説明に従って、カウンタを    
表示します。

ステップ 2 次のいずれかのタスクを実行します。

 • データ サンプル情報を収集するカウンタを右クリックし、図形式を使用している場合は 
[Monitoring Properties] を、表形式を使用している場合は [Properties] を選択します。

 • データ サンプル情報を収集するカウンタをクリックし、[System] > [Performance] > [Monitoring     
Properties] を選択します。

[Counter Property] ウィンドウに、カウンタの説明、およびデータ サンプル設定用のタブが表示され   
ます。説明には、ホスト アドレス、カウンタが属するオブジェクト、カウンタ名、カウンタの機能 
に関する簡単な概要が記載されています。

ステップ 3 カウンタのデータ サンプル数を設定するには、[Data Sample] タブをクリックします。

ステップ 4 [No. of data samples] ドロップダウン リスト ボックスから、サンプル数（100 ～ 1000）を選択しま        
す。デフォルトは 100 です。

ステップ 5 [No. of data points shown on chart] ドロップダウン リスト ボックスから、図に表示するデータ ポイン          
トの数（10 ～ 50）を選択します。デフォルトは 20 です。

ステップ 6 表 5-2 で説明されているいずれかのパラメータをクリックします。

ステップ 7 [Counter Property] ウィンドウを閉じ、RTMT Perfmon Monitoring ペインに戻るには、[OK] ボタンを      
クリックします。

表 5-2 データ サンプル パラメータ 

パラメータ 説明

Absolute 一部のカウンタ値は累積値であるため、データの現在の状況を表示するには

[Absolute] を選択します。 
Delta 現在のカウンタ値と直前のカウンタ値の差を表示するには、[Delta] を選択し 

ます。 
Delta Percentage カウンタのパフォーマンスの変化をパーセントで表示するには、[Delta

Percentage] を選択します。 
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追加情報

P.5-18 の「関連項目」を参照してください。

カウンタ データの表示
パフォーマンス カウンタに関する収集データを表示するには、次の手順を実行します。 

手順

ステップ 1 RTMT Perfmon Monitoring ペイン内で、データ サンプルを表示するカウンタの図を右クリックし、    
[View All Data] を選択します。

サンプリングされたデータはカウンタの図にすべて表示されます。緑のドットは密に表示されるた

め、ほとんど実線のように見えます。

ステップ 2 現在表示されているカウンタを右クリックし、[View Current] を選択します。

最後に設定および収集されたデータ サンプルが、カウンタの図に表示されます。データ サンプル  
の設定手順については、P.5-10 の「データ サンプルの設定」を参照してください。

追加情報

P.5-18 の「関連項目」を参照してください。
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perfmon カウンタ データのローカル ロギング
RTMT では、さまざまな perfmon カウンタを選択して、ローカルにロギングできます。その後 
Performance Log Viewer を使用して、perfmon CSV ログのデータを表示できます。P.5-13 の
「Performance Log Viewer でのログ ファイルの表示」を参照してください。

カウンタ ログの開始
perfmon カウンタ データの CSV ログ ファイルへのロギングを開始するには、次の手順を実行しま     
す。

手順

ステップ 1 P.4-2 の「パフォーマンス モニタリングのための RTMT の使用方法」 の説明に従って、パフォーマ     
ンス モニタリング カウンタを表示します。

ステップ 2 perfmon カウンタを図形式で表示している場合には、データ サンプル情報のグラフを右クリックし、  
[Start Counter(s) Logging] を選択します。画面上のすべてのカウンタ（図形式と表形式の両方）を   
ロギングする場合には、ウィンドウの下部にあるカテゴリ名タブを右クリックし、[Start Counter(s) 
Logging] を選択します。

[Counter Logging Configuration] ダイアログボックスが表示されます。

ステップ 3 [Logger File Name] フィールドにファイル名を入力し、[OK] を選択します。

RTMT では、CSV ログ ファイルは、ユーザ ホーム ディレクトリ下の .jrtmt ディレクトリの log フォ         
ルダに保存されます。たとえば、Windows では C:\Documents and Settings\userA\.jrtmt\log、Linux で     
は /users/home/.jrtmt/log になります。

ログ ファイルの数とサイズを制限するには、Cisco Unified Serviceability の [Trace Configuration] ウィ       
ンドウで選択したサービスのトレース出力設定で、ログ ファイルの最大サイズおよび最大数のファ 
イル パラメータを設定します。『Cisco Unified Serviceability アドミニストレーション ガイド』を参     
照してください。

カウンタ ログの停止
perfmon カウンタ データのロギングを停止するには、次の手順を実行します。

手順

ステップ 1 P.4-2 の「パフォーマンス モニタリングのための RTMT の使用方法」 の説明に従って、パフォーマ     
ンス モニタリング カウンタを表示します。

ステップ 2 perfmon カウンタを図形式で表示している場合には、ロギングを開始するカウンタのグラフを右ク 
リックし、[Stop Counter(s) Logging] を選択します。画面上のすべてのカウンタ（図形式と表形式   
の両方）のロギングを停止する場合には、ウィンドウの下部にあるカテゴリ名のタブを右クリック

し、[Stop Counter(s) Logging] を選択します。
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追加情報

P.5-18 の「関連項目」を参照してください。

perfmon ログ ファイルの表示
RTMT で Performance Log Viewer を使用するか、Microsoft パフォーマンス ツールを使用して、       
perfmon CSV ログ ファイルのデータを表示できます。

Performance Log Viewer でのログ ファイルの表示
Performance Log Viewer は、perfmon CSV ログ ファイルのカウンタ データをグラフ形式で表示しま       
す。Performance Log Viewer を使用して、収集したローカル perfmon ログのデータを表示したり、     
Realtime Information Server Data Collection（RISDC）perfmon ログのデータを表示したりできます。

ローカル perfmon ログは、選択してコンピュータ上にローカルに保存したカウンタのデータで構成  
されています。カウンタの選択方法およびローカル ロギングの開始および停止方法については、 
P.5-12 の「perfmon カウンタ データのローカル ロギング」を参照してください。

手順

ステップ 1 次のいずれかのタスクを実行します。

 • Quick Launch Channel で

－ [System] をクリックします。
－ ツリー階層で、[Performance] をダブルクリックします。

－ [Performance Log Viewer] アイコンをクリックします。
 • [System] > [Performance] > [Open Performance Log Viewer] を選択します。

ステップ 2 表示する perfmon ログのタイプを選択します。

 • RISDC perfmon ログの場合には、次の手順を実行します。

a. [RISDC Perfmon Logs] をクリックするか、[Select a node] ドロップダウン ボックスからノー       
ドを選択します。

b. [Open] をクリックします。

[File Selection] ダイアログボックスが表示されます。

c. ファイルを選択し、[Open File] をクリックします。

[Select Counters] ダイアログボックスが表示されます。

d. 表示するカウンタを選択するには、カウンタの横にあるチェックボックスをオンにします。

e. [OK] をクリックします。

 • ローカルに保存されたデータの場合には、次の手順を実行します。

a. [Local Perfmon Logs] をクリックします。

b. [Open] をクリックします。

[File Selection] ダイアログボックスが表示されます。RTMT では、perfmon CSV ログ ファイ      
ルは、ユーザ ホーム ディレクトリ下の .jrtmt ディレクトリの log フォルダに保存されます。      
Windows では C:\Documents and Settings\userA\.jrtmt\log、Linux では /users/home/.jrtmt/log に       
なります。
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c. ファイル ディレクトリを参照します。

d. 表示するファイルを選択するか、ファイル名のフィールドにファイル名を入力します。

e. [Open] をクリックします。

[Select Counters] ダイアログボックスが表示されます。

f. 表示するカウンタを選択するには、カウンタの横にあるチェックボックスをオンにします。

g. [OK] をクリックします。

Performance Log Viewer は、選択されたカウンタのデータを使用して図を表示します。下部のペイ   
ンには、選択したカウンタ、選択したカウンタの色の凡例、表示オプション、平均値、最小値、お

よび最大値が表示されます。 

表 5-3 は、Performance Log Viewer で使用可能なボタンの機能を説明しています。

ヒント 列見出しをクリックして、各列を並べ替えることができます。列見出しを初めてクリッ

クしたときには、レコードが昇順で表示されます。小さな上向きの三角形は昇順である

ことを示します。列見出しを再度クリックすると、レコードが降順で表示されます。小

さな下向きの三角形は降順であることを示します。列見出しをもう一度クリックすると、

レコードがソートされる前の状態で表示されます。

追加情報

P.5-18 の「関連項目」を参照してください。

ズームインとズームアウト

Performance Log Viewer には、図の領域をズームインできるズーム機能があります。ズームインす   
るには、マウスの左ボタンをクリックしてドラッグし、ズームする領域を選択します。

図を最初のデフォルト表示にリセットするには、[Reset View] をクリックするか、図を右クリック  
して [Reset] を選択します。

追加情報

P.5-18 の「関連項目」を参照してください。

表 5-3 Performance Log Viewer

ボタン 機能

Select Counters Performance Log Viewer で表示するカウンタを追加できます。カウンタ   
を表示しないようにするには、カウンタの横の [Display] 列のチェック  
をオフにします。

Reset View Performance Log Viewer を最初のデフォルト表示にリセットします。
Save Downloaded File ログ ファイルをローカル コンピュータに保存できます。
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Microsoft パフォーマンス ツールでの perfmon ログ ファイルの表示
Microsoft パフォーマンス ツールを使用してログ ファイルを表示するには、次の手順を実行します。

手順

ステップ 1 ［スタート］>［設定］>［コントロール パネル］>［管理ツール］>［パフォーマンス］を選択します。

ステップ 2 アプリケーション ウィンドウで右クリックし、［プロパティ］を選択します。

ステップ 3 ［システム モニタのプロパティ］ダイアログボックスの［ソース］タブをクリックします。

ステップ 4 perfmon ログ ファイルをダウンロードしたディレクトリを参照し、perfmon csv ファイルを選択しま    
す。ログ ファイルの命名規則は、PerfMon_<ノード >_<月 >_<日 >_<年 >_<時 >_<分 >.csv です。  
たとえば、PerfMon_172.19.240.80_06_15_2005_11_25.csv のようになります。

ステップ 5 ［適用］をクリックします。

ステップ 6 ［時間の範囲］ボタンをクリックします。表示する perfmon ログ ファイルについて期間を指定する   
には、バーを適切な開始時刻と終了時刻にドラッグします。

ステップ 7 ［カウンタの追加］ダイアログボックスを開くには、［データ］タブをクリックし、［追加］をクリッ
クします。

ステップ 8 ［パフォーマンス オブジェクト］ドロップダウン ボックスから、perfmon オブジェクトを選択しま   
す。オブジェクトに複数のインスタンスがある場合には、［すべてのインスタンス］を選択するか、

表示するインスタンスだけを選択します。

ステップ 9 ［すべてのカウンタ］を選択するか、表示するカウンタだけを選択します。

ステップ 10 選択したカウンタを追加するには、［追加］をクリックします。

ステップ 11 カウンタの選択が終了したら、［閉じる］をクリックします。

追加情報

P.5-18 の「関連項目」を参照してください。
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トラブルシューティング用 perfmon データ ロギング
RISDC perfmon ロギングを有効にすると、システムの情報が、サーバ上で書き込まれるログに収集  
されます。Cisco Unity Connection の管理で RISDC perfmon ロギングを有効または無効にするには、      
［システム設定（System Settings）］ >［サービス パラメータ（Service Parameters）］を選択し、［サー    
ビス（Service）］ドロップダウン メニューから [Cisco RIS Data Collector] を選択します。デフォルト      
では、RISDC perfmon ロギングは有効になります。RISDC perfmon ロギングは、トラブルシューティ    
ング用 perfmon データ ロギングとも呼ばれます。RISDC perfmon ロギングを有効にすると、問題の     
トラブルシューティングに使用されるパフォーマンス データも収集されます。

Cisco RIS Data Collector サービスのログ ファイルをサーバ上で収集するには、RTMT を使用してロ      
グ ファイルをダウンロードします。CLI を使用してログ ファイルをダウンロードする場合には、   
『Cisco Unified Communications Operating System アドミニストレーション ガイド』を参照してくださ      
い。ログ ファイルを収集したら、RTMT で Performance Log Viewer を使用するか、Microsoft Windows       
パフォーマンス ツールを使用して、ログ ファイルを表示できます。P.5-13 の「Performance Log    
Viewer でのログ ファイルの表示」または P.5-15 の「Microsoft パフォーマンス ツールでの perfmon      
ログ ファイルの表示」を参照してください。

トラブルシューティング用 Perfmon データ ロギングの設定
トラブルシューティング用 perfmon データ ロギング機能を設定する手順は次のとおりです。

手順

ステップ 1 Cisco Unity Connection の管理で［システム（System）］を展開し、［サービス パラメータ（Service    
Parameters）］をクリックします。

ステップ 2 ［サービス パラメータ（Service Parameters）］ページの［サーバ（Server）］ドロップダウン リスト   
ボックスからサーバを選択します。

ステップ 3 ［サービス（Service）］ドロップダウン リスト ボックスから、[Cisco RIS Data Collector] を選択します。

ステップ 4 表 5-4 の説明に従って、適切な設定を入力します。

ステップ 5 ［保存 (Save)］をクリックします。



第 5章      パフォーマンス カウンタの設定と表示
トラブルシューティング用 perfmon データ ロギング   

5-17
Real-Time Monitoring Tool アドミニストレーション ガイド for Cisco Unity Connection        

OL-13895-01-J

トラブルシューティング用 Perfmon データ ロギングのコンフィギュレーション設定
表 5-4 は、トラブルシューティング用 perfmon データ ロギングを有効および無効にするために使用    
可能な設定の説明です。

表 5-4 トラブルシューティング用 Perfmon データ ロギングのパラメータ

フィールド 説明

Enable Logging トラブルシューティング用 perfmon データ ロギングを有効にするには   
[True] を、無効にするには [False] をドロップダウン ボックスから選択しま    
す。デフォルト値は [True] です。

Polling Rate ポーリング レート間隔を入力します（秒単位）。5（最小）～ 300（最大）の  
値を入力できます。デフォルト値は 15 です。

Maximum No. of Files ディスクに保存するトラブルシューティング用 Perfmon データ ロギング   
ファイルの最大数を入力します。1（最小）～ 100（最大）の値を入力でき 
ます。デフォルト値は 50 です。

Maximum No. of Files パラメータと Maximum File Size パラメータを設定す        
るときには、ストレージ容量を考慮してください。[Maximum Number of  
Files] 値と [Maximum File Size] 値を掛けた値が 100 MB を超えないようにす        
ることをお勧めします。

ファイルの数が、このフィールドで指定した最大ファイル数を超えると、タ

イムスタンプが最も古いログ ファイルが削除されます。 

注意 このパラメータを変更する前にログ ファイルを別のマシンに保 
存しないと、ログ ファイルを失う危険性があります。 

Maximum File Size 新しいファイルが開始される前に perfmon ログ ファイルに保存する最大   
ファイル サイズ（MB 単位）を入力します。1（最小）～ 500（最大）の値   
を入力できます。デフォルト値は 2 MB です。

Maximum No. of Files パラメータと Maximum File Size パラメータを設定す        
るときには、ストレージ容量を考慮してください。[Maximum Number of  
Files] 値と [Maximum File Size] 値を掛けた値が 100 MB を超えないようにす        
ることをお勧めします。
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関連項目
 • パフォーマンス カウンタの表示（P.5-2）

 • RTMT Performance Monitoring ペインからのカウンタの削除（P.5-3）

 • カウンタ インスタンスの追加（P.5-4）

 • カウンタのアラート通知の設定（P.5-5）

 • カウンタのズーム（P.5-8）

 • カウンタの説明の表示（P.5-9）

 • データ サンプルの設定（P.5-10）

 • カウンタ データの表示（P.5-11）

 • perfmon カウンタ データのローカル ロギング（P.5-12）

 • Performance Log Viewer でのログ ファイルの表示（P.5-13）

 • パフォーマンス モニタリングの概要（P.4-1）

 • システムのパフォーマンス オブジェクトとパフォーマンス カウンタ（P.A-1）

 • Cisco Unity Connection のパフォーマンス オブジェクトとパフォーマンス カウンタ（P.B-1）
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6
アラート

この章は、次の項で構成されています。

 • アラートの概要（P.6-2）

 • アラートの表示（P.6-3）

 • アラートのフィールド（P.6-4）

 • アラート アクションの設定（P.6-5）

 • トレース ダウンロードの有効化（P.6-5）

 • アラート ログの概要（P.6-6）

 • Log Partition Monitoring（P.6-7）
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アラートの概要
アクティブになっているサービスが停止したときなど、あらかじめ設定されている条件が満たされ

ると、その旨を管理者に通知するためのアラート メッセージが生成されます。アラートは、電子 
メールまたは電子ページとして送信できます。

RTMT は、アラートの定義、設定、表示をサポートし、あらかじめ設定されているアラートとユー 
ザ定義のアラートが利用できます。両方のタイプのアラートを設定できますが、あらかじめ設定さ

れているアラートの削除はできません（ユーザ定義のアラートの追加および削除は可能です）。

[Alert] メニューは、次のメニュー オプションで構成されます。

 • Alert Central：このオプションは、システム内のすべてのアラートの履歴と現在のステータスで 
構成されます。

（注） システム ドロワの階層ツリーにある [Alert Central] アイコンをクリックして [Alert Central]      
にアクセスすることもできます。

 • Set Alert/Properties：アラートとアラート プロパティを設定できます。

 • Remove Alert：アラートを削除できます。

 • Enable Alert：アラートを使用可能にできます。

 • Disable Alert：このカテゴリでアラートを使用不可にできます。

 • Suspend cluster/node Alerts：アラートを一時停止できます。

 • Clear Alerts：アラートをリセットして（アラート項目の色が赤から黒に変わります）、アラート 
が処理済みであると示すことができます。アラートが発生すると、RTMT でアラートの色が自 
動的に変わり、アラートを手動でクリアするまでそのままです。

 • Clear All Alerts：すべてのアラートをクリアできます。

 • Alert Detail：アラート イベントに関する詳細情報を表示します。

 • Config Email Server：電子メール サーバを設定してアラートを有効にできます。

 • Config Alert Action：特定のアラートに対するアクションの設定、および目的の電子メール受信  
者にアラートを送信するアクションの設定ができます。

RTMT では、perfmon カウンタのしきい値に対するアラート通知の設定と、しきい値、期間、頻度  
などのアラートのプロパティを設定します。

[Alert Central] は、Quick Launch Channel の [Tools] 階層ツリーの配下にあります。[Alert Central] に         
は、システム内のすべてのアラートの現在のステータスと履歴が表示されます。 

追加情報

P.6-8 の「関連項目」を参照してください。
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アラートの表示
RTMT の [Alert Central] には、あらかじめ設定されているアラートとカスタム アラートが表示され     
ます。RTMT は、[System]、[Cisco Unity Connection]、[Custom] といった複数のタブの下でアラート    
を構成します。

[Alert Central] で、あらかじめ設定されているアラートとカスタム アラートを有効または無効にで   
きます。ただし、あらかじめ設定されているアラートは削除できません。

システムであらかじめ設定されているアラートは、次のとおりです。

 • AuthenticationFailed

 • CoreDumpFileFound

 • CpuPegging

 • CriticalServiceDown

 • LogFileSearchStringFound

 • LogPartitionHighWaterMarkExceeded

 • LogPartitionLowWaterMarkExceeded

 • LowActivePartitionAvailableDiskSpace

 • LowAvailableVirtualMemory

 • LowInactivePartitionAvailableDiskSpace

 • LowSwapPartitionAvailableDiskSpace

 • SyslogSeverityMatchFound

 • SyslogStringMatchFound

 • ThreadCounterUpdateStopped

追加情報

P.6-8 の「関連項目」を参照してください。
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アラートのフィールド
RTMT で、あらかじめ設定されているアラートとユーザ定義のアラートを設定できます。また、あ 
らかじめ設定されているアラートとユーザ定義のアラートの両方を無効にすることもできます。パ

フォーマンス モニタリング ウィンドウでは、ユーザ定義のアラートを追加および削除できます。た  
だし、あらかじめ設定されているアラートは削除できません。

表 6-1 は、各アラートの設定に使用できるフィールドのリストです。特に記載がない限り、あらか 
じめ設定されているフィールドはユーザ設定が可能です。

表 6-1 アラートのカスタマイズ 

フィールド 説明 コメント

Alert Name RTMT がアラートに関連付けるモニタリ 
ング項目の高レベル名

説明的な名前。あらかじめ設定されているア

ラートの場合、このフィールドは変更できませ

ん。あらかじめ設定されているアラートのリス

トについては、P.6-3 の「アラートの表示」を参 
照してください。

Description アラートの説明 あらかじめ設定されているアラートの場合、こ

のフィールドは編集できません。あらかじめ設

定されているアラートのリストについては、

P.6-3 の「アラートの表示」を参照してください。
Performance Counter(s) パフォーマンス カウンタのソース このフィールドは変更できません。

Threshold アラートの生成条件（値） 上限 < - > 下限（#、%、レートより小さい、#、    
%、レートより大きい）を指定します。

Value Calculated As しきい値条件を確認する方法 評価する値を絶対値、差分（現在と前回）、また

は差分（%）で指定します。
Duration アラートの生成条件（アラートを生成する

までのしきい値の持続時間）

すぐにアラートを送信させるオプション、また

はアラートが指定時間持続した後に送信させる

オプションがあります。

Number of Events Threshold 設定可能なイベント数が、設定可能な時間
間隔（分）の中でしきい値を超えたときに

限りアラートを生成します。

ExcessiveVoiceQualityReports の場合、デフォルト 
のしきい値は 60 分以内に 10 件です。 
RouteListExhausted と MediaListExhausted の場   
合、デフォルトは 60 分以内に 0 件です。

Alert Action ID 実行するアラート アクションの ID（どの  
ようなアラート アクションでも、システ 
ムは常にアラートを記録します）。

アラート アクションは最初に定義されます 
（P.6-5 の「追加情報」を参照）。このフィールド 
が空白の場合は、電子メールが使用不可である

ことを示しています。

Enable Alerts アラートを有効または無効にします。 オプションは、使用可能または使用不可です。

Clear Alert アラートをリセットして（アラート項目の

色が赤から黒に変わります）、アラートが

解決されたことを示します。

アラートが発生すると、アラートの色が自動的

に変わり、アラートを手動でクリアするまでそ

のままです。すべてのアラートをクリアするに

は、[Clear All] を使用します。
Alert Details アラートの詳細を表示します（設定不可）。該当なし

Alert Generation Rate アラート条件が持続したときにアラート

を生成する頻度

X 分ごとに指定します（条件が持続した場合に 
は、X 分ごとに 1 回アラートが生成されます）。

X 分ごとに最大 Y 回と指定します（条件が持続   
した場合には、X 分ごとに Y 回アラートが生成   
されます）。
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追加情報

P.6-8 の「関連項目」を参照してください。

アラート アクションの設定
RTMT では、生成されるアラートごとにアラート アクションを設定して、アラート アクション リ    
ストで指定した電子メール受信者にアラート アクションを送信できます。

表 6-2 は、アラート アクションの設定に使用するフィールドのリストです。特に記載がない限り、  
ユーザはすべてのフィールドを設定できます。

追加情報

P.6-8 の「関連項目」を参照してください。

トレース ダウンロードの有効化
あらかじめ設定されているアラートの中には、イベントが発生するとトレース ダウンロードを開始 
できるアラートがあります。次のアラートで [Set Alert/Properties] の [Enable Trace Download] チェッ       
クボックスをオンにすることにより、特定のイベントが発生したときに、トレースを自動的に取り

込めます。

 • CriticalServiceDown

 • CodeYellow

 • CoreDumpFileFound

注意 トレース ダウンロードを有効にすると、サーバのサービスに影響する場合があります。 
多数のダウンロードを設定すると、サーバのサービス品質に悪影響が出ます。

追加情報

P.6-8 の「関連項目」を参照してください。

User Provide Text あらかじめ設定されているアラート テキ 
ストの先頭にテキストを付加する管理者

該当なし

Severity 表示用（たとえば、シビラティ 1 のアラー  
トだけを表示する）

あらかじめ設定されているアラート（Error、
Warning、Information など）に割り当てられるデ 
フォルトを指定します。

表 6-1 アラートのカスタマイズ（続き）

フィールド 説明 コメント

表 6-2 アラート アクションの設定 

フィールド 説明 コメント

Alert Action ID 実行するアラート アクションの ID 説明的な名前を指定します。

Mail Recipients 電子メール アドレスのリスト。リスト内の個別の電 
子メールを選択的に使用可能 /使用不可にできます。

該当なし
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アラート ログの概要
アラートは、アラート ログに保存されます。また、メモリにも保存されます。メモリは一定間隔で 
クリアされ、メモリには、最後の 30 分間のデータが残されます。サービスが開始または再開され  
ると、サーバに存在するアラート ログから最後の 30 分間のアラート データが読み込まれ、メモリ    
にロードされます。メモリ内のアラート データは、要求に応じて RTMT クライアントに送信され   
ます。

RTMT の起動時に、RTMT は、最後の 30 分間に発生したすべてのログを Alert Central ログ履歴に表       
示します。アラート ログは定期的に更新され、新しいログがログ履歴ウィンドウに挿入されます。 
ログ件数が 100 に達すると、RTMT は最も古い 40 件のログを削除します。

アラート ログのファイル名の形式は、AlertLog_MM_DD_YYYY_hh_mm.csv です。

アラート ログの属性は次のとおりです。

 • Time Stamp：RTMT がデータを記録した時刻

 • Alert Name：説明的なアラート名

 • Node：アラートが発生したサーバ

 • Alert Message：アラートに関する詳細説明

 • Description：監視されるオブジェクトの説明

 • Severity：アラートのシビラティ

 • PollValue：アラート条件が発生した監視対象オブジェクトの値

 • Action：実行されたアラート アクション

 • Group ID：アラートの生成元を特定

各ログ ファイルの最初の行はヘッダーです。各アラートの詳細は 1 行に書き込まれ、カンマで区切   
られています。

追加情報

P.6-8 の「関連項目」を参照してください。
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Log Partition Monitoring
Log Partition Monitoring は、システムとともに自動的にインストールされ、設定可能なしきい値を使   
用して、サーバのログ パーティションのディスク使用状況を監視します。Cisco Log Partitioning   
Monitoring Tool サービスは、Cisco Unity Connection のインストール後に自動的に開始されます。

Log Partition Monitoring は、次の設定済みのしきい値を使用して、サーバ上のログ パーティション    
のディスク使用状況を 5 分ごとに監視します。

 • LogPartitionLowWaterMarkExceeded（ディスク スペース使用率）：ディスク使用率が指定のパー 
センテージを超えると、LPM はすべてのアラーム メッセージを syslog に送信し、RTMT Alert     
Central にアラートを送信します。ログ ファイルを保存し、ディスク スペースを回復するには、   
RTMT の [Trace and Log Central] オプションを使用します。

 • LogPartitionHighWaterMarkExceeded（ディスク スペース使用率）：ディスク使用率が指定のパー 
センテージを超えると、LPM はすべてのアラーム メッセージを syslog に送信し、RTMT Alert     
Central にアラートを送信します。

さらに、Cisco Log Partitioning Monitoring Tool サービスは、5 秒ごとにサーバをチェックして、新た      
に作成されたコア ダンプ ファイルの有無をチェックします。新しいコア ダンプ ファイルが存在し    
た場合には、Cisco Log Partitioning Monitoring Tool サービスにより、CoreDumpFileFound アラームと      
アラートが新しいコア ファイルに関する情報とともに Alert Central に送信されます。

ログ パーティション モニタを利用するには、ネットワーク サービスである Cisco Log Partitioning      
Monitoring Tool サービスが Cisco Unified Serviceability 上のサーバで稼働していることを確認しま      
す。サービスを停止すると、機能が失われます。

Log Partition Monitoring サービスは、システム起動時に開始されたときに、現在のディスク使用状況   
をチェックします。ディスク使用率が最低水準点を上回っていても、最高水準点を下回っている場

合には syslog にアラーム メッセージが送信され、RTMT Alert Central で対応するアラートが生成さ      
れます。

Log Partitioning Monitoring を設定するには、Alert Central で LogPartitionLowWaterMarkExceeded ア       
ラートと LogPartitionHighWaterMarkExceeded アラートのアラート プロパティを設定します。詳細に   
ついては、P.7-4 の「アラート プロパティの設定」を参照してください。

ログ ファイルをオフロードし、サーバ上のディスク スペースを元の状態に戻すには、Real-Time  
Monitoring Tool を使用して、保存するトレースを収集する必要があります。

ディスク使用率が設定した最高水準点より高い場合には、syslog にアラーム メッセージが送信さ  
れ、RTMT の Alert Central で対応するアラートが生成され、値が最低水準点に達するまでログ ファ     
イルが自動的に削除されます。

（注） Log Partition Monitoring は、アクティブなディレクトリと非アクティブなディレクトリを含む共通   
のパーティションを自動的に識別します。アクティブなディレクトリは、現在の Cisco Unity  
Connection のログ ファイルを格納しており、非アクティブなディレクトリは、以前にインストール  
されたバージョンの Cisco Unity Connection のログ ファイルを格納しています。必要に応じて、こ     
のサービスは非アクティブなディレクトリのログ ファイルを先に削除します。次に、すべてのア 
プリケーションの最も古いログ ファイルから順に、ディスク スペースのパーセンテージが設定さ  
れた最低水準点を下回るまで、アクティブなディレクトリのログ ファイルを削除します。Log 
Partition Monitoring によってログ ファイルが削除されても、システムは電子メールを送信しません。

システムがディスク使用状況を判断し、必要なタスク（アラームの送信、アラートの生成、ログの

削除）を実行した後は、Log Partition Monitoring が通常の 5 分間隔で行われます。
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関連項目
 • アラートの概要（P.6-2）

 • アラートの表示（P.6-3）

 • アラートのフィールド（P.6-4）

 • アラート アクションの設定（P.6-5）

 • トレース ダウンロードの有効化（P.6-5）

 • アラート ログの概要（P.6-6）

 • アラートの使用（P.7-2）

 • アラート プロパティの設定（P.7-4）

 • アラートの一時停止（P.7-6）

 • アラート通知用電子メールの設定（P.7-7）

 • アラート アクションの設定（P.7-7）
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7
アラートの使用

この章は、次の項で構成されています。

 • アラートの使用（P.7-2）

 • アラート プロパティの設定（P.7-4）

 • アラートの一時停止（P.7-6）

 • アラート通知用電子メールの設定（P.7-7）

 • アラート アクションの設定（P.7-7）
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アラートの使用
次の手順を実行して、[Alert Central] へのアクセス、アラート情報のソート、アラートの有効化、無  
効化、削除、アラートのクリア、アラートの詳細の表示などのタスクを実行できます。

手順

ステップ 1 次のいずれかのタスクを実行します。

 • Quick Launch Channel で

－ [System] をクリックします。
－ ツリー階層で、[Tools] をダブルクリックします。
－ [Alert Central] アイコンをクリックします。

 • [System] > [Tools] > [Alert] > [Alert Central] を選択します。

生成されたアラートのステータスと履歴を示す [Alert Central] モニタリング ウィンドウが表示され    
ます。

ステップ 2 次のいずれかのタスクを実行します。

 • アラートのプロパティを設定するには、P.7-4 の「アラート プロパティの設定」を参照してく  
ださい。

 • サーバでアラートを一時停止するには、P.7-6 の「アラートの一時停止」を参照してください。

 • アラート通知用の電子メールを設定するには、P.7-7 の「アラート通知用電子メールの設定」を 
参照してください。

 • アラート アクションを設定するには、P.7-7 の「アラート アクションの設定」を参照してくだ   
さい。

 • アラート ステータス ペイン内のアラート情報をソートするには、列見出しの上向き矢印また  
は下向き矢印をクリックします。たとえば、[Enabled] 列や [In Safe Range] 列に表示される上向     
き矢印または下向きの矢印をクリックします。

アラート履歴情報をソートするには、[Alert History] ペインの列の上向き矢印または下向き矢印  
をクリックします。ペインに表示されていないアラート履歴を表示するには、[Alert History] ペ  
インの右側にあるスクロール バーを使用します。

 • アラートを有効にする、無効にする、または削除するには、次のいずれかのタスクを実行しま

す。

－ アラート ステータス ウィンドウでアラートを右クリックし、目的の操作に応じて、
[Disable/Enable Alert]（オプション トグル）または [Remove Alert] を選択します。

－ アラート ステータス ウィンドウでアラートを強調表示し、[System] > [Tools] > [Alert] > 
[Disable/Enable Alert]（または [Remove Alert]）を選択します。

ヒント ユーザ定義のアラートに限り、RTMT から削除できます。あらかじめ設定されているア 
ラートを選択すると、[Remove Alert] オプションがグレー表示されます。

 • アラートを解決した後に、アラートを個別に、またはまとめてクリアするには、次のいずれか

のタスクを実行します。

－ アラート ステータス ウィンドウが表示されたら、アラートを右クリックし、[Clear Alert]   
（または [Clear All Alerts]）を選択します。

－ アラート ステータス ウィンドウでアラートを強調表示し、[System] > [Tools] > [Alert] > 
[Clear Alert]（または [Clear All Alerts]）を選択します。
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アラートをクリアすると、アラートの色が赤から黒に変わります。

 • アラートの詳細を表示するには、次のいずれかのタスクを実行します。

－ アラート ステータス ウィンドウが表示されたら、アラートを右クリックし、[Alert Details]   
を選択します。

－ アラート ステータス ウィンドウでアラートを強調表示し、[System] > [Tools] > [Alert] > 
[Alert Details] を選択します。

ヒント アラートの詳細を確認したら、[OK] をクリックします。

追加情報

P.7-8 の「関連項目」を参照してください。
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アラート プロパティの設定
アラート プロパティを設定する手順は次のとおりです。

手順

ステップ 1 P.7-2 の「アラートの使用」の説明に従って、[Alert Central] を表示します。

ステップ 2 アラート ステータス ウィンドウで、アラート プロパティを設定するアラートをクリックします。

ステップ 3 次のいずれかのタスクを実行します。

 • アラートを右クリックし、[Set Alert/Properties] を選択します。

 • [System] > [Tools] > [Alert] > [Set Alert/Properties] を選択します。

ステップ 4 アラートを使用可能にするには、[Enable Alert] チェックボックスをオンにします。

ステップ 5 [Severity] ドロップダウン リスト ボックスから、アラートのシビラティを選択します。

ステップ 6 [Enable/Disable this alert on following server(s)] ペインで、このアラートを使用可能にするサーバの      
[Enable] チェックボックスをオンにします。

あらかじめ設定されているアラートについては、[Description] 情報ペインにアラートの説明が表示 
されます。

ステップ 7 [Next] をクリックします。

ステップ 8 [Threshold] ペインに、システムがアラートをトリガーする条件を入力します。

ステップ 9 [Duration] ペインで、次のいずれかのオプション ボタンをクリックします。

 • Trigger alert only when below or over....：値が特定の秒数にわたって常にしきい値を下回るまたは      
上回る場合に限り、アラートがトリガーされます。秒数を入力します。

 • Trigger alert immediately：アラートがすぐにトリガーされます。

ステップ 10 [Next] をクリックします。

ステップ 11 [Frequency] ペインで、次のいずれかのオプション ボタンをクリックします。

 • Trigger alert on every poll：ポーリングのたびにアラートがトリガーされます。

 • Trigger up to <numbers> of alerts within <number> of minutes：特定の時間（分単位）の間に、特定         
の回数のアラートがトリガーされます。アラートの回数と時間（分単位）を入力します。

ステップ 12 [Schedule] ペインで、次のいずれかのオプション ボタンをクリックします。

 • 24-hours daily：アラートが 1 日 24 時間トリガーされます。

 • Start time/Stop time：特定の開始時刻と終了時刻の間のみアラートがトリガーされます。開始時  
刻と終了時刻を入力します。

ステップ 13 [Next] をクリックします。
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ステップ 14 このアラートの電子メールを使用可能にする場合は、[Enable Email] チェックボックスをオンにしま  
す。

ステップ 15 このアラートでアラート アクションをトリガーするには、ドロップダウン リスト ボックスから、   
送信するアラート アクションを選択します。

ステップ 16 新しいアラート アクションを設定、または既存のアラート アクションを編集するには、[Configure]  
をクリックします。

ステップ 17 新しいアラート アクションを追加するには、ステップ 18 に進みます。既存のアラート アクション    
を編集するには、ステップ 25 に進みます。

ステップ 18 [Add] をクリックします。

ステップ 19 [Name] フィールドに、アラート アクションの名前を入力します。

ステップ 20 [Description] フィールドに、アラート アクションの説明を入力します。

ステップ 21 電子メール受信者を追加するには、[Add] をクリックします。

ステップ 22 [Enter email/epage address] フィールドに、アラート アクションの受信者の電子メールまたは電子    
ページのアドレスを入力します。

ステップ 23 [OK] をクリックします。

[Action Configuration] ウィンドウに、追加した受信者が表示され、[Enable] チェックボックスがオン   
になります。

ヒント 電子メールの受信者を削除するには、その受信者を強調表示し、[Delete] をクリックしま 
す。選択した受信者が、受信者リストから削除されます。

ステップ 24 すべての受信者を追加したら、[OK] をクリックします。ステップ 27 に進みます。

ステップ 25 既存のアラート アクションを編集するには、アラート アクションを強調表示し、[Edit] をクリック   
します。

選択したアラート アクションの [Action Configuration] ウィンドウが表示されます。

ステップ 26 設定を更新して、[OK] をクリックします。ステップ 27 に進みます。

ステップ 27 アラート アクションの設定を終了したら、[Close] をクリックします。

ステップ 28 トレース ダウンロードが許可されていないアラートの場合は、[Alert Properties：Email Notification]   
ウィンドウで [Activate] をクリックします。

CriticalServiceDown や CodeYellow のようにトレース ダウンロードが許可されているアラートの場    
合は、次の手順を実行します。

a. [Next] をクリックします。
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b. [Alert Properties：Trace Download] ウィンドウで、[Enable Trace Download] チェックボックスを      
オンにします。

c. [SFTP Parameters Dialog] ウィンドウが表示されます。IP アドレス、ユーザ名、パスワード、ポー    
ト、およびトレースを保存するためのダウンロード ディレクトリ パスを入力します。SFTP サー   
バとの接続性を確認するには、[Test Connection] をクリックします。接続テストに失敗した場  
合、設定は保存されません。

d. [OK] をクリックして、設定を保存します。

e. [Trace Download Parameters] ウィンドウに、ダウンロードの回数と頻度を入力します。ダウン   
ロードの回数と頻度を設定すると、ダウンロードされるトレース ファイルを制限するのに役立 
ちます。ポーリングの設定が、頻度のデフォルト設定の基準となります。

注意 トレース ダウンロードを有効にすると、サーバのサービスに影響する場合があります。 
多数のダウンロードを設定すると、サーバのサービス品質に悪影響が出ます。

（注） アラート アクションを削除するには、そのアクションを強調表示し、[Delete] をクリックし  
て、[Close] をクリックします。

追加情報

P.7-8 の「関連項目」を参照してください。

アラートの一時停止
場合によっては、Cisco Unity Connection の一部またはすべてのアラートを一時的に停止する必要が   
生じることがあります。[Alert Central] でアラートを一時停止する手順は次のとおりです。

手順

ステップ 1 [System] > [Tools] > [Alert] > [Suspend cluster/node Alerts] を選択します。

ステップ 2 [Per Server] オプション ボタンを選択し、サーバの [Suspend] チェックボックスをオンにします。

ステップ 3 [OK] をクリックします。

（注） アラートを再開するには、再び [Alert] > [Suspend cluster/node Alerts] を選択し、[Suspend]      
チェックボックスをオフにします。

追加情報

P.7-8 の「関連項目」を参照してください。
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アラート通知用電子メールの設定
アラート通知用の電子メール情報を設定するには、次の手順を実行します。

手順

ステップ 1 [System] > [Tools] > [Alert] > [Config Email Server] を選択します。

[Mail Server Configuration] ウィンドウが表示されます。

ステップ 2 [Mail Server] フィールドに、電子メール受信者の情報を入力します。

ステップ 3 [Port] フィールドに、メール サーバのポート番号を入力します。

ステップ 4 [OK] をクリックします。

追加情報

P.7-8 の「関連項目」を参照してください。

アラート アクションの設定
新しいアラート アクションを設定する手順は次のとおりです。

手順

ステップ 1 P.7-2 の「アラートの使用」の説明に従って、[Alert Central] を表示します。

ステップ 2 [Alert] > [Config Alert Action] を選択します。

ステップ 3 P.7-4 の「アラート プロパティの設定」 のステップ 17 ～ステップ 28 を実行して、アラート アクショ        
ンを追加、編集、または削除します。

追加情報

P.7-8 の「関連項目」を参照してください。
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関連項目
 • アラートの使用（P.7-2）

 • アラート プロパティの設定（P.7-4）

 • アラートの一時停止（P.7-6）

 • アラート通知用電子メールの設定（P.7-7）

 • アラート アクションの設定（P.7-7）

 • カウンタのアラート通知の設定（P.5-5）

 • アラート（P.6-1）
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8
プラグインの使用方法

Voice Log Translator（VLT）アプリケーションなどのアプリケーション プラグインをインストール   
して、RTMT の機能を拡張できます。Cisco.com から、RTMT ビューアの最新プラグインをダウン   
ロードできます。プラグインをインストールすると、RTMT ビューアのアプリケーションにアクセ 
スできるようになります。

プラグインをダウンロードするには、次の手順を実行します。

手順

ステップ 1 [Application] > [CCO Voice Tools Download] を選択します。

ステップ 2 ログイン プロンプトが表示されます。Cisco.com ユーザ名とパスワードを入力し、[OK] をクリック   
します。

ステップ 3 ファイルを PC にダウンロードします。

ステップ 4 インストールを開始するには、ダウンロードしたファイルをダブルクリックします。 

ステップ 5 インストールに関する指示に従います。

プラグインにアクセスするには、次の手順を実行します。

手順

ステップ 1 次のいずれかのタスクを実行します。

• Quick Launch Channel で
－ [System] をクリックします。

－ ツリー階層にある [Tools] をダブルクリックします。
－ 目的のアプリケーションのアイコンをクリックします。

• [System] > [Tools] > [Plugin] から、起動するプラグインを選択します。

プラグイン ウィンドウにアプリケーションが表示されます。

使用方法については、アプリケーションのマニュアルを参照してください。
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関連項目
Cisco Voice Log Translator の詳細については、『Cisco Voice Log Translator User Guide』を参照してく         
ださい。
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9
RTMT での Trace and Log Central の
設定

Real-Time Monitoring Tool（RTMT）の Trace and Log Central 機能を使用して、特定の日付範囲また       
は絶対時間でのオンデマンド トレース収集を設定できます。指定する検索条件を含むトレース 
ファイルを収集して再使用できるようにそのトレース収集条件を保存したり、定期的なトレース収

集をスケジュールしてネットワーク上の SFTP または FTP サーバにトレース ファイルをダウン     
ロードしたり、あるいはクラッシュ ダンプ ファイルを収集したりできます。ファイルの収集後は、  
Real-Time Monitoring Tool 内の適切なビューアでそれらのファイルを表示できます。また、リモー   
ト参照機能を使用すれば、トレース ファイルをダウンロードしなくてもサーバでトレースを表示す 
ることもできます。トレース ファイルは、RTMT に付属する内部ビューアを選択するか、または適  
切なプログラムを外部ビューアとして選択して開きます。 

（注） RTMT から、指定したサーバのトレースに関するトレース設定を編集することもできます。トレー 
ス設定を有効にするとシステムのパフォーマンスが低下するため、トレースはトラブルシューティ

ングを行う場合にのみ有効にしてください。

（注） RTMT で Trace and Log Central 機能を使用するには、 RTMT が Network Access Translation（NAT）を           
使用しなくてもサーバに直接アクセスできることを確認してください。デバイスにアクセスするた

めに NAT を設定している場合は、IP アドレスの代わりにホスト名を使用してサーバを設定し、ホ   
スト名とそのルータブル IP アドレスが DNS サーバまたはホスト ファイルに登録されていること     
を確認してください。

（注） 暗号化をサポートするデバイスの場合、SRTP キー関連情報はトレース ファイルに表示されませ  
ん。

この章は、次の項で構成されています。

 • 証明書のインポート（P.9-2）

 • RTMT の Trace and Log Central オプションの表示（P.9-3）

 • トレース ファイルの収集（P.9-4）

 • Query Wizard の使用方法（P.9-7）
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 • トレース収集のスケジュール（P.9-11）

 • トレース収集ステータスの表示とスケジュールされた収集の削除（P.9-14）

 • クラッシュ ダンプの収集（P.9-15）

 • Local Browse の使用方法（P.9-18）

 • Remote Browse の使用方法（P.9-19）

 • Real-Time Trace の使用方法（P.9-22）

 • Real-Time Trace の使用方法（P.9-22）

 • RTMT のトレース設定の更新（P.9-25）

証明書のインポート
認証局がサーバに発行するサーバ認証証明書をインポートできます。シスコでは、Trace and Log  
Central オプションを使用する前に、証明書をインポートすることをお勧めします。証明書をイン 
ポートしないと、RTMT にログインして Trace and Log Central オプションを利用するたびに、Trace      
and Log Central オプションによってサーバのセキュリティ証明書が表示されます。証明書に表示さ   
れるデータは一切変更できません。

証明書をインポートするには、[System] > [Tools] > [Trace] > [Import Certificate] を選択します。

システムでサーバ証明書のインポートが完了したことを示すメッセージが表示されます。[OK] を 
クリックします。

追加情報

P.9-26 の「関連項目」を参照してください。
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RTMT の Trace and Log Central オプションの表示
操作を開始する前に、P.9-2 の「証明書のインポート」の説明に従ってセキュリティ証明書がイン 
ポートされていることを確認してください。

Trace & Log Central ツリー階層を表示するには、次のいずれかのタスクを実行します。

 • Quick Launch Channel で [System] をクリックし、ツリー階層で [Tools] をダブルクリックして、       
[Trace & Log Central] アイコンをクリックします。

 • [System] > [Tools] > [Trace] > [Trace & Log Central] を選択します。

ヒント ツリー階層に表示されるどのオプションからでも、トレース対象とするサービス /アプリケーショ
ンの指定、使用するログおよびサーバの指定、収集日時のスケジュール、ファイルのダウンロード

機能の設定、zip ファイルの設定、および収集したトレース ファイルの削除を行うことができます。

Real-Time Monitoring Tool で Trace and Log Central のオプションを表示したら、次のいずれかのタス        
クを実行します。

 • サーバ上のサービス、アプリケーション、およびシステム ログのトレースを収集します。P.9-4 
の「トレース ファイルの収集」を参照してください。

 • 指定する検索条件を含むトレース ファイルを収集およびダウンロードして、再使用できるよう 
にトレース収集条件を保存します。P.9-7 の「Query Wizard の使用方法」 を参照してください。

 • 定期的なトレース収集をスケジュールし、ネットワーク上の SFTP または FTP サーバにトレー    
ス ファイルをダウンロードします。P.9-11 の「トレース収集のスケジュール」 を参照してくだ   
さい。

 • ネットワークに接続されている 1 台以上のサーバのクラッシュ ダンプ ファイルを収集します。    
P.9-15 の「クラッシュ ダンプの収集」 を参照してください。

 • 収集したトレース ファイルを表示します。P.9-18 の「Local Browse の使用方法」を参照してく    
ださい。

 • サーバ上のトレース ファイルをすべて表示します。P.9-19 の「Remote Browse の使用方法」を    
参照してください。

 • アプリケーションごとに、サーバに書き込まれている現在のトレース ファイルを表示します。 
トレース ファイルに検索文字列が存在する場合には、指定した操作を実行できます。P.9-22 の  
「Real-Time Trace の使用方法」を参照してください。

追加情報

P.9-26 の「関連項目」を参照してください。
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トレース ファイルの収集
Trace and Log Central の [Collect Files] オプションを使用して、サーバ上のサービス、アプリケーショ       
ン、およびシステム ログのトレースを収集します。トレースを収集する日付 /時間の範囲、トレー 
ス ファイルのダウンロード先ディレクトリ、収集されたファイルをサーバから削除するかどうかな 
どを指定します。Trace and Log Central 機能を使用してトレースを収集するには、次の手順を実行し    
ます。

（注） アクティブにしなかったサービスも表示されるため、それらのサービスのトレースを収集

できます。

指定する検索条件を含むトレース ファイルを収集する場合、または再使用できるように保存したト 
レース収集条件を使用する場合は、P.9-7 の「Query Wizard の使用方法」を参照してください。

始める前に

次のタスクを 1 つ以上実行します。

 • Cisco Unified Serviceability の [Trace Configuration] ウィンドウで、さまざまなサービスのトレー      
ス ファイルに含める情報を設定します。詳細については、『Cisco Unified Serviceability アドミニ    
ストレーション ガイド』を参照してください。

 • トレース ファイルにアラームが送信されるようにするには、Cisco Unified Serviceability の 
[Alarm Configuration] ウィンドウで、SDI または SDL トレース ファイルをアラーム宛先として
選択します。詳細については、『Cisco Unified Serviceability アドミニストレーション ガイド』
を参照してください。

手順

ステップ 1 P.9-3 の「RTMT の Trace and Log Central オプションの表示」の説明に従って、Trace and Log Central          
のオプションを表示します。

ステップ 2 Trace & Log Central ツリー階層で、[Collect Files] をダブルクリックします。

トレース収集ウィザードが表示されます。

（注） アクティブにしなかったサービスも表示されるため、それらのサービスのトレースを収集

できます。

ステップ 3 [Select CUC Services/Application] タブで、次のいずれかのタスクを実行します。

 • すべてのサーバのシステム ログをすべて収集するには、[Select All Services on all Servers] 
チェックボックスをオンにします。

 • 特定サーバのすべてのシステム ログのトレースを収集するには、そのサーバの横にあるチェッ 
クボックスをオンにします。

 • 特定サーバの特定システム ログのトレースを収集するには、該当するチェックボックスをオン 
にします。

 • システム ログのトレースを収集せずにトレース収集ウィザードでの設定を続行するには、ス 
テップ 4 に進みます。
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ステップ 4 [Next] をクリックします。

ステップ 5 [Select System Services/Application] タブで、次のいずれかのタスクを実行します。

 • すべてのサーバのシステム ログをすべて収集するには、[Select All Services on all Servers] 
チェックボックスをオンにします。

 • 特定サーバのすべてのシステム ログのトレースを収集するには、サーバの横にあるチェック 
ボックスをオンにします。

 • 特定サーバの特定システム ログのトレースを収集するには、該当するチェックボックスをオン 
にします。

 • システム ログのトレースを収集せずにトレース収集ウィザードでの設定を続行するには、ス 
テップ 6 に進みます。

ステップ 6 [Next] をクリックします。

ステップ 7 [Collection Time] グループ ボックスで、トレースを収集する時間範囲を指定します。次のいずれか   
のオプションを選択します。

 • Absolute Range：トレースを収集するサーバのタイム ゾーンと時間範囲（開始および終了の日  
時）を指定します。

クライアント マシンのタイム ゾーンが [Select Reference Server Time Zone] フィールドのデフォ        
ルト設定になります。Daylight Saving が設定されているすべてのタイム ゾーンの別々のエント   
リ セットとともに、すべての標準タイム ゾーンが [Select Time Zone] ドロップダウン リスト       
ボックスに表示されます。

Trace and Log Central により、[Selected Reference Server Time Zone] フィールドに基づいた時間範         
囲のファイルがダウンロードされます。 

トレースを収集する日付範囲を設定するには、[From Date/Time] フィールドと [To Date/Time]    
フィールドのドロップダウン リスト ボックスを選択します。

 • Relative Range：トレースの収集範囲となる現在時刻までの時間（分、時、日、週、または月 
単位）を指定します。

[Download File Options] グループ ボックスで、トレースをダウンロードするときに適用するオプショ    
ンを指定します。

ステップ 8 [Select Partition] ドロップダウン リスト ボックスで、トレースの収集対象となるログが記録されて    
いるパーティションを選択します。

Cisco Unified Serviceability では、ユーザがログインしたアプリケーションのバージョンのログをア   
クティブ パーティションに保存し、他のバージョンがインストールされている場合には、そのバー 
ジョンのログを非アクティブ ディレクトリに保存します。

そのため、Linux プラットフォームで実行されている Cisco Unity Connection のバージョンを別の     
バージョンにアップグレードし、Cisco Unity Connection の新しいバージョンでサーバを再起動する   
と、Cisco Unified Serviceability は、前のバージョンのログを非アクティブ パーティションに移動し、    
新しいバージョンのログをアクティブ パーティションに保存します。古いバージョンの Cisco Unity   
Connection にもう一度ログインすると、Cisco Unified Serviceability は、新しいバージョンの    
Cisco Unity Connection のログを非アクティブ パーティションに移動し、古いバージョンのログをア    
クティブ ディレクトリに保存します。
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ステップ 9 トレース ファイルのダウンロード先ディレクトリを指定するには、[Download File Directory] フィー    
ルドの横にある [Browse] ボタンをクリックし、ディレクトリまでナビゲートして、[Open] をクリッ   
クします。デフォルトでは、<rtmt_install_directory>\<サーバ名またはサーバ IP アドレス >\<ダウン  
ロード時刻 > と指定されます。<rtmt_install_directory> には、RTMT のインストール先ディレクトリ   
が指定されます。

ステップ 10 収集するトレース ファイルの zip ファイルを作成するには、[Zip File] オプション ボタンをクリッ      
クします。zip ファイルに圧縮せずにトレース ファイルをダウンロードするには、[Do Not Zip Files]     
オプション ボタンをクリックします。

ステップ 11 収集されたログ ファイルをサーバから削除するには、[Delete Collected Log Files from the server] 
チェックボックスをオンにします。

ステップ 12 [Finish] をクリックします。

ウィンドウにトレース収集の経過が表示されます。トレース収集を停止する場合は、[Cancel] をク 
リックします。

トレース収集プロセスが完了すると、ウィンドウの下部に [Completed downloading for node <サーバ     
名または IP アドレス >] というメッセージが表示されます。

ステップ 13 収集したトレース ファイルを表示するには、トレース収集機能の [Local Browse] オプションを使用    
できます。詳細については、P.9-18 の「Local Browse の使用方法」を参照してください。

追加情報

P.9-26 の「関連項目」を参照してください。
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Query Wizard の使用方法
トレース収集 Query Wizard を使用して、指定する検索条件を含むトレース ファイルを収集および    
ダウンロードして、再使用できるようにトレース収集条件を保存することができます。トレース収

集 Query Wizard を使用するには、次の手順を実行します。

（注） Trace and Log Central 内では、最大で 5 個のファイルを同時に開いて表示できます。ファイルを開      
くと、Query Wizard、Local Browse、および Remote Browse 機能を使用できます。

始める前に

次のタスクを 1 つ以上実行します。

 • Cisco Unified Serviceability の [Trace Configuration] ウィンドウで、さまざまなサービスのトレー      
ス ファイルに含める情報を設定します。詳細については、『Cisco Unified Serviceability アドミニ    
ストレーション ガイド』を参照してください。

 • トレース ファイルにアラームが送信されるようにするには、[Alarm Configuration] ウィンドウ   
で、SDI または SDL トレース ファイルをアラーム宛先として選択します。詳細については、    
『Cisco Unified Serviceability アドミニストレーション ガイド』を参照してください。

手順

ステップ 1 P.9-3 の「RTMT の Trace and Log Central オプションの表示」の説明に従って、Trace and Log Central          
のオプションを表示します。

ステップ 2 Trace & Log Central ツリー階層で、[Query Wizard] をダブルクリックします。

Query Wizard が表示されます。

ステップ 3 [Query Wizard Options] ウィンドウで、次のいずれかのオプション ボタンをクリックします。

 • Saved Query

[Browse] ボタンをクリックし、使用するクエリーまでナビゲートします。クエリーを選択し、 
[Open] をクリックします。

変更なしでクエリーを実行するには、[Run Query] をクリックし、ステップ 18 に進みます。ク    
エリーを変更するには、ステップ 4 に進みます。

 • Create Query

ステップ 4 [Next] をクリックします。

ステップ 5 [Saved Query] オプション ボタンをクリックしてクエリーを選択した場合は、そのクエリーで指定し   
た基準が表示されます。必要に応じて、トレースを収集する対象のサービス /アプリケーションの
リストを変更します。[Create Query] オプション ボタンをクリックした場合は、トレースを収集す   
る対象のサービス /アプリケーションをすべて選択する必要があります。

ヒント 特定のサーバで実行されるすべてのサービスとアプリケーションのトレースを収集する

には、サーバ名またはサーバ IP アドレスの横にあるチェックボックスをオンにします。
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（注） アクティブにしなかったサービスも表示されるため、それらのサービスのトレースを収集

できます。

ステップ 6 [Select CUC Services/Application] タブで、該当するすべてのチェックボックスをオンにして、目的の   
サービス ログとアプリケーション ログを選択します。

ステップ 7 [Next] をクリックします。

ステップ 8 [Select System Services/Application] タブで、該当するすべてのチェックボックスをオンにして、目的   
のサービス ログとアプリケーション ログを選択します。

ステップ 9 [Next] をクリックします。

ステップ 10 [Query Time Options] ボックスで、トレースを収集するときの時間範囲を指定します。次のいずれか   
のオプションを選択します。

 • All Available Traces：選択したサービスのサーバ上にあるトレースをすべて収集する場合は、  
このオプションを選択します。

 • Absolute Range：トレースを収集するサーバのタイム ゾーンと時間範囲（開始および終了の日  
時）を指定します。

クライアント マシンのタイム ゾーンが [Select Reference Server Time Zone] フィールドのデフォ        
ルト設定になります。Daylight Saving が設定されているすべてのタイム ゾーンの別々のエント   
リ セットとともに、すべての標準タイム ゾーンが [Select Time Zone] ドロップダウン リスト       
ボックスに表示されます。

Trace and Log Central により、[Selected Reference Server Time Zone] フィールドに基づいた時間範         
囲のファイルがダウンロードされます。 

トレースを収集する日付範囲を設定するには、[From Date/Time] フィールドと [To Date/Time]    
フィールドのドロップダウン リスト ボックスを選択します。

 • Relative Range：トレースの収集範囲となる現在時刻までの時間（分、時、日、週、または月 
単位）を指定します。

ステップ 11 トレース ファイル内のフレーズや単語を基準にして検索するには、[Search String] フィールドに単   
語またはフレーズを入力します。入力した単語またはフレーズの完全一致を検索する場合は、[Case
Sensitive] チェックボックスをオンにします。

ステップ 12 [Call Procession Impact Options] ボックスで、文字列検索アクティビティが通話処理に与える影響の    
レベルを指定します。[Select Impact Level] ドロップダウン ボックスで、[Low]、[Medium]、または    
[High] を選択します。[Low] レベルにすると、通話処理への影響は最小限に抑えられますが、検索  
に時間がかかります。[High] レベルにすると、通話処理への影響が大きくなりますが、検索は高速 
で実行されます。

ステップ 13 次のいずれかのオプションを選択します。

 • クエリーを実行するには、[Run Query] をクリックします。 

[Query Results] フォルダが表示されます。クエリーが完了すると、クエリーの実行が完了した  
ことを示すダイアログボックスが表示されます。[OK] をクリックし、ステップ 18 に進みます。

 • クエリーを保存するには、[Save Query] ボタンをクリックし、ステップ 14 に進みます。
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ステップ 14 作成するタイプのクエリーの横にあるチェックボックスをオンにします。

 • Generic Query：作成されたときとは別のサーバでも実行できるクエリーを作成する場合は、こ 
のオプションを選択します。選択したサービスがそのサーバに存在する場合は、汎用クエリー

のみを作成できます。

次に、[Single Node Query] オプションまたは [All Node Query] オプションのどちらかを選択しま       
す。[Single Node Query] を選択すると、クエリーを実行するときに、そのクエリーが作成され   
たサーバがトレース収集ツールによってデフォルトで選択されます。[All Node Query] オプショ   
ンを選択すると、クエリーを実行するときに、そのクエリーが作成されたサーバがトレース収

集ツールによって選択されます。

（注） クエリーを実行する前に、デフォルト以外のサーバを選択できます。

 • Regular Query：作成されたときのサーバでのみクエリーを実行する場合は、このオプションを 
選択します。

ステップ 15 [Finish] をクリックします。

ステップ 16 クエリーを保存する場所を参照し、[File Name] フィールドにクエリーの名前を入力して、[Save] を   
クリックします。

ステップ 17 次のいずれかのタスクを実行します。

 • 保存したクエリーを実行するには、[Run Query] をクリックし、ステップ 18 に進みます。

 • 作成したクエリーを実行せずに Query Wizard を終了するには、[Cancel] をクリックします。

ステップ 18 クエリーの実行が完了したら、次のタスクを 1 つ以上実行します。

 • 収集したファイルを表示するには、[Query Results] をダブルクリックし、< ノード > フォルダ   
（<ノード > はウィザードで指定したサーバの IP アドレスまたはホスト名）をダブルクリック   
し、さらに表示するファイルが格納されているフォルダをダブルクリックして、ファイルの場

所までナビゲートします。 

ファイルの場所を指定したら、マウスを右クリックしてファイルの表示に使用するプログラム

のタイプを選択するか、またはファイルをダブルクリックしてデフォルトのビューアでファイ

ルを表示することができます。Real-Time Monitoring Tool のファイル タイプに応じた適切な    
ビューアに、ファイルが表示されます。他に適切なビューアがない場合には、Real-Time
Monitoring Tool の Generic Log Viewer でファイルが開きます。

 • トレース ファイルと、クエリーで収集したトレース ファイルのリストが書き込まれた結果ファ  
イルをダウンロードします。ファイルをダウンロードするには、対象のファイルを選択し、

[Download] ボタンをクリックし、ダウンロードの基準を指定して、[Finish] をクリックします。 

－ トレース ファイルおよび結果ファイルのダウンロード先ディレクトリを指定するには、 
[Download all files] フィールドの横にある [Browse] ボタンをクリックし、ディレクトリま     
でナビゲートして、[Open] をクリックします。デフォルトでは、<rtmt_install_directory>\< 
サーバ名またはサーバ IP アドレス >\<ダウンロード時刻 > と指定されます。 
<rtmt_install_directory> には、RTMT のインストール先ディレクトリが指定されます。

－ 収集するトレース ファイルの zip ファイルを作成するには、[Zip File] チェックボックスを     
オンにします。

－ 収集されたログ ファイルをサーバから削除するには、[Delete Collected Log Files from 
Server] チェックボックスをオンにします。
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ヒント トレース ファイルをダウンロードしたら、Trace and Log Central 機能の [Local Browse] オ        
プションを使用して表示できます。詳細については、P.9-18 の「Local Browse の使用方   
法」を参照してください。

 • クエリーを保存するには、[Save Query] ボタンをクリックし、ステップ 14 からステップ 16 ま      
でを実行します。

追加情報

P.9-26 の「関連項目」を参照してください。
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トレース収集のスケジュール
Trace and Log Central 機能の [Schedule Collection] オプションを使用して、最大 6 件の同時トレース         
収集をスケジュールし、トレース ファイルをネットワーク上の SFTP または FTP サーバにダウン     
ロードしたり、別の保存されたクエリーを実行したり、SysLog ファイルを生成したりすることがで 
きます。スケジュールされた収集イベントをシステムに入力した後で変更する場合、スケジュール

された収集イベントを削除して、新しい収集イベントを追加する必要があります。トレース収集を

スケジュールするには、次の手順を実行します。

（注） 最大で 10 件のトレース収集ジョブをスケジュールできますが、同時に実行可能なトレース収集
ジョブは 6 件です。つまり、同時に実行状態にすることができるジョブは 6 件だけです。

始める前に

次のタスクを 1 つ以上実行します。

 • Cisco Unified Serviceability の [Trace Configuration] ウィンドウで、さまざまなサービスのトレー      
ス ファイルに含める情報を設定します。詳細については、『Cisco Unified Serviceability アドミニ    
ストレーション ガイド』を参照してください。

 • トレース ファイルにアラームが送信されるようにするには、[Alarm Configuration] ウィンドウ   
で、SDI または SDL トレース ファイルをアラーム宛先として選択します。詳細については、    
『Cisco Unified Serviceability アドミニストレーション ガイド』を参照してください。

手順

ステップ 1 P.9-3 の「RTMT の Trace and Log Central オプションの表示」の説明に従って、Trace and Log Central          
のオプションを表示します。

ステップ 2 Trace & Log Central ツリー階層で、[Schedule Collection] をダブルクリックします。

Schedule Collection ウィザードが表示されます。

（注） アクティブにしなかったサービスも表示されるため、それらのサービスのトレースを収集

できます。

ステップ 3 [Select CUC Services/Application] タブで、次のいずれかのタスクを実行します。

 • すべてのサーバのシステム ログをすべて収集するには、[Select All Services on all Servers] 
チェックボックスをオンにします。

 • 特定サーバのすべてのシステム ログのトレースを収集するには、サーバの横にあるチェック 
ボックスをオンにします。

 • 特定サーバの特定システム ログのトレースを収集するには、該当するチェックボックスをオン 
にします。

 • システム ログのトレースを収集せずに Schedule Collection ウィザードでの設定を続行するに    
は、ステップ 4 に進みます。

ステップ 4 [Next] をクリックします。
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ステップ 5 [Select System Services/Application] タブで、次のいずれかのタスクを実行します。

 • すべてのサーバのシステム ログをすべて収集するには、[Select All Services on all Servers] 
チェックボックスをオンにします。

 • 特定サーバのすべてのシステム ログのトレースを収集するには、サーバの横にあるチェック 
ボックスをオンにします。

 • 特定サーバの特定システム ログのトレースを収集するには、該当するチェックボックスをオン 
にします。

 • システム ログのトレースを収集せずに Schedule Collection ウィザードでの設定を続行するに    
は、ステップ 6 に進みます。

ステップ 6 [Next] をクリックします。

ステップ 7 トレースを収集するサーバのタイム ゾーンと時間範囲を指定します。

クライアント マシンのタイム ゾーンが [Select Reference Server Time Zone] フィールドのデフォルト        
設定になります。Daylight Saving が設定されているすべてのタイム ゾーンの別々のエントリ セット    
とともに、すべての標準タイム ゾーンが [Select Time Zone] ドロップダウン リスト ボックスに表示       
されます。

ステップ 8 トレース収集を開始する日時を指定するには、[Schedule Start Date/Time] フィールドの横にある下向   
き矢印をクリックします。[Date] タブで、適切な日付を選択します。[Time] タブで、適切な時刻を  
選択します。

ステップ 9 トレース収集を終了する日時を指定するには、[Schedule End Date/Time] フィールドの横にある下向   
き矢印をクリックします。[Date] タブで、適切な日付を選択します。[Time] タブで、適切な時刻を  
選択します。

（注） トレース収集は、設定された終了時刻を過ぎても完了しますが、Trace and Log Central 機能    
によってその収集はスケジュールから削除されます。

ステップ 10 [Scheduler Frequency] ドロップダウン リスト ボックスで、設定されたトレース収集の実行頻度を選    
択します。 

ステップ 11 [Collect Files generated in the last] ドロップダウン リスト ボックスで、トレースの収集範囲となる現        
在時刻までの時間（分、時、日、週、または月単位）を指定します。

ステップ 12 トレース ファイル内のフレーズや単語を基準にして検索するには、[Search String] フィールドに単   
語またはフレーズを入力します。ツールにより、入力した単語またはフレーズに一致する項目が検

索され、検索条件に一致するそれらのファイルが収集されます。入力した単語またはフレーズの完

全一致を検索する場合は、[Case Sensitive] チェックボックスをオンにします。

ステップ 13 収集するトレース ファイルの zip ファイルを作成するには、[Zip File] チェックボックスをオンにし     
ます。

ステップ 14 収集されたログ ファイルをサーバから削除するには、[Delete Collected Log Files from the Server]       
チェックボックスをオンにします。
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ステップ 15 次の操作を 1 つ以上選択します。

 • Download Files：[Download Files] または [Run Another Query] を選択した場合は、ステップ 16 に         
進みます。 

 • Run Another Query

 • Generate Syslog：[Generate Syslog] を選択した場合は、ステップ 18 に進みます。

ステップ 16 [SFTP/FTP Server Parameters] グループ ボックスで、Trace and Log Central 機能で結果をダウンロード        
するサーバのサーバ クレデンシャルを入力し、[Test Connection] をクリックします。Trace and Log     
Central 機能で SFTP または FTP サーバへの接続の検証が終了したら、[OK] をクリックします。

（注） [Download Directory Path] フィールドで、収集されたファイルを Trace and Log Central 機能        
によって保存するときのディレクトリを指定します。デフォルトでは、トレース収集によっ

て、SFTP または FTP のパラメータ フィールドで指定するユーザ ID を持つユーザのホーム      
ディレクトリ（/home/<user>/Trace）にファイルが保存されます。

ステップ 17 [Run Another Query] オプションを選択した場合は、[Browse] ボタンをクリックして実行するクエ    
リーの場所を指定し、[OK] をクリックします。

（注） Trace and Log Central 機能は、最初のクエリーが結果を生成した場合にのみ、指定され    
たクエリーを実行します。

ステップ 18 [Finish] をクリックします。

スケジュールされたトレースが正常に追加されたことを示すメッセージが表示されます。

（注） Real-Time Monitoring Tool が SFTP または FTP サーバにアクセスできない場合は、メッセー       
ジが表示されます。その場合、入力した IP アドレス、ユーザ名、およびパスワードが正し  
いことを確認してください。

ステップ 19 [OK] をクリックします。

ステップ 20 スケジュールされた収集のリストを表示するには、Quick Launch Channel の Trace & Log Central ツ        
リー階層で、[Job Status] アイコンをクリックします。

ヒント スケジュールされた収集を削除するには、対象の収集イベントを選択して、[Delete] をク 
リックします。確認メッセージが表示されます。[OK] をクリックします。

追加情報

P.9-26 の「関連項目」を参照してください。
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トレース収集ステータスの表示とスケジュールされた収集の削除
トレース収集イベントのステータスを表示し、スケジュールされたトレース収集を削除するには、

次の手順を実行します。

手順

ステップ 1 P.9-3 の「RTMT の Trace and Log Central オプションの表示」の説明に従って、Trace & Log Central          
ツリー階層を表示します。

ステップ 2 [Job Status] をダブルクリックします。

[Job Status] ウィンドウが表示されます。

ステップ 3 [Select a Node] ドロップダウン リスト ボックスで、表示または削除するトレース収集イベントの対     
象サーバを選択します。

スケジュールされたトレース収集のリストが表示されます。

ジョブ タイプには、Scheduled Job、OnDemand、RealTimeFileMon、および RealTimeFileSearch があ    
ります。

ステータスには、Pending、Running、Cancel、および Terminated があります。

ステップ 4 スケジュールされた収集を削除するには、削除するイベントを選択して、[Delete] をクリックしま 
す。

（注） 削除できるのは、ステータスが「Pending」または「Running」で、ジョブ タイプが「Schedule 
Task」または「RealTimeFileSearch」のジョブです。

追加情報

P.9-26 の「関連項目」を参照してください。
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クラッシュ ダンプの収集
トレース ファイルのコア ダンプを収集するには、次の手順を実行します。

手順

ステップ 1 P.9-3 の「RTMT の Trace and Log Central オプションの表示」の説明に従って、Trace & Log Central          
ツリー階層を表示します。

ステップ 2 [Collect Crash Dump] をダブルクリックします。

Collect Crash Dump ウィザードが表示されます。

（注） アクティブにしなかったサービスも表示されるため、それらのサービスのトレースを収集

できます。

ステップ 3 [Select CUC Services/Application] タブで、次のいずれかのタスクを実行します。

 • すべてのサーバのシステム ログをすべて収集するには、[Select All Services on all Servers] 
チェックボックスをオンにします。

 • 特定サーバのすべてのシステム ログのトレースを収集するには、サーバの横にあるチェック 
ボックスをオンにします。

 • 特定サーバの特定システム ログのトレースを収集するには、該当するチェックボックスをオン 
にします。

 • システム ログのトレースを収集せずに Collect Crash Dump ウィザードでの設定を続行するに     
は、ステップ 4 に進みます。

ステップ 4 [Next] をクリックします。

ステップ 5 [Select System Services/Application] タブで、次のいずれかのタスクを実行します。

 • すべてのサーバのシステム ログをすべて収集するには、[Select All Services on all Servers] 
チェックボックスをオンにします。

 • 特定サーバのすべてのシステム ログのトレースを収集するには、サーバの横にあるチェック 
ボックスをオンにします。

 • 特定サーバの特定システム ログのトレースを収集するには、該当するチェックボックスをオン 
にします。

 • システム ログのトレースを収集せずに Collect Crash Dump ウィザードでの設定を続行するに     
は、ステップ 6 に進みます。

ステップ 6 [Next] をクリックします。
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ステップ 7 [Collection Time] グループ ボックスで、トレースを収集する時間範囲を指定します。次のいずれか   
のオプションを選択します。

 • Absolute Range：トレースを収集するサーバのタイム ゾーンと時間範囲（開始および終了の日  
時）を指定します。

クライアント マシンのタイム ゾーンが [Select Reference Server Time Zone] フィールドのデフォ        
ルト設定になります。Daylight Saving が設定されているすべてのタイム ゾーンの別々のエント   
リ セットとともに、すべての標準タイム ゾーンが [Select Time Zone] ドロップダウン リスト       
ボックスに表示されます。

Trace and Log Central により、[Selected Reference Server Time Zone] フィールドに基づいた時間範         
囲のファイルがダウンロードされます。 

クラッシュ ファイルを収集する日付範囲を設定するには、[From Date/Time] フィールドと [To    
Date/Time] フィールドのドロップダウン リスト ボックスを選択します。

 • Relative Range：クラッシュ ファイルの収集範囲となる現在時刻までの時間（分、時、日、週、  
または月単位）を指定します。

ステップ 8 [Select Partition] ドロップダウン リスト ボックスで、トレースの収集対象となるログが記録されて    
いるパーティションを選択します。

Cisco Unified Serviceability では、ユーザがログインしたアプリケーションのバージョンのログをア   
クティブ パーティションに保存し、他のバージョンがインストールされている場合には、そのバー 
ジョンのログを非アクティブ ディレクトリに保存します。

そのため、Linux プラットフォームで実行されている Cisco Unity Connection のバージョンを別の     
バージョンにアップグレードし、新しいバージョンでサーバを再起動すると、Cisco Unified 
Serviceability は、前のバージョンのログを非アクティブ パーティションに移動し、新しいバージョ  
ンのログをアクティブ パーティションに保存します。古いバージョンの Cisco Unity Connection に     
ログインすると、Cisco Unified Serviceability は、新しいバージョンの Cisco Unity Connection のログ       
を非アクティブ パーティションに移動し、古いバージョンのログをアクティブ ディレクトリに保  
存します。

ステップ 9 トレース ファイルのダウンロード先ディレクトリを指定するには、[Download File Directory] フィー    
ルドの横にある [Browse] ボタンをクリックし、ディレクトリまでナビゲートして、[Open] をクリッ   
クします。デフォルトでは、<rtmt_install_directory>\<サーバ名またはサーバ IP アドレス >\<ダウン  
ロード時刻 > と指定されます。<rtmt_install_directory> には、RTMT のインストール先ディレクトリ   
が指定されます。

ステップ 10 収集するクラッシュ ダンプ ファイルの zip ファイルを作成するには、[Zip File] オプション ボタン       
をクリックします。zip ファイルに圧縮せずにクラッシュ ダンプ ファイルをダウンロードするには、   
[Do Not Zip Files] オプション ボタンをクリックします。

（注） クラッシュ ダンプ ファイルの zip ファイルが 2 GB を超える場合、そのファイルはダウン       
ロードできません。 

ステップ 11 収集されたクラッシュ ダンプ ファイルをサーバから削除するには、[Delete Collected Log Files from      
Server] チェックボックスをオンにします。
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ステップ 12 [Finish] をクリックします。

コア ダンプを収集しようとしていることを示すメッセージが表示されます。続行するには、[Yes] 
をクリックします。

（注） [Zip File] オプション ボタンをクリックした場合にクラッシュ ダンプ ファイルのサイズが     
2 GB を超えると、[Zip File] オプション ボタンをクリックした状態ではそのサイズのクラッ     
シュ ダンプ ファイルを収集できないことを示すメッセージが表示されます。[Do Not Zip    
Files] オプション ボタンをクリックして、もう一度収集を行ってください。

追加情報

P.9-26 の「関連項目」を参照してください。
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Local Browse の使用方法
トレース ファイルを収集して PC にダウンロードしたら、UNIX 系の行末記号を処理できる    
WordPad などのテキスト エディタを使用して PC に表示するか、または Real-Time Monitoring Tool       
内のビューアを使用して表示できます。

（注） 収集されたトレース ファイルを NotePad で表示しないでください。

次の手順を実行し、Trace and Log Central 機能によって収集したログ ファイルを表示します。PC に      
ダウンロードしたときにトレース ファイルを zip ファイルに圧縮した場合は、それらのファイルを   
解凍してから Real-Time Monitoring Tool 内のビューアを使用して表示する必要があります。

（注） Trace & Log Central 内では、最大で 5 個のファイルを同時に開いて表示できます。ファイルを開く      
と、Query Wizard、Local Browse、および Remote Browse 機能を使用できます。

始める前に

次のセクションのいずれかの説明に従ってトレース ファイルを収集します。

 • トレース ファイルの収集（P.9-4）

 • Query Wizard の使用方法（P.9-7）

 • トレース収集のスケジュール（P.9-11）

手順

ステップ 1 P.9-3 の「RTMT の Trace and Log Central オプションの表示」の説明に従って、Trace and Log Central          
のオプションを表示します。

ステップ 2 [Local Browse] をダブルクリックします。

ステップ 3 ログ ファイルを保存したディレクトリを参照し、表示するファイルを選択します。

ステップ 4 結果を表示するには、そのファイルをダブルクリックします。

ステップ 5 ファイルを表示するために使用するプログラム（ビューア）をクリックします。プログラムがリス

トにない場合は、[Other] ボタンをクリックして別のプログラムを選択します。

このプログラムをデフォルトのビューアとして使用する場合は、[Always use this program to open     
these files] チェックボックスをオンにします。

Real-Time Monitoring Tool のファイル タイプに応じた適切なビューアに、ファイルが表示されます。    
他に適切なビューアがない場合には、Real-Time Monitoring Tool の Generic Log Viewer でファイルが       
開きます。 

追加情報

P.9-26 の「関連項目」を参照してください。
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Remote Browse の使用方法
トレース ファイルを生成したら、Real-Time Monitoring Tool 内のビューアを使用し、サーバにそれ    
らのファイルを表示できます。また、Remote Browse 機能を使用して PC にトレースをダウンロー    
ドすることもできます。

次の手順を実行し、Trace and Log Central 機能でログ ファイルをサーバで表示またはダウンロード     
します。

（注） Trace and Log Central 内では、最大で 5 個のファイルを同時に開いて表示できます。ファイルを開      
くと、Query Wizard、Local Browse、および Remote Browse 機能を使用できます。

始める前に

次のセクションのいずれかの説明に従ってトレース ファイルを収集します。

 • トレース ファイルの収集（P.9-4）

 • Query Wizard の使用方法（P.9-7）

 • トレース収集のスケジュール（P.9-11）

手順

ステップ 1 P.9-3 の「RTMT の Trace and Log Central オプションの表示」の説明に従って、Trace and Log Central          
のオプションを表示します。

ステップ 2 [Remote Browse] をダブルクリックします。

ステップ 3 適切なオプション ボタンをクリックし、[Next] をクリックします。[Trace Files] を選択する場合は、    
ステップ 5 に進みます。[Crash Dump] を選択する場合は、ステップ 10 に進みます。

（注） アクティブにしなかったサービスも表示されるため、それらのサービスのトレースを選択

できます。

（注） [Crash Dump] を選択すると、ウィザードにはクラッシュ ダンプを引き起こすサービスのみ   
が表示されます。目的のサービスが表示されない場合は、[Back] をクリックして [Trace Files]   
を選択してください。

ステップ 4 [Select CUC Services/Application] タブで、次のいずれかのタスクを実行します。

 • すべてのサーバのシステム ログをすべて収集するには、[Select All Services on all Servers] 
チェックボックスをオンにします。

 • 特定サーバのすべてのシステム ログのトレースを収集するには、サーバの横にあるチェック 
ボックスをオンにします。

 • 特定サーバの特定システム ログのトレースを収集するには、該当するチェックボックスをオン 
にします。

 • システム ログのトレースを収集せずに Remote Browse ウィザードでの設定を続行するには、ス    
テップ 5 に進みます。
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ステップ 5 [Next] をクリックします。

ステップ 6 [Select System Services/Application] タブで、次のいずれかのタスクを実行します。

 • すべてのサーバのシステム ログをすべて収集するには、[Select All Services on all Servers] 
チェックボックスをオンにします。

 • 特定サーバのすべてのシステム ログのトレースを収集するには、サーバの横にあるチェック 
ボックスをオンにします。

 • 特定サーバの特定システム ログのトレースを収集するには、該当するチェックボックスをオン 
にします。

 • システム ログのトレースを収集せずに Remote Browse ウィザードでの設定を続行するには、ス    
テップ 10 に進みます。

ステップ 7 [Select CUC Services/Application] タブで、次のいずれかのタスクを実行します。

 • すべてのサーバのクラッシュ ダンプ ファイルを選択するには、[Select All Services on all 
Servers] チェックボックスをオンにします。

 • 特定のサーバのクラッシュ ダンプ ファイルを選択するには、そのサーバの横にあるチェック  
ボックスをオンにします。

 • 特定のサーバにある特定のシステム ログのクラッシュ ダンプ ファイルを選択するには、該当   
するチェックボックスをオンにします。

 • クラッシュ ダンプ ファイルを収集せずに Remote Browse ウィザードでの設定を続行するには、
ステップ 8 に進みます。

ステップ 8 [Next] をクリックします。

ステップ 9 [Select System Services/Application] タブで、次のいずれかのタスクを実行します。

 • すべてのサーバのクラッシュ ダンプ ファイルを選択するには、[Select All Services on all 
Servers] チェックボックスをオンにします。

 • 特定のサーバにあるすべてのシステム ログのクラッシュ ダンプ ファイルを選択するには、そ   
のサーバの横にあるチェックボックスをオンにします。

 • 特定のサーバにある特定のシステム ログのクラッシュ ダンプ ファイルを選択するには、該当   
するチェックボックスをオンにします。

 • クラッシュ ダンプ ファイルを収集せずに Remote Browse ウィザードでの設定を続行するには、     
ステップ 10 に進みます。

ステップ 10 [Finish] をクリックします。

ステップ 11 トレースが使用可能になると、メッセージが表示されます。[Close] をクリックします。

ステップ 12 次のいずれかのタスクを実行します。

 • 結果を表示するには、ツリー階層をたどってファイルまでナビゲートします。ウィンドウの右

側のペインにログ ファイル名が表示されたら、マウスを右クリックしてファイルの表示に使用 
するプログラムのタイプを選択するか、ファイルをダブルクリックしてデフォルトのビューア

でファイルを表示することができます。

ヒント ペインに表示されるファイルをソートするには、列見出しをクリックします。たとえば

名前でファイルをソートする場合は、列見出し [Name] をクリックします。
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Real-Time Monitoring Tool のファイル タイプに応じた適切なビューアに、ファイルが表示され    
ます。他に適切なビューアがない場合には、Real-Time Monitoring Tool の Generic Log Viewer で       
ファイルが開きます。 

 • トレース ファイルをダウンロードするには、ダウンロードするファイルを選択して [Download]  
をクリックし、ダウンロードの基準を指定して、[Finish] をクリックします。

－ トレース ファイルのダウンロード先ディレクトリを指定するには、[Download all files]   
フィールドの横にある [Browse] ボタンをクリックし、ディレクトリまでナビゲートして、  
[Open] をクリックします。デフォルトでは、<rtmt_install_directory>\<サーバ名またはサー 
バ IP アドレス >\<ダウンロード時刻 > と指定されます。<rtmt_install_directory> には、RTMT    
のインストール先ディレクトリが指定されます。

－ 収集するトレース ファイルの zip ファイルを作成するには、[Zip File] チェックボックスを     
オンにします。

－ 収集したログファイルをサーバから削除するには、[Delete Files on server] チェックボック    
スをオンにします。

 • サーバからトレース ファイルを削除するには、ウィンドウの右側のペインに表示されるファイ 
ルをクリックしてから、[Delete] ボタンをクリックします。

 • 特定のサービスを更新するには、サーバ名またはサービスをクリックしてから、[Refresh] ボタ 
ンをクリックします。リモート参照の準備ができたことを示すメッセージが表示されたら、

[Close] をクリックします。

 • ツリー階層に表示されるすべてのサービスとノードを更新するには、[Refresh All] ボタンをク  
リックします。リモート参照の準備ができたことを示すメッセージが表示されたら、[Close] を 
クリックします。

ヒント トレース ファイルをダウンロードしたら、Trace and Log Central 機能の [Local Browse] オ        
プションを使用して表示できます。詳細については、P.9-18 の「Local Browse の使用方   
法」を参照してください。

追加情報

P.9-26 の「関連項目」を参照してください。
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Real-Time Trace の使用方法
RTMT の Trace and Log Central 機能の [Real-Time Trace] オプションを使用して、アプリケーション         
ごとにサーバに書き込まれている現在のトレース ファイルを表示できます。システムがトレース 
ファイルの書き込みを開始すると、Real-Time Trace では、トレース ファイルの先頭からではなく、   
モニタリングの開始点からファイルの読み取りを開始します。以前の内容を読み取ることはできま

せん。

Real-Time Trace では、次のオプションを選択できます。

 • View Real-Time Data（P.9-22）

 • Monitor User Event（P.9-23）

View Real-Time Data

Trace and Log Central 機能の [View Real-Time Data] オプションを選択すると、データがトレース ファ         
イルに書き込まれると同時にそのトレース ファイルを表示します。最大 10 件のサービスの   
Real-Time Trace データを Generic Log Viewer で表示でき、1 つのサーバでの同時セッションは 3 件         
に制限されています。ログ ビューアは 5 秒ごとに更新されます。トレースが新しいファイルに切り   
替わると、Generic Log Viewer はその内容をビューアに追加します。

（注） サービスが書き込むトレースの頻度に応じて、[View Real Time Data] オプションを選択した場合に    
は、Generic Log Viewer にデータを表示できるようになるまでに時間がかかる場合があります。

手順

ステップ 1 P.9-3 の「RTMT の Trace and Log Central オプションの表示」の説明に従って、Trace & Log Central          
ツリー階層を表示します。

ステップ 2 [Real Time Trace] をダブルクリックします。

ステップ 3 [View Real Time Data] をダブルクリックします。

View Real Time Data ウィザードが表示されます。

ステップ 4 [Nodes] ドロップダウン リスト ボックスで、リアルタイム データを表示するサーバを選択し、[Next]    
をクリックします。

ステップ 5 リアルタイム データを表示する製品、サービス、およびトレース ファイルのタイプを選択し、  
[Finish] をクリックします。

（注） アクティブにしなかったサービスも表示されるため、それらのサービスのトレースを収集

できます。

選択したサービスのリアルタイム データが Generic Log Viewer に表示されます。
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ステップ 6 [Show New Data] チェックボックスをオンにしてカーソルをウィンドウの最後に固定し、新しいト   
レースが収集されると同時に表示されるようにします。新しいトレースが表示されてもカーソルが

ウィンドウの最後に移動しないようにする場合は、[Show New Data] チェックボックスをオフにし   
ます。

ステップ 7 この手順を繰り返して、他のサービスのデータを表示します。5 件のサービスのデータを表示でき 
ます。データを表示するサービスの数が多すぎたり、1 つのノード上のサービスの数が多すぎたり 
すると、メッセージが表示されます。

ステップ 8 リアルタイム データの表示が完了したら、Generic Log Viewer で [Close] をクリックします。

ヒント Log Viewer でフレーズまたは単語を基準にして検索するには、[Search String] フィールド    
に単語またはフレーズを入力します。単語またはフレーズの大文字と小文字を区別して

検索する場合は、[Match Case] チェックボックスをオンにします。

追加情報

P.9-26 の「関連項目」を参照してください。

Monitor User Event

Trace and Log Central 機能の [Monitor User Event] オプションを選択すると、Real-Time Trace ファイ          
ルが監視され、検索文字列がトレース ファイル内に存在する場合には指定された操作が実行されま 
す。トレース ファイルは 5 秒ごとにポーリングされます。1 回のポーリング間隔中に検索文字列が    
複数検出されても、システムは処理を 1 回だけ実行します。各イベントで 1 つのサービスを監視で    
きます。

始める前に

監視対象のトレース ファイル内に指定した検索文字列が存在する場合にアラームを生成するには、 
LogFileSearchStringFound アラートを有効にします。アラートの有効化の詳細については、P.7-4 の  
「アラート プロパティの設定」を参照してください。

手順

ステップ 1 P.9-3 の「RTMT の Trace and Log Central オプションの表示」の説明に従って、Trace & Log Central          
ツリー階層を表示します。

ステップ 2 [Real Time Trace] をダブルクリックします。

ステップ 3 [Monitor User Event] をダブルクリックします。

Monitor User Event ウィザードが表示されます。
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ステップ 4 次のいずれかのタスクを実行します。

 • すでに設定済みのモニタリング イベントを表示するには、[View Configured Events] オプショ    
ン ボタンをクリックし、ドロップダウン リスト ボックスからサーバを選択して、[Finish] をク    
リックします。

選択したサーバに設定されたイベントが表示されます。 

（注） イベントを削除するには、イベントを選択して [Delete] をクリックします。

 • 新しいモニタリング イベントを設定するには、[Create Events] オプション ボタンをクリック    
し、[Next] をクリックして、ステップ 5 に進みます。

ステップ 5 [Nodes] ドロップダウン リスト ボックスで、システムで監視するサーバを選択し、[Next] をクリッ    
クします。

ステップ 6 システムで監視する製品、サービス、およびトレース ファイルのタイプを選択し、[Next] をクリッ  
クします。 

（注） アクティブにしなかったサービスも表示されるため、それらのサービスのトレースを収集

できます。

ステップ 7 [Search String] フィールドで、システムがトレース ファイル内で特定するフレーズまたは単語を指   
定します。ツールは、入力される単語またはフレーズの完全一致を検索します。

ステップ 8 システムがトレース ファイルを監視するサーバのタイム ゾーンと時間範囲（開始および終了の日  
時）を指定します。

クライアント マシンのタイム ゾーンが [Select Reference Server Time Zone] フィールドのデフォルト        
設定になります。Daylight Saving が設定されているすべてのタイム ゾーンの別々のエントリ セット    
とともに、すべての標準タイム ゾーンが [Select Time Zone] ドロップダウン リスト ボックスに表示       
されます。

Trace and Log Central により、[Selected Reference Server Time Zone] フィールドに基づいた時間範囲         
のファイルがダウンロードされます。 

トレースを監視する日付範囲を設定するには、[From Date/Time] フィールドと [To Date/Time] フィー     
ルドのドロップダウン リスト ボックスを選択します。

ステップ 9 [Search String] フィールドで指定した検索文字列が検出されたときにシステムが実行する処理を、次  
の中から 1 つ以上選択します。

 • Alert：指定された検索文字列を検出したときにアラームを生成する場合は、このオプションを
選択します。システムでアラームを生成するには、LogFileSearchStringFound アラートを有効に 
する必要があります。アラートの有効化の詳細については、P.7-4 の「アラート プロパティの  
設定」を参照してください。

 • Local SysLog：SysLog Viewer のアプリケーション ログ領域にエラーのログを記録する場合は、    
このオプションを選択します。システムに、アラームと推奨される操作の説明が表示されます。

SysLog Viewer には RTMT からアクセスできます。 



第 9章      RTMT での Trace and Log Central の設定
RTMT のトレース設定の更新 

9-25
Real-Time Monitoring Tool アドミニストレーション ガイド for Cisco Unity Connection        

OL-13895-01-J

 • Remote Syslog：syslog サーバに syslog メッセージを保存する場合は、このオプションを選択し    
ます。[Server Name] フィールドで、syslog サーバ名を指定します。 

 • Download File：指定された検索文字列を含むトレース ファイルをダウンロードするには、この  
オプションを選択します。[SFTP/FTP Server Parameters] グループ ボックスで、[FTP] または     
[SFTP] を選択し、トレース ファイルをダウンロードするサーバのサーバ クレデンシャルを入   
力して、[Test Connection] をクリックします。Trace and Log Central 機能で SFTP または FTP         
サーバへの接続の検証が終了したら、[OK] をクリックします。

（注） [Download Directory Path] フィールドで、収集されたファイルを Trace and Log Central 機能で        
保存するときのディレクトリを指定します。デフォルトでは、トレース収集によって、SFTP
または FTP のパラメータ フィールドで指定するユーザ ID を持つユーザのホーム ディレク      
トリ（/home/<user>/Trace）にファイルが保存されます。

（注） システムは 5 秒ごとにトレース ファイルをポーリングし、検索文字列が検出されると指定   
の処理を実行します。1 回のポーリング間隔中に検索文字列が複数検出されても、システム 
は処理を 1 回だけ実行します。 

ステップ 10 [Finish] をクリックします。

追加情報

P.9-26 の「関連項目」を参照してください。

RTMT のトレース設定の更新
Real-Time Monitoring プラグインのトレース設定を編集するには、[Edit] > [Trace Settings] を選択し、      
該当するオプション ボタンをクリックします。RTMT プラグインがインストールされたログ ディ   
レクトリ（たとえば、C:\Program Files\Cisco\Unified Serviceability\jrtmt\log）に rtmt.log ファイルが保    
存されます。

ヒント [Error] オプション ボタンがデフォルト設定です。

追加情報

P.9-26 の「関連項目」を参照してください。
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関連項目
 • Query Wizard の使用方法（P.9-7）

 • Local Browse の使用方法（P.9-18）

 • トレース ファイルの収集（P.9-4）

 • トレース収集のスケジュール（P.9-11）

 • RTMT の Trace and Log Central オプションの表示（P.9-3）

 • クラッシュ ダンプの収集（P.9-15）

 • Local Browse の使用方法（P.9-18）

 • Cisco Unified Serviceability アドミニストレーション ガイド
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10
RTMT での SysLog Viewer の使用方法

SysLog Viewer でメッセージを表示するには、次の手順を実行します。

手順

ステップ 1 次のいずれかのタスクを実行します。

• Quick Launch Channel で
－ [System] をクリックします。
－ ツリー階層で、[Tools] をダブルクリックします。
－ [Syslog Viewer] アイコンをクリックします。

• [System] > [Tools] > [SysLog Viewer] > [Open SysLog Viewer]  を選択します。

ステップ 2 [Select a Node] ドロップダウン リスト ボックスで、表示するログが保存されているサーバを選択し     
ます。

ステップ 3 表示するログのタブをクリックします。

ステップ 4 ログが表示されたら、ログ アイコンをダブルクリックして、同じウィンドウにファイル名のリスト 
を表示します。

ステップ 5 ウィンドウの下部にあるファイルの内容を表示するには、ファイル名をクリックします。

ステップ 6 表示するエントリをクリックします。 

ステップ 7 syslog メッセージの全体を表示するには、その syslog メッセージをダブルクリックします。次の表   
10-1 で説明されているボタンを使用して syslog メッセージを表示することもできます。

ヒント 列を大きくしたり小さくしたりするには、2 つの列見出しの間にマウスのポインタを置く 
と表示される矢印をドラッグします。

ヒント 列見出しをクリックしてメッセージの順序を並べ替えることができます。列見出しを 1 回  
クリックすると、レコードが昇順で表示されます。小さい上向きの三角形が昇順を表し

ます。列見出しを再度クリックすると、レコードが降順で表示されます。小さい下向き

の三角形が降順を表します。列見出しをもう一度クリックすると、レコードがソートさ

れる前の状態になります。
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ヒント [Filter By] ドロップダウン リスト ボックスでオプションを選択して、結果をフィルタで    
きます。フィルタを削除するには、[Clear Filter] をクリックします。フィルタをクリアす  
ると、すべてのログが表示されます。

追加情報

P.10-2 の「関連項目」を参照してください。

関連項目
 • Real-Time Monitoring Tool のインストールと設定（P.2-1）

表 10-1 Syslog Viewer のボタン

ボタン 機能

Refresh SysLog Viewer の現在のログの内容を更新します。

ヒント [Auto Refresh] チェックボックスをオンにすると、SysLog Viewer で    
syslog メッセージが 5 秒ごとに自動更新されます。

Clear 現在のログの表示をクリアします。 
Filter 選択する一組のオプションに基づいて、表示されるメッセージを制限します。

Clear Filter 表示されるメッセージのタイプを制限するフィルタを削除します。

Find 現在のログで特定の文字列を検索できます。

Save 現在選択されているログを PC に保存します。
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11
Port Monitor

この章では、Real-Time Monitoring Tool（RTMT）の Cisco Unity Connection 用 Port Monitor について         
説明します。次の項で構成されています。

 • Port Monitor の概要（P.11-1）

 • Port Monitor の使用方法（P.11-2）

Port Monitor の概要
RTMT Port Monitor を使用すると、各 Cisco Unity Connection のボイス メッセージ ポートのアクティ         
ビティをリアルタイムで監視できます。この情報に基づいて、システムのポートが多すぎるか、ま

たは少なすぎるかを判断できます。

このツールには、各ポートに次の情報が表示されます。

追加情報

P.11-2 の「関連項目」を参照してください。

Port Name Cisco Unity Connection の管理でのポートの表示名
Caller ID 着信の場合、発信者の電話番号

Application Status Cisco Unity Connection が発信者に対して再生するガイダンスの名前。ポー   
トが着信を処理していないときのステータスは「Idle」です。

Display Status ガイダンスが現在実行している処理。ポートが着信を処理していないとき

のステータスは「Idle」です。
Conversation Status ガイダンスが実行している処理の詳細。ポートが着信を処理していないと

きのステータスは「Idle」です。
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Port Monitor の使用方法
ここでは、Cisco Unity Connection の Port Monitor の使用方法について説明します。

手順

ステップ 1 RTMT で、次の手順のいずれかを実行します。

 • 左ペインの Quick Launch Channel で [Unity Connection] をクリックし、[Port Monitor] をクリッ         
クします。

 • [Unity Connection] メニューで、[Port Monitor] をクリックします。

[Port Monitor] タブが表示されます。

ステップ 2 [Polling Rate] フィールドで、[Port Monitor] タブのデータを更新するときのデフォルト間隔をそのま    
ま使用するか、または秒数を入力し、[Set Polling Rate] をクリックします。

（注） ポーリング レートを低く設定すると、システムのパフォーマンスに影響する可能性があり 
ます。

ステップ 3 [Start Polling] をクリックします。

[Port Monitor] タブに、Cisco Unity Connection のすべてのボイス メッセージ ポートのステータスが       
表示されます。

追加情報

P.11-2 の「関連項目」を参照してください。

関連項目
 • Port Monitor の概要（P.11-1）

 • Port Monitor の使用方法（P.11-2）
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A
システムのパフォーマンス オブジェク 
トとパフォーマンス カウンタ

この付録では、システムに関連するオブジェクトおよびカウンタについて説明します。特定のカウ

ンタの詳細については、次の一覧を参照してください。

 • Cisco Tomcat Connector（P.A-2）

 • Cisco Tomcat JVM（P.A-3）

 • Cisco Tomcat Web Application（P.A-4）

 • Database Change Notification Client（P.A-4）

 • Database Change Notification Server（P.A-5）

 • Database Change Notification Subscription（P.A-5）

 • Database Local DSN（P.A-5）

 • Database Local DSN（P.A-5）

 • DB User Host Information Counters（P.A-5）

 • Enterprise Replication DBSpace Monitors（P.A-5）

 • Enterprise Replication Perfmon Counters（P.A-6）

 • IP（P.A-6）

 • Memory（P.A-7）

 • Network Interface（P.A-8）

 • Number of Replicates Created and State of Replication（P.A-9）

 • Partition（P.A-9）

 • Process（P.A-10）

 • Processor（P.A-11）

 • System（P.A-11）

 • TCP（P.A-12）

 • Thread（P.A-12）

 • 参考情報（P.A-12）

ヒント システムのモニタリングで使用できる最新のパフォーマンス モニタリング カウンタ、オブジェク  
ト、およびカウンタの説明については、Real-Time Monitoring Tool のパフォーマンス モニタリング    
カウンタにアクセスしてください。RTMT では、P.5-2 の「パフォーマンス カウンタの表示」に示   
すとおり、カウンタの説明を確認できます。
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Cisco Tomcat Connector

Tomcat Hypertext Transport Protocol（HTTP）/HTTP Secure（HTTPS）Connector オブジェクトは、Tomcat     
コネクタについての情報を提供します。Tomcat HTTP コネクタは、要求を受信して応答を送信する  
エンドポイントを表します。このコネクタは、Cisco Unified Communications Manager 関連の Web     
ページへアクセスする時に発生する、HTTP/HTTPS 要求の処理と HTTP/HTTPS 応答の送信を行い   
ます。Web アプリケーションでの URL の Secure Socket Layer（SSL）ステータスは、各 Tomcat HTTP       
Connector のインスタンス名の基準になります。たとえば、SSL の場合は http://<IP Address>:8443、    
非 SSL の場合は http://<IP Address>:8080 です。表 A-1 では、Tomcat HTTP Connector の各カウンタ         
について説明します。

表 A-1 Cisco Tomcat Connector 

カウンタ カウンタの説明

Errors コネクタで発生した HTTP エラー（たとえば、401 Unauthorized）の数の合計を表します。   
Tomcat HTTP コネクタは、要求を受信して応答を送信するエンドポイントを表します。コネ  
クタは、Cisco Unified Communications Manager 関連ウィンドウへのアクセス時に発生する、    
HTTP/HTTPS 要求の処理と HTTP/HTTPS 応答の送信を行います。Web アプリケーションでの    
URL の Secure Socket Layer（SSL）ステータスは、各 Tomcat HTTP Connector のインスタンス        
名の基準になります。たとえば、SSL の場合は https://<IP Address>:8443、非 SSL の場合は     
http://<IP Address>:8080 です。

MBytesReceived コネクタが受信したデータ量を表します。Tomcat HTTP コネクタは、要求を受信して応答を  
送信するエンドポイントを表します。コネクタは、Cisco Unified Communications Manager 関    
連ウィンドウへのアクセス時に発生する、HTTP/HTTPS 要求の処理と HTTP/HTTPS 応答の送   
信を行います。Web アプリケーションでの URL の Secure Socket Layer（SSL）ステータスは、      
各 Tomcat HTTP Connector のインスタンス名の基準になります。たとえば、SSL の場合は     
https://<IP Address>:8443、非 SSL の場合は http://<IP Address>:8080 です。

MBytesSent コネクタが送信したデータ量を表します。Tomcat HTTP コネクタは、要求を受信して応答を  
送信するエンドポイントを表します。コネクタは、Cisco Unified Communications Manager 関    
連ウィンドウへのアクセス時に発生する、HTTP/HTTPS 要求の処理と HTTP/HTTPS 応答の送   
信を行います。Web アプリケーションでの URL の Secure Socket Layer（SSL）ステータスは、      
各 Tomcat HTTP Connector のインスタンス名の基準になります。たとえば、SSL の場合は     
https://<IP Address>:8443、非 SSL の場合は http://<IP Address>:8080 です。

Requests コネクタが処理した要求の数の合計を表します。Tomcat HTTP コネクタは、要求を受信して  
応答を送信するエンドポイントを表します。コネクタは、Cisco Unified Communications Manager   
関連ウィンドウへのアクセス時に発生する、HTTP/HTTPS 要求の処理と HTTP/HTTPS 応答の   
送信を行います。Web アプリケーションでの URL の Secure Socket Layer（SSL）ステータス      
は、各 Tomcat HTTP Connector のインスタンス名の基準になります。たとえば、SSL の場合     
は https://<IP Address>:8443、非 SSL の場合は http://<IP Address>:8080 です。

ThreadsTotal 使用可能なスレッドと使用中のスレッドを含む、コネクタの要求処理スレッドの現在の数の

合計を表します。Tomcat HTTP コネクタは、要求を受信して応答を送信するエンドポイント  
を表します。コネクタは、Cisco Unified Communications Manager 関連ウィンドウへのアクセ    
ス時に発生する、HTTP/HTTPS 要求の処理と HTTP/HTTPS 応答の送信を行います。Web アプ    
リケーションでの URL の Secure Socket Layer（SSL）ステータスは、各 Tomcat HTTP Connector        
のインスタンス名の基準になります。たとえば、SSL の場合は https://<IP Address>:8443、非   
SSL の場合は http://<IP Address>:8080 です。
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Cisco Tomcat JVM

Cisco Tomcat Java Virtual Machine（JVM）オブジェクトは、Tomcat JVM についての情報を提供しま      
す。Tomcat JVM は、たとえば Cisco Unity Connection の管理や Cisco Unified Serviceability などの Cisco           
Unified Communications Manager に関連した Web アプリケーションで使用される共通リソース メモ      
リのプールを表します。表 A-2 では、Tomcat JVM の各カウンタについて説明します。

ThreadsMax コネクタの要求処理スレッドの最大数を表します。Cisco Unified Communications Manager 関    
連ウィンドウで着信する各要求は、その要求の期間中、スレッドを 1 つ必要とします。現在  
使用可能な要求処理スレッドで処理できる数以上の同時要求を受信すると、このカウンタに

示される設定最大数までの追加スレッドが作成されます。さらに別の同時要求を受信すると、

それらの要求は、内部で指定された最大数になるまで、コネクタで作成されたサーバ ソケッ 
ト内に累積されます。それより多い同時要求は、それらの要求を処理するリソースが使用可

能になるまで、接続拒否メッセージを受け取ります。

Tomcat HTTP コネクタは、要求を受信して応答を送信するエンドポイントを表します。コネ  
クタは、Cisco Unified Communications Manager 関連ウィンドウへのアクセス時に発生する、    
HTTP/HTTPS 要求の処理と HTTP/HTTPS 応答の送信を行います。Web アプリケーションでの    
URL の Secure Socket Layer（SSL）ステータスは、各 Tomcat HTTP Connector のインスタンス        
名の基準になります。たとえば、SSL の場合は https://<IP Address>:8443、非 SSL の場合は     
http://<IP Address>:8080 です。

ThreadsBusy コネクタの通話中 /使用中要求処理スレッドの現在の数を表します。Tomcat Connector は、要  
求を受信して応答を送信するエンドポイントを表します。このコネクタは、Cisco Unified 
Communications Manager に関連した Web ページへのアクセス時に発生する、HTTP/HTTPS 要     
求の処理と HTTP/HTTPS 応答の送信を行います。Web アプリケーションでの URL の Secure      
Socket Layer（SSL）ステータスは、各 Tomcat Connector のインスタンス名の基準になります。    
たとえば、SSL の場合は https://<IP Address>:8443、非 SSL の場合は http://<IP Address>:8080 で        
す。

表 A-1 Cisco Tomcat Connector（続き）

カウンタ カウンタの説明

表 A-2 Tomcat JVM

カウンタ カウンタの説明

KBytesMemoryFree Tomcat Java Virtual Machine の動的空きメモリ ブロック（ヒープ メモリ）の空き容量を表し      
ます。動的メモリ ブロックには、Tomcat とその Web アプリケーション（Cisco Unity Connection      
の管理や Cisco Unified Serviceability など）で作成されるすべてのオブジェクトが保存されま    
す。動的メモリの空き容量が少なくなると、追加のメモリが自動的に割り当てられ、

KbytesMemoryTotal カウンタによって表される合計メモリ サイズが KbytesMemoryMax カウ    
ンタによって表される最大容量まで増加します。使用中のメモリ容量は、KbytesMemoryTotal
から KBytesMemoryFree の値を減算したものです。

KBytesMemoryMax Tomcat Java Virtual Machine の動的空きメモリ ブロック（ヒープ メモリ）の空き容量を表し      
ます。動的メモリ ブロックには、Tomcat とその Web アプリケーション（Cisco Unity Connection      
の管理や Cisco Unified Serviceability など）で作成されるすべてのオブジェクトが保存されま    
す。 

KBytesMemoryTotal 空きメモリと使用中メモリを含む、Tomcat Java Virtual Machine の現在の動的メモリ ブロック     
の合計サイズを表します。動的メモリ ブロックには、Tomcat とその Web アプリケーション    
（Cisco Unity Connection の管理や Cisco Unified Serviceability など）が作成するすべてのオブ       
ジェクトが保存されます。
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Cisco Tomcat Web Application

Cisco Tomcat Web Application オブジェクトは、Cisco Unified Communications Manager Web アプリケー         
ションの実行方法についての情報を提供します。Web アプリケーションの URL は、各 Tomcat Web     
Application のインスタンス名の基準になります。たとえば、Cisco Unified Serviceability は ccmservice     
によって識別され、拡張子を持たない URL（https://<IP Address>:8443 や http://<IP Address>:8080な     
ど）は _root によって識別されます。表 A-3 では、Tomcat Web Application の各カウンタについて説      
明します。

Database Change Notification Client

Database Change Notification Client オブジェクトは、変更通知クライアントについての情報を提供し    
ます。表 A-4 では、Database Change Notification Client の各カウンタについて説明します。

表 A-3 Tomcat Web Application

カウンタ カウンタの説明

Errors Cisco Unified Communications Manager 関連の Web アプリケーションで発生した HTTP エラー（た        
とえば、401 Unauthorized）の数の合計を表します。Web アプリケーションの URL は、各 Tomcat     
Web Application のインスタンス名の基準になります。たとえば、Cisco Unity Connection の管理     
（https://<IP Address>:8443/cuadmin）は cuadmin によって識別され、Cisco Unified Serviceability は      
ccmservice によって識別され、拡張子を持たない URL（https://<IP Address>:8443 や http://<IP     
Address>:8080 など）は _root によって識別されます。

Requests Web アプリケーションが処理する要求の数の合計を表します。Web アプリケーションにアクセ  
スするたびに、Requests カウンタが増分されます。Web アプリケーションの URL は、各 Tomcat     
Web Application のインスタンス名の基準になります。たとえば、Cisco Unity Connection の管理     
（https://<IP Address>:8443/cuadmin）は cuadmin によって識別され、Cisco Unified Serviceability は      
ccmservice によって識別され、拡張子を持たない URL（https://<IP Address>:8443 や http://<IP     
Address>:8080 など）は _root によって識別されます。

SessionsActive Web アプリケーションが現在アクティブ（使用中）になっているセッション数を表します。Web 
アプリケーションの URL は、各 Tomcat Web Application のインスタンス名の基準になります。た      
とえば、Cisco Unity Connection の管理（https://<IP Address>:8443/cuadmin）は cuadmin によって      
識別され、Cisco Unified Serviceability は ccmservice によって識別され、拡張子を持たない URL      
（https://<IP Address>:8443 や http://<IP Address>:8080 など）は _root によって識別されます。

表 A-4 Database Change Notification Client 

カウンタ カウンタの説明

MessagesProcessed 処理されたデータベース変更通知の数を表します。このカウンタは、15 秒ごとに更新されます。
MessagesProcessing 現在処理中、またはクライアントの変更通知キューで処理待ち状態にある変更通知メッセージの

数を表します。このカウンタは、15 秒ごとに更新されます。
QueueHeadPointer 変更通知キューへのヘッド ポインタを表します。ヘッド ポインタは、変更通知キュー内の開始  

ポイントとして機能します。キュー内の通知数は、テール ポインタ値からヘッド ポインタ値を  
減算したものです。デフォルトでは、このカウンタは 15 秒ごとに更新されます。

QueueMax このクライアントで処理される変更通知メッセージの最大数を表します。カウンタの値は、Cisco
Database Layer Monitor サービスが最後に再起動された時点からの累積値です。

QueueTailPointer 変更通知キューへのテール ポインタを表します。テール ポインタは、変更通知キュー内の終了  
ポイントを表します。キュー内の通知数は、テール ポインタ値からヘッド ポインタ値を減算し  
たものです。デフォルトでは、このカウンタは 15 秒ごとに更新されます。

TablesSubscribed クライアントが登録している表の数を表します。 
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Database Change Notification Server

Database Change Notification Server オブジェクトは、さまざまな変更通知関連の統計情報を提供しま    
す。表 A-5 では、Database Change Notification Server の各カウンタについて説明します。

Database Change Notification Subscription

Database Change Notification Subscription オブジェクトには、クライアントが変更通知を受信する表    
の名前が表示されます。

SubscribedTable オブジェクトには、変更通知を受信するサービスまたは servlet を含んだ表が表示さ   
れます。カウンタは増分しないため、表示は参考目的のみに使用されます。

Database Local DSN

Database Local Data Source Name（DSN）オブジェクトと LocalDSN カウンタは、ローカル マシンの       
DSN 情報を提供します。表 A-6 では、Database Local DSN の各カウンタについて説明します。

DB User Host Information Counters

DB User Host Information オブジェクトは、DB User Host についての情報を提供します。 

DB:User:Host Instance オブジェクトには、DB:User:Host の各インスタンスの接続数が表示されます。 

Enterprise Replication DBSpace Monitors

Enterprise Replication DBSpace Monitors オブジェクトには、さまざまな ER DbSpace の使用状況が表       
示されます。表 A-7 では、Enterprise Replication DBSpace Monitors の各カウンタについて説明します。

表 A-5 Database Change Notification Server 

カウンタ カウンタの説明

Clients 変更を通知するために登録されている変更通知クライアント（サービス /servlet）の数を表し
ます。

QueuedRequestsInDB 共有メモリのキューに入らずに直接 TCP/IP 接続を介して通知された、DBCNQueue（Database  
Change Notification Queue）の表に存在する変更通知レコードの数を表します。このカウンタ  
は、15 秒ごとに更新されます。

QueuedRequestsInMemory 共用メモリのキューに入る変更通知要求の数を表します。

表 A-6 Database Local Data Source Name  

カウンタ カウンタの説明

CcmDbSpace_Used 使用されている Ccm DbSpace の量を表します。
CcmtempDbSpace_Used 使用されている Ccmtemp DbSpace の量を表します。 
LocalDSN ローカル マシンから参照されているデータ ソース名（DSN）を表します。
RootDbSpace_Used 使用されている RootDbSpace の量を表します。

表 A-7 Enterprise Replication DBSpace Monitors

カウンタ カウンタの説明

ERDbSpace_Used 使用された Enterprise Replication DbSpace の量を表します。
ERSBDbSpace_Used 使用された ERDbSpace の量を表します。
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Enterprise Replication Perfmon Counters

Enterprise Replication Perfmon Counter オブジェクトは、さまざまなレプリケーション カウンタにつ     
いての情報を提供します。 

ServerName:ReplicationQueueDepth カウンタには、サーバ名に続いて、レプリケーション キュー項  
目数が表示されます。 

IP

IP オブジェクトは、システムの IP 統計についての情報を提供します。表 A-8 では、IP の各カウン     
タについて説明します。

表 A-8 IP 

カウンタ カウンタの説明

Frag Creates このエンティティで生成された IP データグラム フラグメントの数を表します。
Frag Fails Do not Fragment フラグが設定されたデータグラムの場合など、データグラムを断片化できな   

かったためにこのエンティティで廃棄された IP データグラムの数を表します。
Frag OKs このエンティティで正常に断片化された IP データグラムの数を表します。 
In Delivers IP ユーザ プロトコルに配信された入力データグラムの数を表します。これには Internet   

Control Message Protocol（ICMP）が含まれます。
In Discards 問題が発生しなくても廃棄された入力 IP データグラムの数を表します。考えられる原因の 1   

つに、バッファ領域の不足が挙げられます。カウンタの数には、再構成されるのを待ってい

る間に廃棄されたデータグラムの数は含まれません。

In HdrErrors ヘッダー エラーによって廃棄された入力データグラムの数を表します。これには、不適切な 
チェックサム、バージョン番号のミスマッチ、他のフォーマット エラー、存続可能時間の超 
過、およびデータグラム IP オプションの処理中に発見されたその他のエラーが含まれます。

In Receives すべてのネットワーク インターフェイスから受信した入力データグラムの数を表します。カ 
ウンタの数には、エラーを伴って受信したデータグラムも含まれます。

In UnknownProtos 正常に受信したものの、プロトコルが不明か未対応であるために廃棄されたローカル アドレ 
ス宛のデータグラムの数を表します。

InOut Requests 受信した着信 IP データグラムの数および送信された発信 IP データグラムの数を表します。
Out Discards 送信されずに廃棄された出力 IP データグラムの数を表します。考えられる原因の 1 つに、    

バッファ領域の不足があります。

Out Requests ローカル IP ユーザ プロトコル（ICMP を含む）が要求送信で IP に渡す IP データグラムの数        
を表します。カウンタの数には、ForwDatagrams でカウントされたデータグラムは含まれま 
せん。 

Reasm Fails タイムアウトやエラーなど、IP 再構成アルゴリズムによって検出された IP 再構成の失敗の回   
数を表します。このカウンタは、廃棄された IP フラグメントの数を表しません。これは、RFC  
815 のアルゴリズムなどの一部のアルゴリズムでは、受信するときにフラグメントを結合す 
るため、フラグメントの正しい数を追跡できなくなる可能性があるためです。

Reasm OKs 正常に再構成された IP データグラムの数を表します。
Reasm Reqds このエンティティで再構成が必要だった受信 IP フラグメントの数を表します。
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Memory

Memory オブジェクトは、サーバの物理メモリとスワップ メモリの使用状況についての情報を提供  
します。表 A-9 では、Memory の各カウンタについて説明します。

表 A-9 Memory 

カウンタ カウンタの説明

% Mem Used システムの物理メモリの使用率をパーセンテージで表示します。カウンタの値は、（Total
KBytes - Free KBytes - Buffers KBytes - Cached KBytes + Shared Kbytes）/Total Kbytes で計算さ              
れる値と等しく、Used KBytes/Total Kbytes にも対応します。 

% Page Usage アクティブなページの使用率をパーセンテージで表示します。

% VM Used システムの仮想メモリの使用率をパーセンテージで表示します。カウンタの値は、（Total
KBytes - Free KBytes - Buffers KBytes - Cached KBytes + Shared KBytes + Used Swap Kbytes）/                
（Total KBytes + Total Swap Kbytes）で計算される値と等しく、Used VM KBytes/Total VM Kbytes         
にも対応します。 

Buffers KBytes システムのバッファ容量を KB 単位で表します。
Cached KBytes キャッシュされたメモリの量を KB 単位で表します。
Free KBytes システムで使用可能なメモリの合計容量を KB 単位で表します。
Free Swap KBytes システムで使用可能な空きスワップ領域の容量を KB 単位で表します。
Pages ディスクからページインしたページの数と、ディスクにページアウトしたページ数の合計を

表します。

Pages Input ディスクからページインしたページの数を表します。

Pages Output ディスクにページアウトしたページの数を表します。

Shared KBytes システムの共有メモリの容量を KB 単位で表します。
Total KBytes システムの合計メモリ容量を KB 単位で表します。
Total Swap KBytes システムのスワップ領域全体の容量を KB 単位で表します。
Total VM KBytes 使用中のシステム物理メモリとスワップ領域（Total Kbytes + Total Swap Kbytes）の合計使用     

量を KB 単位で表します。

Used KBytes 使用中のシステム物理メモリの使用量を KB 単位で表します。Used KBytes カウンタの値は、    
Total KBytes - Free KBytes - Buffers KBytes - Cached KBytes + Shared Kbytes で計算されます。              
Used Kbytes 値は、top または free コマンド出力で表示される Linux 用語とは異なります。top       
または free コマンド出力に表示される Used の値は、Total KBytes - Free KBytes で計算される         
値に等しく、Buffers KBytes と Cached Kbytes の合計値も含みます。

Used Swap KBytes 使用中のスワップ領域の量を KB 単位で表します。
Used VM KBytes システム物理メモリと、使用中のスワップ領域の量を KB 単位で表します。値は、Total KBytes   

- Free KBytes - Buffers KBytes - Cached KBytes + Shared KBytes + Used Swap Kbytes で計算され                
ます。これは、Used Mem KBytes + Used Swap Kbytes に対応します。
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Network Interface

Network Interface オブジェクトは、システムのネットワーク インターフェイスについての情報を提   
供します。表 A-10 では、Network Interface の各カウンタについて説明します。

表 A-10 Network Interface 

カウンタ カウンタの説明

Rx Bytes インターフェイスで受信した、フレーミング文字を含めたバイト数を表します。

Rx Dropped エラーが検出されなかったものの、廃棄するように選択されたインバウンド パケットの数を 
表します。これによって、上位レイヤのプロトコルにパケットが配信されないようにします。

理由の 1 つとして、パケットを廃棄してバッファ領域を解放することが挙げられます。
Rx Errors エラーがあったために上位レイヤのプロトコルに配信できなかったインバウンド パケット 

の数（パケット指向インターフェイス）と、インバウンド送信ユニットの数（文字指向また

は固定長インターフェイス）を表します。

Rx Multicast このインターフェイスで受信したマルチキャスト パケットの数を表します。
Rx Packets サブレイヤが上位サブレイヤに配信したパケットの数を表します。この数には、このサブレ

イヤでマルチキャストまたはブロードキャスト アドレスにアドレス指定されたパケットは 
含まれません。

Total Bytes 受信（Rx）バイトと送信（Tx）バイトの合計を表します。
Total Packets Rx パケットと Tx パケットの数の合計を表します。
Tx Bytes インターフェイスから送信された、フレーミング文字を含むオクテットの数の合計を表しま

す。 
Tx Dropped エラーが検出されなくても廃棄するように選択されたアウトバウンド パケットの数を表し 

ます。この操作により、上位レイヤのプロトコルにパケットが配信されないようにします。

理由の 1 つとして、パケットを廃棄してバッファ領域を解放することが挙げられます。
Tx Errors エラーがあったために送信できなかったアウトバウンド パケットの数（パケット指向イン 

ターフェイス）と、アウトバウンド送信ユニットの数（文字指向または固定長インターフェ

イス）を表します。

Tx Packets 廃棄または送信されなかったものも含め、上位レベルのプロトコルが送信を要求したパケッ

トの数の合計を表します。この数には、このサブレイヤでマルチキャストまたはブロードキャ

スト アドレスにアドレス指定されたパケットは含まれません。
Tx QueueLen 出力パケット キューの長さをパケット単位で表します。
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Number of Replicates Created and State of Replication

Number of Replicates Created and State of Replication オブジェクトは、システムのレプリケーション状        
態についての情報を提供します。表 A-11 では、各レプリケーション カウンタについて説明します。

Partition 

Partition オブジェクトは、システムのファイル システムとその使用状況についての情報を提供しま  
す。表 A-12 では、Partition の各カウンタについて説明します。

表 A-11 Number of Replicates Created and State of Replication

カウンタ カウンタの説明

Number of Replicates Created DB の表用に Informix データベースによって作成されたレプリケーションの数を表しま   
す。それぞれの表にレプリケーションが 1 つ存在します。

Replicate_State レプリケーションの状態を表します。値には、次のものがあります。

 • 0（Not Started）：加入者が存在しないか、または加入者がインストールされて以来 
Database Layer Monitor サービスが実行されていません。

 • 1（Started）：レプリケーションを現在セットアップ中です。

 • 2（Finished）：レプリケーションのセットアップが完了し、機能しています。

 • 3（Broken）：レプリケーションはセットアップ時に失敗し、機能していません。

表 A-12 Partition 

カウンタ カウンタの説明

% CPU Time ディスクに対する I/O 要求の処理に費やされた CPU 時間をパーセンテージで表します。
% Used このファイル システムで使用中のディスク領域をパーセンテージで表します。
Await Read Time サービスを提供されるデバイスに対する Read 要求の平均時間を、ミリ秒単位で測定して表し  

ます。

Await Time サービスを提供されるデバイスに対する I/O 要求の平均時間を、ミリ秒単位で測定して表し  
ます。これには、要求がキューに入っていた時間と、サービスを提供するのにかかった時間

が含まれます。

Await Write Time サービスを提供されるデバイスに対する Write 要求の平均時間を、ミリ秒単位で測定して表  
します。

Queue Length ディスクに対する要求の平均キュー長を表します。

Read Bytes Per Sec ディスクで読み取られた毎秒あたりのデータ量をバイト単位で表します。

Total Mbytes このファイル システムの合計ディスク領域を MB 単位で表します。
Used Mbytes このファイル システムで使用中のディスク領域の合計を MB 単位で表します。
Write Bytes Per Sec ディスクに書き込まれた毎秒あたりのデータ量をバイト単位で表します。



付録 A      システムのパフォーマンス オブジェクトとパフォーマンス カウンタ        

A-10
Real-Time Monitoring Tool アドミニストレーション ガイド for Cisco Unity Connection

OL-13895-01-J

Process

Process オブジェクトは、システムで実行されているプロセスについての情報を提供します。表 A-13 
では、Process の各カウンタについて説明します。

表 A-13 Process 

カウンタ カウンタの説明

% CPU Time 最後の更新以降の経過 CPU 時間におけるタスクの占有率を、合計 CPU 時間に対してパーセ    
ンテージで表します。 

% MemoryUsage タスクが現在使用している物理メモリの使用率をパーセンテージで表します。

Data Stack Size タスク メモリ ステータスのスタック サイズを表します。
Nice タスクの Nice 値を表します。負の Nice 値はプロセスの優先順位が高いことを示し、正の Nice     

値はプロセスの優先順位が低いことを表します。Nice 値が 0 の場合、タスクの割り当てを判   
断するときに優先順位を調整しないでください。

Page Fault Count タスクで発生し、データをメモリにロードすることが必要になった主なページ障害の数を表

します。

PID タスク固有のプロセス ID を表します。この ID は定期的にラッピングされますが、値が 0 に      
なることはありません。

Process Status 次のプロセス ステータスを表示します。

 • 0：Running（実行）

 • 1：Sleeping（スリープ）

 • 2：Uninterruptible disk sleep（割り込み不能ディスク スリープ）

 • 3：Zombie（ゾンビ）

 • 4：Stopped（停止）

 • 5：Paging（ページング）

 • 6：Unknown（不明）
Shared Memory Size タスクが使用している共有メモリの容量（KB）を表示します。他のプロセスが同じメモリを

共有することも可能です。

STime このプロセスがカーネル モードでスケジュールしたシステム時間（STime）を、jiffy 単位で  
表示します。jiffy は CPU 時間の 1 単位に相当し、測定単位として使用されます。1 秒は 100       
jiffy です。

Thread Count タスクで現在グループ化されているスレッドの数を表示します。負の値（-1）は、このカウ
ンタが現在使用不可になっていることを示します。この状態になるのは、システムのプロセ

スとスレッドの数の合計がデフォルトのしきい値を超過したために、スレッド統計情報

（Thread オブジェクトのすべてのパフォーマンス カウンタ、および Process オブジェクトの    
Thread Count カウンタを含む）がオフになる場合です。

Total CPU Time Used タスクの開始以降、ユーザ モードとカーネル モードでタスクが使用した合計 CPU 時間を、    
jiffy 単位で表示します。jiffy は CPU 時間の 1 単位に相当し、測定単位として使用されます。      
1 秒は 100 jiffy です。

UTime タスクがユーザ モードでスケジュールした時間を jiffy 単位で表示します。
VmData タスクでのヒープの仮想メモリ使用状況を KB 単位で表示します。
VmRSS 現在の物理メモリにおける仮想メモリ（Vm）常駐セット サイズ（RSS）を KB 単位で表示し   

ます。これには、コード、データ、およびスタックが含まれます。

VmSize タスクでの仮想メモリの合計使用量を KB 単位で表示します。これには、すべてのコード、  
データ、共有ライブラリ、およびスワップ アウトされたページが含まれます（仮想イメージ 
= スワップ サイズ + 常駐サイズ）。
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Processor

Processor オブジェクトは、さまざまなプロセッサ時間の使用率についての情報をパーセンテージで 
提供します。表 A-14 では、Processor の各カウンタについて説明します。 

System 

System オブジェクトは、システムのファイル記述子についての情報を提供します。表 A-15 では、  
System の各カウンタについて説明します。

表 A-14 Processor 

カウンタ カウンタの説明

% CPU Time 最後の更新以降の経過 CPU 時間における、アイドル時間を除いたプロセッサの占有率を表示  
します。この占有率は、合計 CPU 時間に対してパーセンテージで表されます。

Idle Percentage プロセッサがアイドル状態になっており、未処理のディスク I/O 要求が存在しなかった時間  
をパーセンテージで表示します。

IOwait Percentage システムに未処理のディスク I/O 要求が存在し、同時にプロセッサがアイドル状態になって  
いた時間をパーセンテージで表します。

Irq Percentage プロセッサがコンピュータに信号を送信するために費やす時間を含む、デバイスに割り当て

られる割り込み要求を実行するためにプロセッサが費やす時間をパーセンテージで表しま

す。

Nice Percentage プロセッサが、Nice 優先順位に従ってユーザ レベルで実行するために費やす時間をパーセン  
テージで表示します。 

Softirq Percentage プロセッサが、CPU のパフォーマンスを向上させるために、ソフト IRQ の実行とタスク切り   
替えの延期に費やす時間をパーセンテージで表します。

System Percentage プロセッサが、システム（カーネル）レベルでプロセスを実行している時間をパーセンテー

ジで表示します。

User Percentage プロセッサが、ユーザ（アプリケーション）レベルで通常のプロセスを実行している時間を

パーセンテージで表示します。

表 A-15 System 

カウンタ カウンタの説明

Allocated FDs 割り当てられたファイル記述子の数の合計を表します。

Being Used FDs システムで現在使用中のファイル記述子の数を表します。

Freed FDs システム上で割り当てられているファイル記述子のうち、解放されているファイル記述子の

数の合計を表します。

Max FDs システムで許可されているファイル記述子の最大数を表します。

Total CPU Time システムが起動して稼働している合計時間を jiffy 単位で表します。 
Total Processes システム上のプロセスの数の合計を表します。

Total Threads システム上のスレッドの数の合計を表します。
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TCP 

TCP オブジェクトは、システムの TCP 統計についての情報を提供します。表 A-16 では、TCP の各     
カウンタについて説明します。

Thread

Thread オブジェクトは、システムで実行されているスレッドの一覧を表示します。表 A-17 では、
Thread の各カウンタについて説明します。

参考情報

関連項目

 • パフォーマンス モニタリングの概要

 • パフォーマンス カウンタの設定と表示

表 A-16 TCP 

カウンタ カウンタの説明

Active Opens TCP 接続が CLOSED 状態から SYS-SENT 状態へ直接遷移した回数を表示します。
Attempt Fails TCP 接続が SYN-RCVD 状態または SYN-SENT 状態のいずれかから CLOSED 状態に直接遷移       

した回数と、TCP 接続が SYS-RCVD 状態から LISTEN 状態に直接遷移した回数の合計を表示     
します。

Curr Estab 現在 ESTABLISHED 状態または CLOSE- WAIT 状態になっている TCP 接続の数を表示しま       
す。

Estab Resets TCP 接続が、ESTABLISHED 状態または CLOSE-WAIT 状態のいずれかから CLOSED 状態に      
直接遷移した回数を表示します。

In Segs 誤って受信したセグメントを含む、受信したセグメントの数の合計を表示します。この数に

は、現在確立されている接続で受信したセグメントのみが含まれます。

InOut Segs 送信したセグメント数の合計と受信したセグメント数の合計を表示します。

Out Segs 送信したセグメントの数の合計を表示します。この数には、現在確立されている接続で送信

されるセグメントのみが含まれますが、再送信されたオクテットは除外されます。

Passive Opens TCP 接続が、LISTEN 状態から SYN-RCVD 状態に直接遷移した回数を表示します。
RetransSegs 以前に送信されたオクテットが 1 つ以上含まれているために再送信されたセグメントの数の  

合計を表示します。 

表 A-17 Thread

カウンタ カウンタの説明

% CPU Time 最後の更新以降の経過 CPU 時間におけるスレッドの占有率を表示します。このカウンタで  
は、合計 CPU 時間に対してパーセンテージで占有率を表します。

PID スレッド リーダー プロセス ID を表示します。
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B
Cisco Unity Connection のパフォーマ   
ンス オブジェクトとパフォーマンス 
カウンタ

この付録では、Cisco Unity Connection に関連するオブジェクトおよびカウンタについて説明します。   
特定のカウンタの詳細については、次の一覧を参照してください。

 • CUC Data Store: Databases（P.B-2）

 • CUC Message Store（P.B-2）

 • CUC Personal Call Transfer Rules（P.B-2）

 • CUC Phone System（P.B-3）

 • CUC Phone System: Ports（P.B-4）

 • CUC Sessions: IMAP Server（P.B-4）

 • CUC Sessions: TRaP（P.B-5）

 • CUC Sessions: TTS（P.B-5）

 • CUC Sessions: Voice（P.B-6）

 • CUC Sessions: VUI（P.B-7）

 • CUC Sessions: Web（P.B-7）

 • 参考情報（P.B-8）

ヒント Cisco Unity Connection で使用可能な最新のパフォーマンス モニタリング カウンタ、オブジェクト、     
およびカウンタの説明については、Real-Time Monitoring Tool（RTMT）のパフォーマンス モニタリ   
ング カウンタにアクセスしてください。RTMT では、P.5-2 の「パフォーマンス カウンタの表示」    
に示すとおり、カウンタの説明を確認できます。
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CUC Data Store: Databases

CUC Data: Databases オブジェクトは、Cisco Unity Connection が使用するデータベースについての情      
報を提供します。

Disk Free/chunk [kb] カウンタは、チャンクで使用可能な空き領域の容量（KB）を表します。

CUC Message Store

CUC Message Store オブジェクトは、Cisco Unity Connection Message Store のパフォーマンスについ        
ての情報を提供します。表 B-1 では、CUC Message Store の各カウンタについて説明します。

CUC Personal Call Transfer Rules

CUC Personal Call Transfer Rules オブジェクトは、パーソナル着信転送ルール（PCTR）の数と使用     
状況についての情報を提供します。表 B-2 では、CUC Personal Call Transfer Rules の各カウンタにつ      
いて説明します。

表 B-1 CUC Message Store 

カウンタ カウンタの説明

Messages Delivered Total MTA サーバの最後の再起動以降に送信されたメッセージ数の合計
Messages Received Total MTA サーバの最後の再起動以降に受信したメッセージ数の合計
VPIM Messages Delivered Total Cisco Unity Connection Message Store によって送信された VPIM メッセージ数の合計
VPIM Messages Received Total Cisco Unity Connection Message Store によって受信された VPIM メッセージ数の合計
VPIM Messages Total Cisco Unity Connection Message Store によって処理された VPIM メッセージ数の合計

表 B-2 CUC Personal Call Transfer Rules 

カウンタ カウンタの説明

Applicable Rule Found ルール処理が開始され、適用可能な転送ルールが見つかったパーソナル着信転送ルー

ル（PCTR）の通話
Destinations Tried 転送ルールが適用されている間に試行された転送先の数

PCTR Calls 通話はパーソナル着信転送ルール（PCTR）（ユーザ割り当ての COS を PCTR で有効に    
する、ユーザは Cisco Unified Communications Manager ユーザである、ユーザは PCTR      
を無効にしていない）に従って処理されます。

Rules Evaluated パーソナル着信転送ルール（PCTR）の通話でのルール処理中に評価されたルールの数
Subscriber Reached 転送ルールが適用されている間にサブスクライバに到達した回数

Transfer Failed パーソナル着信転送ルールが適用されている間に、Cisco Unity Connection が転送先へ   
の通話の転送に失敗する回数。転送の失敗には、呼び出された転送先がタイムアウト

するか、または接続済み、通話中、または RNA 状態になっている場合を除くすべての  
状態が含まれます。転送中に発信者が電話を切ることも転送の失敗と見なされます。

Voicemail Reached 転送ルールが適用されている間にボイスメールが到達した回数
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CUC Phone System

CUC Phone System オブジェクトは、電話システム連動のパフォーマンスについての情報を提供しま   
す。表 B-3 では、CUC Phone System の各カウンタについて説明します。

表 B-3 CUC Phone System 

カウンタ カウンタの説明

Call Count Current Cisco Unity Connection サーバへの着信および発信の現在の数
Call Count Total Cisco Unity Connection サーバへの着信および発信数の合計
Call Duration Average [s] Cisco Unity Connection サーバからの着信および発信の平均持続時間（秒）
Call Duration Total [s] Cisco Unity Connection サーバからの着信および発信の合計持続時間（秒）
Incoming Calls CFB Current Call Forward Busy として受信した着信の現在の数
Incoming Calls CFB Total Call Forward Busy として受信した着信数の合計
Incoming Calls CFNA Current Call Forward No Answer として受信した着信の現在の数
Incoming Calls CFNA Total Call Forward No Answer として受信した着信数の合計
Incoming Calls Current 着信の現在の数

Incoming Calls Direct Current 一般の着信として受信した着信の現在の数

Incoming Calls Direct Total 一般の着信として受信した着信数の合計

Incoming Calls Duration Average [s] Cisco Unity Connection サーバへのすべての着信の平均持続時間（秒）
Incoming Calls Duration Total [s] Cisco Unity Connection サーバへのすべての着信の合計持続時間（秒）
Incoming Calls Total 着信数の合計

MWI Request Duration Average [ms] Cisco Unity Connection サーバからのすべての MWI 要求の平均持続時間（ミリ秒）
MWI Request Duration Total [ms] Cisco Unity Connection サーバからのすべての MWI 要求の合計持続時間（ミリ秒）
MWI Requests Failed Total 宛先番号への接続に失敗した、または MWI 操作を完了できなかった MWI 要求    

数の合計

MWI Requests Total Cisco Unity Connection によって送信された MWI 要求数の合計
Notification Duration Average [s] Cisco Unity Connection サーバからすべてのメッセージ通知が完了するまでにかか   

る平均時間（秒）

Notification Duration Total [s] Cisco Unity Connection サーバからすべてのメッセージ通知が完了するまでにかか   
る合計時間（秒）

Notifications Failed 宛先番号への接続に失敗したメッセージ通知の数の合計

Notifications Total Cisco Unity Connection によってサブスクライバに送信されたメッセージ通知の数   
の合計

Outgoing Calls Duration Average [s] Cisco Unity Connection サーバからのすべての発信の平均持続時間（秒）
Outgoing Calls Duration Total [s] Cisco Unity Connection サーバからのすべての発信の合計持続時間（秒）
Pager Notifications Duration Average [s] Cisco Unity Connection サーバからすべてのポケットベル通知が完了するまでにか   

かる平均時間（秒）

Pager Notifications Duration Total [s] Cisco Unity Connection サーバからすべてのポケットベル通知が完了するまでにか   
かる合計時間（秒）

Pager Notifications Failed 宛先番号への接続に失敗したポケットベル通知の数の合計

Pager Notifications Total Cisco Unity Connection によってサブスクライバに送信されたポケットベル通知の   
数の合計

Port Idle Duration [s] Cisco Unity Connection サーバへの着信から着信の間に、いずれかのポートがアイ   
ドル状態になる時間の合計（秒）
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CUC Phone System: Ports

CUC Phone System: Ports オブジェクトは、Cisco Unity Connection のボイス メッセージ ポートについ         
ての情報を提供します。表 B-4 では、CUC Phone System: Ports の各カウンタについて説明します。

CUC Sessions: IMAP Server

CUC Sessions: IMAP Server オブジェクトは、IMAP サーバについての情報を提供します。表 B-5 で      
は、CUC Sessions: IMAP Server の各カウンタについて説明します。

Port Idle Duration Average [s] Cisco Unity Connection サーバへの着信から着信の間に、いずれかのポートがアイ   
ドル状態になる時間の平均（秒）

Ports Idle Current Cisco Unity Connection サーバで使用されていない連動ポートの現在の数
Ports In Use Current Cisco Unity Connection サーバで使用されている連動ポートの現在の数
Ports Locked 応答しなくなったか、または Cisco Unity Connection で使用不能なポートの現在の    

数

表 B-3 CUC Phone System（続き）

カウンタ カウンタの説明

表 B-4 CUC Phone System: Ports 

カウンタ カウンタの説明

Port Calls Cisco Unity Connection サーバの最後の再起動以降に、このポートで受信した通話   
の数の合計。これには、着信、MWI 発信、通知発信、TRAP 発信、および VPIM   
発信など、すべてのタイプの通話が含まれます。

Port Usage Duration Average [s] ポートでアクティブに通話が処理されていた平均時間（秒）

Port Usage Duration Total [s] ポートでアクティブに通話が処理されていた合計時間（秒）

表 B-5 CUC Sessions: IMAP Server 

カウンタ カウンタの説明

Commands/second Average 毎秒あたりの IMAP コマンド数の平均
Connection Length Average [s] 過去 1 分間における IMAP サーバへの接続の平均持続時間（秒）
Errors Total IMAP サーバの最後の再起動以降に、IMAP サーバによって返された IMAP   

エラーの数の合計

EXAMINE Requests Total IMAP サーバの最後の再起動以降に、IMAP サーバに対して発行された  
EXAMINE 要求の数の合計

Failed Login Requests Total IMAP サーバの最後の再起動以降に、IMAP サーバに対して発行された失  
敗 LOGIN 要求の数の合計

FETCH Requests Total IMAP サーバの最後の再起動以降に、IMAP サーバに対して発行された  
FETCH 要求の数の合計

Login Requests Total IMAP サーバの最後の再起動以降に、IMAP サーバに対して発行された  
LOGIN 要求の数の合計

Logout Requests Total IMAP サーバの最後の再起動以降に、IMAP サーバに対して発行された  
LOGOUT 要求の数の合計

Messages Read Total IMAP の最後の再起動以降に、メッセージ本文を返した IMAP FETCH コマ    
ンドの数の合計

Messages Read/hour メッセージ本文を返した、過去 1 時間における IMAP FETCH コマンドの数
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CUC Sessions: TRaP

CUC Sessions: TRaP オブジェクトは、電話レコードと再生（TRaP）セッションについての情報を提   
供します。表 B-6 では、CUC Sessions: TRaP の各カウンタについて説明します。

CUC Sessions: TTS

CUC Sessions: TTS オブジェクトは、テキスト /スピーチ（TTS）セッションについての情報を提供   
します。表 B-7 では、CUC Sessions: TTS の各カウンタについて説明します。

Messages/fetch Average IMAP FETCH コマンドから返されたメッセージ数の平均
NOOP Requests Total IMAP サーバの最後の再起動以降に、IMAP サーバに対して発行された  

NOOP 要求の数の合計
Response Time Average [ms] IMAP コマンドに対する平均応答時間（ミリ秒）
Socket Connections Current IMAP サーバへの有効なソケット接続の数
Socket Connections Total IMAP サーバの最後の再起動以降に、IMAP サーバとの間で確立されたソ  

ケット接続数の合計

STARTTLS Requests Total IMAP サーバの最後の再起動以降に、IMAP サーバに対して発行された  
STARTTLS 要求の数の合計。このカウンタは、クライアントが IMAP SSL   
ポートに直接接続するときにも増分されます。

STATUS Requests Total IMAP サーバの最後の再起動以降に、IMAP サーバに対して発行された  
STATUS 要求の数の合計

TLS Connections Current IMAP サーバへの有効な Transport Layer Security 接続の数
TLS Errors Total IMAP サーバの最後の再起動以降に、IMAP サーバへの接続に失敗した  

TLS 接続数の合計
Unsolicited Notify Response Time Average [ms] IMAP サーバの未承諾 NOTIFY 応答時間の平均（ミリ秒）
Unsolicited Notify Responses Total IMAP サーバの最後の再起動以降に、IMAP サーバによって返された未承  

諾 NOTIFY 応答の合計回数

表 B-5 CUC Sessions: IMAP Server（続き）

カウンタ カウンタの説明

表 B-6 CUC Sessions: TRaP 

カウンタ カウンタの説明

Session Duration Average [s] すべての TRaP セッションの平均持続時間（秒）
Session Duration Total [s] すべての TRaP セッションの合計持続時間（秒）
Sessions Current アクティブな TRaP セッションの現在の数
Sessions Total Cisco Unity Connection が最後に起動された以降の TRaP セッションの数の合計

表 B-7 CUC Sessions: TTS 

カウンタ カウンタの説明

Session Duration Average [s] すべての TTS セッションの平均持続時間（秒）
Session Duration Total [s] すべての TTS セッションの合計持続時間（秒）
Sessions Current アクティブな TTS 音声セッションの現在の数
Sessions Total Cisco Unity Connection が最後に起動された以降の TTS 音声セッションの数の合計
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CUC Sessions: Voice

CUC Sessions: Voice オブジェクトは、音声セッションについての情報を提供します。表 B-8 では、    
CUC Sessions: Voice の各カウンタについて説明します。

表 B-8 CUC Sessions: Voice 

カウンタ カウンタの説明

Delay - Directory Search [ms] 発信者がディレクトリ全体の検索を試みるときに発生する遅延（ミリ秒）。検

索条件を入力してから結果が返されるまでの時間を測定します。

Delay - Opening Greeting [ms] 発信者が音声を聞くまでの遅延（ミリ秒）。システムが着信を受信してから、

発信者に対して音声がストリーム再生されるまでの時間を測定します。

Delay - Subscriber Delete Message [ms] Cisco Unity Connection のサブスクライバがメッセージの削除を試みるときに   
発生する遅延（ミリ秒）。最後のメッセージ削除プロンプトから、削除の確認

までの時間を測定します。

Delay - Subscriber Logon [ms] Cisco Unity Connection のサブスクライバが認証を行うときに発生する遅延（ミ   
リ秒）

Delay - Subscriber Message Count [ms] Cisco Unity Connection のサブスクライバが、サブスクライバのメッセージ   
ボックスでメッセージ数をカウントするときに発生する遅延（ミリ秒）

Delay - Subscriber Messages Header [ms] 発信者が Cisco Unity Connection でメッセージのヘッダー情報を収集する間に    
発生する遅延（ミリ秒）

Failsafes Total フェイルセーフ ガイダンスが再生される回数の合計
Messages Deleted Cisco Unity Connection の最後の再起動以降に、TUI によって削除されたボイ    

ス メッセージ数の合計
Messages Forwarded Cisco Unity Connection の最後の再起動以降に、TUI によって転送されたボイ    

ス メッセージ数の合計
Messages Read Cisco Unity Connection の最後の再起動以降に、TUI によって読み取られたボ    

イス メッセージ数の合計
Messages Replied Cisco Unity Connection の最後の再起動以降に、TUI によって応答されたボイ    

ス メッセージ数の合計
Messages Sent Cisco Unity Connection の最後の再起動以降に、TUI によって送信されたボイ    

ス メッセージ数の合計
MRCP Define Grammar Delay [ms] MRCP define-grammar 要求を発行してから応答が返されるまでの遅延（ミリ  

秒）

MRCP Define Grammar Delay Average [ms] MRCP define-grammar 要求を発行してから応答が返されるまでの遅延の平均  
（ミリ秒）

MRCP Define Grammar Delay Max [ms] MRCP define-grammar 要求を発行してから応答が返されるまでの最大遅延（ミ  
リ秒）

MRCP Delay [ms] MRCP 要求を発行してから応答が返されるまでの遅延（ミリ秒）
MRCP Delay Average [ms] MRCP 要求を発行してから応答が返されるまでの平均遅延（ミリ秒）
MRCP Delay Max [ms] MRCP 要求を発行してから応答が返されるまでの最大遅延（ミリ秒）
Subscriber Lookup Delay [ms] Cisco Unity Connection のサブスクライバが、DTMF ID によってサブスクライ     

バを検出およびロードするために発生する遅延（ミリ秒）



付録 B      Cisco Unity Connection のパフォーマンス オブジェクトとパフォーマンス カウンタ

B-7
Real-Time Monitoring Tool アドミニストレーション ガイド for Cisco Unity Connection        

OL-13895-01-J

CUC Sessions: VUI

CUC Sessions: VUI オブジェクトは、Voice User Interface（VUI; 音声ユーザ インターフェイス）につ       
いての情報を提供します。表 B-9 では、CUC Sessions: VUI の各カウンタについて説明します。

CUC Sessions: Web

CUC Sessions: Web オブジェクトは、Cisco Personal Communications Assistant（Cisco PCA）セッショ       
ンと Cisco Unity Connection の管理セッションについての情報を提供します。表 B-10 では、CUC     
Sessions: Web の各カウンタについて説明します。

表 B-9 CUC Sessions: VUI 

カウンタ カウンタの説明

Delay - Subscriber Message Access [ms] ユーザがメッセージにアクセスしようとするときに発生する遅延（ミリ秒）。

メッセージを聞くことを指示するボイス コマンドが発行されてから、メッセー 
ジが実際に再生されるまでの時間を測定します。

Matches Total VUI ガイダンスでの一致数の合計
Messages Deleted Cisco Unity Connection の最後の再起動以降に、VUI によって削除されたメッ    

セージ数の合計

Messages Forwarded Cisco Unity Connection の最後の再起動以降に、VUI によって転送されたメッ    
セージ数の合計

Messages Read Cisco Unity Connection の最後の再起動以降に、VUI によって読み取られたメッ    
セージ数の合計

Messages Replied Cisco Unity Connection の最後の再起動以降に、VUI によって応答が返された    
メッセージ数の合計

Messages Sent Cisco Unity Connection の最後の再起動以降に、VUI によって送信されたメッ    
セージ数の合計

No-matches Total VUI ガイダンスでの不一致の数の合計
Session Duration Average/call [s] 通話単位で測定された VUI セッションの平均持続時間（秒）
Session Duration Total [s] すべての VUI セッションの持続時間（秒）
Sessions Current 任意のコーデックでのアクティブな VUI の現在の数
Sessions Total 任意のコーデックでの VUI セッションと音声セッションの数の合計

表 B-10 CUC Sessions: Web 

カウンタ カウンタの説明

CPCA Failed Authentications Total 失敗した認証の数

CPCA Pages Saved Total CPCA ユーザがページを保存した回数の合計
CPCA Pages Served Total Cisco Unity Connection サーバによるサービスを受けた CPCA ページ数の合計
CPCA Requests In Queue Current 処理されるのを待っている CPCA キュー内の要求数
CPCA Server Busy Pages Total Cisco Unity Connection サーバによって返される通話中のページ数の合計
CPCA Sessions Current CPCA セッションの現在の数
CPCA Sessions Total CPCA セッションの数の合計
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